
                 Hitachi Virtual Storage Platform 
G600

Installation and Reference Guide

FE-94HM8022-00

lodeluca
Text Box
G400, G600

lodeluca
Text Box
Hardware Installation and Reference Guide



© 2015 Hitachi, Ltd. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any
means, electronic or mechanical, including photocopying and recording, or stored in a
database or retrieval system for any purpose without the express written permission of
Hitachi, Ltd.

Hitachi, Ltd., reserves the right to make changes to this document at any time without
notice and assumes no responsibility for its use. This document contains the most
current information available at the time of publication. When new or revised information
becomes available, this entire document will be updated and distributed to all registered
users.

Some of the features described in this document might not be currently available. Refer
to the most recent product announcement for information about feature and product
availability, or contact Hitachi Data Systems Corporation at https://portal.hds.com.

Notice: Hitachi, Ltd., products and services can be ordered only under the terms and
conditions of the applicable Hitachi Data Systems Corporation agreements. The use of
Hitachi, Ltd., products is governed by the terms of your agreements with Hitachi Data
Systems Corporation.

By using this software, you agree that you are responsible for:

a) Acquiring the relevant consents as may be required under local privacy laws or
otherwise from employees and other individuals to access relevant data; and
b) Verifying that data continues to be held, retrieved, deleted, or otherwise processed in
accordance with relevant laws.

Hitachi is a registered trademark of Hitachi, Ltd., in the United States and other
countries. Hitachi Data Systems is a registered trademark and service mark of Hitachi,
Ltd., in the United States and other countries.

Archivas, Essential NAS Platform, HiCommand, Hi-Track, ShadowImage, Tagmaserve,
Tagmasoft, Tagmasolve, Tagmastore, TrueCopy, Universal Star Network, and Universal
Storage Platform are registered trademarks of Hitachi Data Systems.

AIX, AS/400, DB2, Domino, DS6000, DS8000, Enterprise Storage Server, ESCON, FICON,
FlashCopy, IBM, Lotus, MVS, OS/390, RS/6000, S/390, System z9, System z10, Tivoli,
VM/ESA, z/OS, z9, z10, zSeries, z/VM, and z/VSE are registered trademarks or
trademarks of International Business Machines Corporation.

iPad is a trademark of Apple Inc., registered in the U.S. and other countries.

All other trademarks, service marks, and company names in this document or web site
are properties of their respective owners.

Microsoft product screen shots are reprinted with permission from Microsoft Corporation.

2
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide

https://portal.hds.com


Notice on Export Controls. The technical data and technology inherent in this
Document may be subject to U.S. export control laws, including the U.S. Export
Administration Act and its associated regulations, and may be subject to export or
import regulations in other countries. Reader agrees to comply strictly with all such
regulations and acknowledges that Reader has the responsibility to obtain licenses to
export, re-export, or import the Document and any Compliant Products.

3
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



4
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Contents

Preface............................................................................................... 13
Safety and environmental notices............................................................................14
General safety guidelines........................................................................................ 17

Handling of heavy parts.................................................................................... 17
Preventing electric shock...................................................................................17
Avoiding rotating or moving parts...................................................................... 18
Preventing machine damage..............................................................................18
Working when the storage system is turned on...................................................18
Precautions when using the storage system........................................................18
Procedures in an emergency..............................................................................19

For electric shock........................................................................................ 19
For fire....................................................................................................... 19

Intended audience................................................................................................. 20
Product version - reference guide............................................................................20
Release notes........................................................................................................ 20
Document conventions........................................................................................... 20
Conventions for storage capacity values...................................................................21
Accessing product documentation........................................................................... 22
Getting help...........................................................................................................22
Comments.............................................................................................................22

1 Product overview................................................................................. 23
Block configuration.................................................................................................24
Hitachi Virtual Storage Platform G400 model............................................................ 24
Hitachi Virtual Storage Platform G600 model............................................................ 25
Features................................................................................................................26
Scalability.............................................................................................................. 26

Examples of supported Hitachi Virtual Storage Platform G400 configurations.........26
Examples of supported Hitachi Virtual Storage Platform G600 configurations.........27
Maximum number of mounted drive trays...........................................................27

5
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



2 Hardware description........................................................................... 29
Storage system controllers......................................................................................30

CBLM controller................................................................................................ 30
CBLM with front panel bezel.........................................................................30
CBLM front panel without bezel.................................................................... 31
CBLM rear panel..........................................................................................32

Controller interfaces............................................................................................... 33
Front end module descriptions...........................................................................33

8 Gbps Fibre Channel board LEDs and connectors......................................... 33
16 Gbps Fibre Channel board LEDs and connectors........................................34
10 Gbps iSCSI board LEDs and connectors....................................................35

Back end module LEDs and connectors.............................................................. 36
Power supply unit LEDs and connectors..............................................................36

Storage system drive trays......................................................................................37
Small form factor (SFF) drive tray...................................................................... 37

SFF with front panel bezel............................................................................37
SFF front panel without bezel.......................................................................38
SFF rear panel............................................................................................ 38

Large form factor (LFF) drive tray...................................................................... 39
LFF with front panel bezel............................................................................39
LFF front panel without bezel....................................................................... 40
LFF rear panel.............................................................................................40

Flash module drive (FMD) tray...........................................................................41
FMD with front panel bezel.......................................................................... 41
FMD front panel without bezel......................................................................42
FMD rear panel........................................................................................... 43

Dense intermix drive tray.................................................................................. 44
Dense intermix drive tray with front panel bezel............................................ 44
Dense intermix drive tray display LEDs..........................................................44
Dense intermix drive tray rear panel............................................................. 45

Service Processor...................................................................................................46
SVP front panel................................................................................................ 47
SVP rear panel..................................................................................................48

3 Installing the hardware........................................................................ 49
Unpacking............................................................................................................. 51
Mounting the hardware...........................................................................................51

Floor load ratings..............................................................................................52
Mounting the SVP............................................................................................. 53

Choose a mounting location......................................................................... 53
Installing the inner rail extension..................................................................53
Installing the outer rails to the rack.............................................................. 55
Installing the chassis into the rack................................................................55

Mounting the storage system.............................................................................56
Connecting drive trays............................................................................................57

Maximum drive boxes supported........................................................................58
Virtual Storage Platform G600 connection rules...................................................58
Maximum number of installable drive trays......................................................... 59
Selecting SAS cables......................................................................................... 59
Connecting drive trays...................................................................................... 59

6
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Turning on the drive tray Locate LED..................................................................64
Connecting to the SVP............................................................................................65
Powering up the hardware...................................................................................... 66

Powering up the SVP.........................................................................................66
Powering up the storage system........................................................................ 68
Confirming normal operation............................................................................. 69

Making host connections.........................................................................................70
Fibre Channel connections.................................................................................70
iSCSI connections............................................................................................. 70

Confirming your connections...................................................................................71
Attaching and removing the front panel bezel...........................................................72

Attaching the front bezel to the SVP...................................................................72
Removing the front bezel from the SVP.............................................................. 73
Attaching the front bezel to a SFF, LFF, or FMD................................................... 74
Removing the front bezel from a DBS or DBL drive tray....................................... 74
Remove the front bezel from a CBLM or CBLH controller......................................75
Attaching the front bezel to a CBLM or CBLH controller........................................75
Attaching the front bezel to a dense intermix drive tray....................................... 76
Removing the front bezel from a dense intermix drive tray...................................77

Powering off the storage system............................................................................. 78
Removing cables.................................................................................................... 79
Storing the storage system..................................................................................... 80

Using flash drives and flash module drives..........................................................80
Where to go from here........................................................................................... 80

4 Performing the initial configuration........................................................81
Running the Initial Startup Wizard...........................................................................82
Running the Initial Setup Wizard............................................................................. 87
Configuring alert notifications..................................................................................91
Installing and enabling licenses............................................................................... 97
Setting the SVP date, time, and timezone settings.................................................... 99
Disconnecting from the SVP.................................................................................. 103

5 Troubleshooting................................................................................. 105
General troubleshooting........................................................................................106

Host cannot access storage............................................................................. 106
Correct values for the storage system IP address.............................................. 106
DHCPv4 configuration for storage systems........................................................106
IP address being used by other storage systems or hosts.................................. 107
IP address configuration for the host................................................................107
TCP/UDP port filtering being performed on the network switch.......................... 107
Search Storage system performed across the IPv6 routers.................................107

Using LEDs to diagnose problems.......................................................................... 107
POWER LED does not go on............................................................................ 108
POWER LED turned off ...................................................................................108
READY LED does not go on or READY LED went on and then off........................109
ALARM LED is on. .......................................................................................... 109
WARNING LED goes on or blinks......................................................................109

Checking alerts.................................................................................................... 110
Checking SIM alerts..............................................................................................116

7
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Checking hardware replacement alerts...................................................................118
Troubleshooting Hitachi Device Manager - Storage Navigator...................................121
Dump tool........................................................................................................... 122

About the Dump tool.......................................................................................122
Using the Dump tool....................................................................................... 123
Collecting dump files manually.........................................................................123

Troubleshooting the maintenance utility................................................................. 124
JavaScript security.......................................................................................... 124
Compatibility view...........................................................................................125
Clearing the browser cache..............................................................................125
Refreshing the Maintenance Utility window....................................................... 125
Maintenance Utility window freezes..................................................................126

Turning the storage system on or off using the maintenance utility.......................... 126
iSCSI troubleshooting........................................................................................... 126
SVP troubleshooting............................................................................................. 129

Powering off the SVP.......................................................................................129
Rebooting the SVP.......................................................................................... 129
Backing up the SVP configuration.....................................................................129
Restoring the SVP configuration....................................................................... 130
Changing the SVP IP address...........................................................................131

Changing the SVP IP address in Windows 7.................................................131
Changing the SVP IP address using the Storage Device List.......................... 131

Blocking communications to port 80................................................................. 132
Deleting the registered storage system.............................................................133
Registering the storage system on the SVP....................................................... 134

About working with firewalls................................................................................. 139
Configuring the audit log.......................................................................................140

Audit log files................................................................................................. 140
Exporting audit log files stored from the SVP.....................................................143
Exporting audit log files from the storage system.............................................. 144

6 Adding components........................................................................... 145
Guidelines when adding optional components.........................................................146
Procedures for adding optional components........................................................... 146

Adding optional components with power applied............................................... 146
Conditions when adding optional components........................................................ 147

Conditions when adding drive trays.................................................................. 147
Optional components that can be added...........................................................147

Conditions when adding drives................................................................... 147
Conditions for adding cache memory.......................................................... 148
Conditions for adding cache flash memory.................................................. 149
Conditions for adding batteries................................................................... 149
Conditions for adding Fibre Channel front end module................................. 149
Conditions for adding iSCSI front end module..............................................149
Conditions for adding small form-factor pluggable........................................149

Starting the maintenance utiility............................................................................ 150
Starting the maintenance utility from Hitachi Command Suite.............................150
Starting the maintenance utility from Hitachi Device Manager - Storage Navigator
..................................................................................................................... 151

Adding disk drives................................................................................................ 153
Replacing a drive for the dense intermix drive tray............................................ 153

8
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Adding drives to a SFF drive tray......................................................................154
Adding drives to a LFF drive tray......................................................................155
Recognizing drives.......................................................................................... 156
Configuring a host to recognize a volume with power on................................... 157

Adding cache memory.......................................................................................... 158
Cache memory for Hitachi Virtual Storage Platform G400...................................158
Cache memory for Hitachi Virtual Storage Platform G600...................................159
Checking cache memory..................................................................................159
Blocking a controller........................................................................................162
Adding cache memory to a CBLM or CBLH controller......................................... 163
Adding cache flash memory to a CBLM or CBLH controller................................. 166
Adding a battery to a CBLM or CBLH controller..................................................167
Installing a controller in a CBLM or CBLH controller........................................... 168
Restoring cache memory................................................................................. 170

Shared memory....................................................................................................171
Adding shared memory................................................................................... 175

Front end module.................................................................................................176
Blocking a front end module............................................................................ 176
Adding a front end module.............................................................................. 179
Recognizing a front end module.......................................................................180

Small form factor pluggable.................................................................................. 181
Checking a small form factor pluggable............................................................ 181
Replacing an SFP............................................................................................ 185
Recognizing an SFP.........................................................................................187

Adding a back end module to a CBLM or CBLH controller........................................ 187
Preparing to install a back end module into an empty slot..................................187
Preparing to replace a back end module........................................................... 190
Adding or replacing the back end module......................................................... 192
Recognizing a back end module....................................................................... 194

Adding drive trays................................................................................................ 194

A Registration, resources, and checklists.................................................199
Register your storage system................................................................................ 200
Creating a user account........................................................................................ 200
Logging in to the HDS Support Portal.....................................................................201
Additional resources............................................................................................. 203

Product documentation................................................................................... 203
Product interoperability................................................................................... 203
Global services................................................................................................203
HDS Community............................................................................................. 203

Recording your configuration settings.................................................................... 203

B Upgrading firmware........................................................................... 207
Firmware upgrade prerequisites.............................................................................208
Upgrading the SVP software..................................................................................208

Stopping the SVP service.................................................................................208
Upgrading the software................................................................................... 212

Upgrading firmware for the storage system............................................................ 214
Upgrading the firmware...................................................................................214

9
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



C Specifications.....................................................................................217
Model lists........................................................................................................... 218

Hitachi Virtual Storage Platform G400, G600 controller model lists......................218
Drive tray model lists...................................................................................... 219
Other model list..............................................................................................221

Replacement parts................................................................................................223
Battery unit.................................................................................................... 223

Hitachi Virtual Storage Platform G400, G600 mechanical specifications..................... 224
Electrical specifications......................................................................................... 228
Environmental specifications................................................................................. 229
Battery specifications............................................................................................231
RAID specifications...............................................................................................232
iSCSI specifications...............................................................................................232
iSCSI standards....................................................................................................234
Regulatory compliance..........................................................................................235
Dense intermix drive tray connection restrictions.................................................... 236
SVP hardware specifications..................................................................................236

D Cables...............................................................................................237
Fibre Channel cables.............................................................................................238
iSCSI cables.........................................................................................................240
AC power cables...................................................................................................241

Power cable assemblies...................................................................................241
AC connections...............................................................................................242
Power cable usage guidelines.......................................................................... 243
Three-phase power considerations for racks......................................................244
Cable management......................................................................................... 244
Cable retention............................................................................................... 244

E Port address mapping.........................................................................247
Port address mapping...........................................................................................248

F Using the BECK tool........................................................................... 249
System requirements............................................................................................250
Drive tray specifications........................................................................................ 250
Installing the BECK tool........................................................................................ 251
Uninstalling the BECK tool.....................................................................................251
BECK tool at a glance........................................................................................... 252
Starting the BECK tool.......................................................................................... 253
BECK tool configuration screen..............................................................................254

Understanding the BECK tool configuration screen.............................................254
Creating new configurations............................................................................ 256

Creating a configuration automatically........................................................ 256
Creating a configuration manually...............................................................256
Editing the logical configuration figure........................................................ 257

Assigning units to a path................................................................................. 257
Setting a unit in an empty box in a path......................................................257
Changing or deleting a drive tray in a path..................................................258
Editing box codes for a controller (VSP G200 only).......................................258

10
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Moving and exchanging drive trays...................................................................259
Editing the physical configuration figure........................................................... 259
Setting the rack size........................................................................................259
Setting units to a rack or an empty rack box..................................................... 260

Setting a drive tray in an empty rack box.................................................... 260
Changing or deleting a drive tray................................................................260
Setting a controller or editing its box code...................................................260

Moving and exchanging units...........................................................................261
Working with cable figures.................................................................................... 261

Sizes..............................................................................................................261
Buttons and fields........................................................................................... 262
Working with cable figures...............................................................................262
Working with cable figures in rack boxes.......................................................... 263

Expanding a configuration.....................................................................................263
Simple trace default file name..........................................................................265

Saving and loading a configuration file...................................................................265
Saving a configuration file............................................................................... 265
About the configuration file..............................................................................265
Loading a configuration file..............................................................................266

BECK tool messages............................................................................................. 266
Special guidelines.................................................................................................270

Dense intermix drive tray configuration rules.................................................... 270
Yellow box in the configuration screen..............................................................270
Loading a simple trace when Unit A of a DBX is connected last.......................... 270

G Warning labels on the storage system................................................. 273
CBLM controller....................................................................................................275
Small form factor drive tray...................................................................................275
Large form factor drive tray...................................................................................276
Flash module drive tray.........................................................................................278
Dense intermix drive tray......................................................................................279
CBLM controller....................................................................................................279
Drive for a small form factor drive tray...................................................................280
Drive for a large form factor drive tray................................................................... 280
Drive for a flash module drive tray.........................................................................280
Drive for a dense intermix drive tray...................................................................... 281
CBLM power supply.............................................................................................. 281
Power supply for small and large form factor drive trays..........................................282
Flash module drive tray power supply.................................................................... 282
Dense intermix drive tray power supply..................................................................282
Front end module (Fibre Channel/iSCSI)................................................................ 283
Back end module..................................................................................................283
ENC for small and large form factor drive trays.......................................................283
ENC for a dense intermix drive tray........................................................................284
CMA (used to secure dense intermix drive tray)...................................................... 284
Battery................................................................................................................ 285

11
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



12
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Preface
Before you install a Hitachi Virtual Storage Platform (VSP) storage system, it
is important to confirm that your site is ready to support your storage
system.

This guide describes how to plan and prepare for the installation of a Hitachi
VSP storage system.

As part of the site-preparation process, customers are required to purchase
site-preparation services from Hitachi Global Services. These services
include:
• A telephone predelivery site survey to confirm power, location of

equipment, access, and expectations.
• Telephone consultation to determine a customer's optimum configuration.

□ Safety and environmental notices

□ General safety guidelines

□ Intended audience

□ Product version - reference guide

□ Release notes

□ Document conventions

□ Conventions for storage capacity values

□ Accessing product documentation

□ Getting help

□ Comments
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Safety and environmental notices

Equipment warranty

The term of guarantee of normal operation of the storage system and free
service is one year from date of purchase.

If a failure occurs multiple times, the storage system might shut off to avoid
a serious accident.

Notice of export controls

Export of technical data contained in this document might require an export
license from the United States government, the government of Japan. or
both. Contact the Hitachi Legal Department for guidance about any export
compliance questions.

Backup

Hitachi cannot guarantee against data loss due to failures. Therefore, back up
your data to minimize chances for data loss.

Data backup is also critical when hardware components are added or
replaced, because performing such hardware procedures restores parameter
settings that can affect how data is managed on the storage systems.

Disposal

 

 
This symbol on the product or on its packaging means that your electrical
and electronic equipment should be disposed at the end of life separately
from your household wastes.

There are separate collection systems for recycling in the European Union.
For more information, contact the local authority or the dealer where you
purchased the product.

Recycling

A nickel-metal hydride battery is used in the Cache Backup Battery.
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A nickel-metal hydride battery is a resource that can be recycled. When you
want to replace the Cache Backup Battery, call the service personnel. They
will dispose of it for you. This nickel-metal hydride battery, which is
designated as recycling product by a recycling promotion low, must be
recycled.

The mark posted on the Cache Backup Battery is a three-arrow mark that
indicates a recyclable part.
 

 

UEFI Development Kit 2010

This product includes UEFI Development Kit 2010 written by the UEFI Open
Source Community. For more information, see the UEFI Development Kit
website:

http://sourceforge.net/apps/mediawiki/tianocore/index.php?title=UDK2010

© 2004, Intel Corporation.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

Neither the name of the Intel Corporation nor the names of its contributors
might be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
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CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Notes on use

When using the Hitachi storage system, be sure to read this guide and
understand the operating procedures and instructions described herein
thoroughly before staring your operation.

The array complies with FDA radiation performance standard 21 CFR
subchapter J.

EMI regulation

This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful
interference in which case the user will be required to correct the interference
at his own expense. Testing was done with shielded cables. Therefore, in
order to comply with the FCC regulations, you must use shielded cables with
your installation.

The electromagnetic interference (EMI) test was done in the following
configuration.

If trouble occurs in another configuration, a user might be requested to take
appropriate preventative measures:
• RKU CBSS dense intermix drive tray flash module drive tray+2 small form

factor drive trays + 1 large form factor drive tray.
• RKU CBSL 1 small form factor drive tray
• RKU CBL dense intermix drive tray flash module drive tray 3 small form

factor drive trays 3 large form factor drive trays

This product must not be used in residential areas.

This is a class A product. In a domestic environment this product can cause
radio interference in which case the user can be required to take adequate
measures.
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General safety guidelines
Before starting maintenance:
• Maintenance must be performed by trained and qualified engineers only.
• The safety guidelines and procedures in this manual must be read and

followed.
• In this manual and on the storage system, hazard warnings are provided

to aid you in preventing or reducing the risk of death, personal injury, or
product damage. Understand and follow these hazard warnings fully.

• If warning labels on the storage system become dirty or start peeling off,
replace them.

• If an anomaly such as an unusual noise, smell, or smoke occurs on the
storage system while it is running, power off or remove the power cables
immediately.

• Hazard warnings in this manual or on the storage system cannot cover
every possible case, because it is impossible to predict and evaluate all
circumstances beforehand. Be alert and use common sense.

• To ensure normal operation, operate the storage system according to the
information in this manual.

Read the following safety guidelines carefully and follow them when you
conduct maintenance of the machine:
• Do not use materials that are outside the specifications for the storage

system.
• Use the spare parts, consumables, and materials for maintenance that are

specified in this manual; otherwise, personal injury, system damage, and
degradation in system quality can occur.

• Keep the maintenance area neat.
• Always put away parts, materials, and tools when not in use.

Handling of heavy parts
• When lifting a heavy object, hold it close to yourself and keep your back

erect to prevent back injury.
• When lifting an object designated with a caution in this manual, use a

proper lifting tool or have somebody assist you.

Preventing electric shock
• Before starting work, be sure that, unless otherwise specifically instructed,

there is no potential electric hazard in the maintenance area such as
insufficient grounding or a wet floor.

• Before starting work, know where the emergency power-off switches are
located and be sure you know how to operate them.
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• Unless otherwise specifically instructed, remove all power sources to the
machine before starting maintenance. Switching off the storage system
power supplies is usually not sufficient.

• Do not touch any uninsulated conductor or surface that remains charged
for a limited time after the external power supply to the storage system is
disconnected.

• Do not replace parts during a thunderstorm.

Avoiding rotating or moving parts
• Do not supply power to any device with rotating or moving parts that are

not properly covered.
• Tuck in your tie, scarf, shirt, or any other loose clothing to prevent it from

getting caught by a rotating or moving part.

Preventing machine damage
• Use the tools and instruments, as instructed in this manual, or equivalent

commercially available tools and instruments suited for the purpose.
• Use measurement instruments and powered tools that are properly

calibrated or periodically inspected.
• Before finishing your work, be sure all parts removed during maintenance

have been installed in their original positions in the storage system. Do not
leave any tools or foreign material in the storage system.

Working when the storage system is turned on
Observe the following safety measures when working on the storage system
with the system power turned on. When you perform maintenance, do not
touch live electric parts to prevent an electric shock.
• Do not touch heat sinks immediately after a board is removed because the

heat sinks are extremely hot.
• While performing maintenance, do not drop tools, screws, or other items

into the storage system, because doing so can cause a short circuit.
• While performing maintenance, do not damage or pinch wires.
• When moving a heavy object, have at least two people move the object

after confirming there are no obstacles nearby.

Precautions when using the storage system
• Use the supplied power cords included with the storage system. Do not

use the supplied power cords for other products. Do not use other power
cords with the storage system.

• Shut off the power feed to the equipment and inform the system
administrator immediately if you notice an unusual smell, abnormal heat
generation, or smoke emission. Leaving such conditions unattended can
cause electric shock or fire.
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• Exercise care when handling the storage system and its parts. Do not drop
the equipment or parts.

• Do not stand on the storage system. Avoid using the storage system for
any use other than the one for which it was originally designed.

• Do not place heavy objects on the storage system, near the vents on the
front and rear panels, or on the cables attached to the storage system.

• Do not put a container with water, paper clips, or the like on the storage
system or near the power supply.

• Route cables in a way to prevent people from tripping over them.
• Do not operate the storage system in a moist or dusty place.
• Keep these vents open and be sure they are not blocked to keep the

storage system ventilated. Cool air enters the storage system from the air
vent on the front panel and exits through the vent on the rear panel.

• If a failure occurs in the storage system, follow the instructions in this
manual. If the problem is not covered by this manual, contact your system
administrator.

Procedures in an emergency

For electric shock

• Before performing maintenance, be sure that there is no potential electric
hazard in the maintenance area, such as insufficient grounding or a wet
floor.

• Before performing maintenance, observe where the emergency poweroff
switches are located and be sure you know how to operate them.

• Unless otherwise instructed, remove all power sources to the storage
system before starting work. Switching off the storage system power
supplies is not sufficient. When power is fed from a wall or floor outlet,
unplug the power supply cord, or turn off the switch on the power
distribution panel or board.

• If the power supply has a lockout device, lock the device after powering off
the storage system and retain the key. Attach a notice on the panel or
board prohibiting the use of the switch.

• If the machine power has been already turned off, confirm that these
conditions have been satisfied.

For fire

• Shut off all the power to the machine.
• Turn off the emergency power switch or stop the power supply to the

storage system.
• If the fire continues to burn after the power is shut off, take suitable

actions, including the use of a fire extinguisher, or call the fire department.
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Intended audience
This document is intended for system administrators, Hitachi Data Systems
representatives, and authorized service providers who install, configure, or
operate Hitachi Virtual Storage Platform G200, G400, G600 storage systems.

Readers of this document should be familiar with the following:
• Data processing and RAID storage systems and their basic functions.
• The Hitachi Virtual Storage Platform G200, G400, G600 storage system.
• The operating system and web browser software on the system hosting

the storage management software.

Product version 

This document revision applies to Hitachi Virtual Storage Platform G400,
G600 firmware 83-01-0x or later.

Release notes
Read the release notes before installing and using this product. They may
contain requirements or restrictions that are not fully described in this
document or updates or corrections to this document.

Document conventions
This document uses the following typographic conventions:

Convention Description

Bold Indicates text on a window, other than the window title, including menus,
menu options, buttons, fields, and labels. Example: Click OK.

Italic Indicates a variable, which is a placeholder for actual text provided by the
user or system. Example: copy source-file target-file

Note: Angled brackets (< >) are also used to indicate variables.

Monospace Indicates text that is displayed on screen or entered by the user. Example:
pairdisplay -g oradb

< > angled brackets Indicates a variable, which is a placeholder for actual text provided by the
user or system. Example: pairdisplay -g <group>

Note: Italic font is also used to indicate variables.

[ ] square brackets Indicates optional values. Example: [ a | b ] indicates that you can choose a,
b, or nothing.

{ } braces Indicates required or expected values. Example: { a | b } indicates that you
must choose either a or b.
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Convention Description

| vertical bar Indicates that you have a choice between two or more options or arguments.
Examples:

[ a | b ] indicates that you can choose a, b, or nothing.

{ a | b } indicates that you must choose either a or b.

This document uses the following icons to draw attention to information:

Icon Label Description

Note Calls attention to important or additional information.

Tip Provides helpful information, guidelines, or suggestions for performing
tasks more effectively.

Caution Warns the user of adverse conditions or consequences (for example,
disruptive operations).

WARNING Warns the user of severe conditions or consequences (for example,
destructive operations).

Conventions for storage capacity values
Physical storage capacity values (for example, disk drive capacity) are
calculated based on the following values:

Physical capacity unit Value

1 kilobyte (KB) 1,000 (10 3) bytes

1 megabyte (MB) 1,000 KB or 1,0002 bytes

1 gigabyte (GB) 1,000 MB or 1,0003 bytes

1 terabyte (TB) 1,000 GB or 1,0004 bytes

1 petabyte (PB) 1,000 TB or 1,0005 bytes

1 exabyte (EB) 1,000 PB or 1,0006 bytes

Logical storage capacity values (for example, logical device capacity) are
calculated based on the following values:

Logical capacity unit Value

1 block 512 bytes

1 KB 1,024 (210) bytes

1 MB 1,024 KB or 1,0242 bytes
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Logical capacity unit Value

1 GB 1,024 MB or 1,0243 bytes

1 TB 1,024 GB or 1,0244 bytes

1 PB 1,024 TB or 1,0245 bytes

1 EB 1,024 PB or 1,0246 bytes

Accessing product documentation
Product user documentation is available on the Hitachi Data Systems Portal: 
https://portal.hds.com. Check this site for the most current documentation,
including important updates that may have been made after the release of
the product.

Getting help
Hitachi Data Systems Support Portal is the destination for technical support
of your current or previously-sold storage systems, midrange and enterprise
servers, and combined solution offerings. The Hitachi Data Systems customer
support staff is available 24 hours a day, seven days a week. If you need
technical support, log on to the Hitachi Data Systems Support Portal for
contact information: https://portal.hds.com.

Hitachi Data Systems Community is a new global online community for HDS
customers, partners, independent software vendors, employees, and
prospects. It is an open discussion among these groups about the HDS
portfolio of products and services. It is the destination to get answers,
discover insights, and make connections. The HDS Community complements
our existing Support Portal and support services by providing an area where
you can get answers to non-critical issues and questions. Join the
conversation today! Go to community.hds.com, register, and complete your
profile.

Comments
Please send us your comments on this document to doc.comments@hds.com.
Include the document title and number, including the revision level (for
example, -07), and refer to specific sections and paragraphs whenever
possible. All comments become the property of Hitachi Data Systems
Corporation.

Thank you!
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1
Product overview

Hitachi Virtual Storage Platform G400 and Hitachi Virtual Storage Platform
G600 are modular, rack-mountable storage systems.

The storage systems have dual controllers that provide the interface to a data
host. Each controller contains its own processor, dual in-line cache memory
modules (DIMMs), cache flash memory (CFM), battery, and fans. Each
controller also has an Ethernet connection for out-of-band management using
Hitachi Device Manager - Storage Navigator. If the data path through one
controller fails, all hard drives remain available to data hosts using a
redundant data path through the other controller. The storage system allows
a defective controller to be replaced.

Hitachi VSP storage systems allow defective drives to be replaced without
interruption of data availability to host computers. A hot spare drive can be
configured to replace a failed drive automatically, securing the fault-tolerant
integrity of the logical drive. Self-contained, hardware-based RAID logical
drives provide maximum performance in compact external enclosures.

Key components are implemented with a redundant configuration, so that the
storage system can remain operational in the unlikely event that a
component should fail. Adding and replacing components, along with
firmware upgrades, can be conducted while the storage system is operating.

□ Block configuration

□ Hitachi Virtual Storage Platform G400 model

□ Hitachi Virtual Storage Platform G600 model

□ Features

□ Scalability
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Block configuration
A block configuration supports the Fibre Channel, Internet Small Computer
System Interface (iSCSI), and Fibre Channel over Ethernet (FCoE) protocols,
and consists of:
• One controller.
• One or more drive trays (at least one drive tray is required for controllers

that do not contain drives).
• One 1U block service processor server (SVP).

Hitachi Virtual Storage Platform G400 model
The Hitachi Virtual Storage Platform G400 consists of a 4U controller that
includes a controller, but no disk drives. Drives are supported using drive
trays connected to the controller.

The Hitachi Virtual Storage Platform G400 supports 64 GB of high-speed
memory cache, arranged as 32 GB per controller.

The Hitachi Virtual Storage Platform G400 interfaces consists of:
• 8 GB Fibre Channel: 32 ports per system.
• 16 GB Fibre Channel: 16 ports per system.
• 10 GB iSCSI: 16 ports per system.
• Maximum number of drives supported: 384 (480 with dense intermix

drive tray)
• Maximum cache memory supported: 128 GB (64 GB per controller)

Controller Controller chassis Controller model Height

CBLM DW800-CBL DW-F800-CTLM 4U (174.3 mm)

Drive tray
Drive tray model

name
Supported drive

types
Number of drives

supported
Height

SFF drive tray • DW-F800-DBS
(power supply,
contains
BNST)

• DW-F800-
DBSC

2.5-inch SFF 24 2U (86.2 mm)

LFF drive tray • DW-F800-DBL
(power supply,
contains
BNST)

• DW-F800-
DBLC

3.5-inch LFF 12 2U (86.2 mm)
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Drive tray
Drive tray model

name
Supported drive

types
Number of drives

supported
Height

FMD drive tray • DW-F800-DBF Flash module
drive (FMD)

12 2U (86.2 mm)

Dense intermix
drive tray

• DW-F800-
DB60 (power
supply,
contains
BNST)

• DW-F800-
DB60C

3.5-inch LFF 60 4U (174.3 mm)

Hitachi Virtual Storage Platform G600 model
The Hitachi Virtual Storage Platform G600 consists of a 4U controller that
includes a controller, but no disk drives. Drives are supported using drive
trays connected to the controller.

The Hitachi Virtual Storage Platform G600 supports 64 GB of high-speed
memory cache, arranged as 32 GB per controller.

The Hitachi Virtual Storage Platform G600 interfaces consists of:
• 8 GB Fibre Channel: 32 ports per system.
• 16 GB Fibre Channel: 16 ports per system.
• 10 GB iSCSI: 16 ports per system.
• Maximum number of drives supported: 576 (720 with dense intermix

drive tray)
• Maximum cache memory supported: 256 GB (128 GB per controller)

Controller Controller chassis Controller model Height

CBLM DW800-CBL DW-F800-CTLM 4U (174.3 mm)

Drive tray
Drive tray model

name
Supported drive

types
Number of drives

supported
Height

SFF drive tray • DW-F800-DBS
(power supply,
contains
BNST)

• DW-F800-
DBSC

2.5-inch SFF 24 2U (86.2 mm)

LFF drive tray • DW-F800-DBL
(power supply,
contains
BNST)

• DW-F800-
DBLC

3.5-inch LFF 12 2U (86.2 mm)
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Drive tray
Drive tray model

name
Supported drive

types
Number of drives

supported
Height

FMD drive tray • DW-F800-DBF Flash module
drive (FMD)

12 2U (86.2 mm)

Dense intermix
drive tray

• DW-F800-
DB60 (power
supply,
contains
BNST)

• DW-F800-
DB60C

3.5-inch LFF 60 4U (174.3 mm)

Features

Feature Value

Maximum cache memory supported VSP G400: 128 GB

VSP G600: 256 GB

Maximum number of spare drives 32

Maximum number of RAID groups 200

Maximum volume size 128 TB

Maximum number of volumes and host groups 4,095

Maximum number of volumes and RAID groups 1,024

Maximum number of DP pool volumes 4,095

Maximum number of DP pools 64

Maximum number of Fibre Channel devices
connected through a Fibre Channel switch

128

Maximum number of iSCSI hosts connected
through a network switch

255

Scalability
All storage systems offer pay-as-you-grow scalability by allowing you to hot-
add drives as you need them.

Examples of supported Hitachi Virtual Storage Platform G400
configurations

Drive tray
Maximum number of

drives supported
Number of mountable flash drives

SFF drive tray 384 384
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Drive tray
Maximum number of

drives supported
Number of mountable flash drives

LFF drive tray 192 192

FMD drive tray 192 N/A

Dense intermix drive tray 480 480

Examples of supported Hitachi Virtual Storage Platform G600
configurations

Drive tray
Maximum number of

drives supported
Number of mountable flash drives

SFF drive tray 576 576

LFF drive tray 288 288

FMD drive tray 288 N/A

Dense intermix drive tray 720 720

Maximum number of mounted drive trays

Number of mounted drive trays for VSP G400
(up to 12 per path)

Maximum number of mounted drives for VSP
G400

SFF, LFF drives
Dense intermix drive

tray
SFF drive + dense
intermix drive tray

LFF drive + dense
intermix drive tray

16 0 384 192

14 1 396 228

12 2 408 264

10 3 420 300

8 4 432 336

6 5 444 372

4 6 456 408

2 7 468 444

0 8 0 480

Number of mounted drive trays for VSP G600
(up to 6 per path)

Maximum number of mounted drives for VSP
G600

SFF, LFF drives
Dense intermix drive

tray
SFF drive + dense
intermix drive tray

LFF drive + dense
intermix drive tray

24 0 576 288

22 1 588 324
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Number of mounted drive trays for VSP G600
(up to 6 per path)

Maximum number of mounted drives for VSP
G600

SFF, LFF drives
Dense intermix drive

tray
SFF drive + dense
intermix drive tray

LFF drive + dense
intermix drive tray

20 2 600 360

18 3 612 396

16 4 624 432

14 5 636 468

12 6 648 504

10 7 660 540

8 8 672 576

6 9 684 612

4 10 696 648

2 11 708 684

0 12 0 720

Note: Some configurations might exceed 240 slots per path. If a drive is
inserted into a configuration that exceeds 240 slots per path, the drive is
blocked.
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2
Hardware description

This chapter provides a tour of the storage system hardware.

□ Storage system controllers

□ Controller interfaces

□ Storage system drive trays

□ Service Processor

Hardware description 29
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Storage system controllers
Every storage system has two controllers. The controllers contain fans and
power supplies, and provide the interfaces between a host and the storage
system.

A controller manages the I/O between the host system and data volumes.

CBLM controller

CBLM with front panel bezel
 

 

Number Item Description

1 POWER LED Green: storage system is
powered on.

Amber: storage system is
receiving power.

2 READY LED Green: normal operation.

3 WARNING LED Off: normal operation.

Amber: component requires
maintenance.

Blink: failure requires
maintenance.

LED might go OFF during user
maintenance.

4 ALARM LED Off: normal operation.

Red: processor failure (system
may be down). See the HDS
Support Portal at https://
portal.hds.com

5 POWER ON/OFF (main switch) Powers the storage system.
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Number Item Description

6 Lock Locks and unlocks the front
panel bezel using the supplied
key.

Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to go off. These LEDs return to their on state
after the storage system recovers from the controller replacement.

CBLM front panel without bezel
 

 

Number Item Description

1 POWER ON/OFF (main switch) Powers the storage system.

2 POWER, READY, WARNING, ALARM
LEDs

See previous table.

3 Controllers Controller 1 (top) and
Controller 2 (bottom).

4 Backup module N/A

5 BACKUP Green: power restoration in
progress following power
outage.

Fast blink green: restoring.

Slow blink green: restoring or
sequential shutdown in
progress.

6 Cache flash memory N/A

7 ALM LED (for cache flash
memory)

Red: cache flash memory can
be removed safely.
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Number Item Description

8  CTL ALM LED Red: controller can be removed
safely.

Blink red: failure with the
controller's power supply unit.

Amber: LAN reset switch was
pressed.

9 LAN-RST switch Use only when instructed by
Hitachi Support.

10  STATUS LED (for BKMF) Green: charging of the battery
in the backup module is
complete.

Red: backup module can be
removed safely.

Blink red one time: main
battery failure.

Blink red two times: backup
battery failure.

Blink red three times: both
batteries failed or preventive
maintenance replacement of
batteries can be performed.

Off: battery is not mounted,
battery-mounting failure
occurred, or firmware is being
upgraded. Off is normal status
for configurations with no
batteries (for example,
BKMF-10 and BKMF-20).

CBLM rear panel
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Number Item

1 Power supply unit

2 Front end module

3 Back end module

4 LAN blade

Controller interfaces
Controllers provide interfaces for connecting, powering, and configuring and
managing the storage system. They also have LEDs to show the status of the
storage system.

Front end module descriptions

8 Gbps Fibre Channel board LEDs and connectors
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Number Item Description

1 Fibre Channel connectors Connect to Fibre Channel
cables.

2 STATUS LED Green: front end module is in
power-on state.

Red: front end module can be
removed safely.

3 PORT LED Red: small form-factor
pluggable can be removed
safely.

Blue: normal link status at 8
Gbps.

Green: normal link status at 2
Gbps or 4 Gbps.

16 Gbps Fibre Channel board LEDs and connectors
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Number Item Description

1 STATUS LED Green: front end module is in
the power-on state.

Red: front end module can be
removed safely.

2 PORT LED Red: small form-factor
pluggable can be removed
safely.

Blue: normal link status at 16
Gbps.

Green: normal link status at 4
or 8 Gbps.

3 Fibre Channel connectors Connect to Fibre Channel
cables.

10 Gbps iSCSI board LEDs and connectors
 

 

Number Item Description

1 STATUS LED Green: front end module is in
the power-on state.

Red: front end module can be
removed safely.

2 PORT LED Red: small form-factor
pluggable can be removed
safely.

Blue: normal link status.
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Number Item Description

Blink blue: front end module is
in communication status.

3 iSCSI connectors Connect to Ethernet LAN
cables.

Back end module LEDs and connectors
 

 

Number Item Description

1 STATUS LED Green: back end module is in
the power-on state.

Red: back end module can be
removed safely.

2 Port LED Blue: link status is normal.

3 PATH 0 connector Connect to a drive tray.

4 PATH 1 connector Connects to a drive tray.

Power supply unit LEDs and connectors
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Number Item Description

1 ALM/RDY LED Red: power supply unit can be
removed safely.

2 Receptacle Connect to the power cable
supplied with the storage
system.

3 RDY LED Green: normal operation.

Storage system drive trays
Drive trays contain drives, power supplies, fans, and status LEDs. They also
provide interfaces for connecting to controllers and other drive trays.

Small form factor (SFF) drive tray

SFF with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: Nonfatal error. Storage
system can remain operating.

This LED can also go ON to
identify the drive tray being
added.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.
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SFF front panel without bezel
 

 

Number Item Description

1 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

3 POWER, READY, LOCATE LEDs See previous table.

4 Small form factor drives Twenty-four 2.5-inch small form
factor drives oriented vertically.
Slots are designated
0-23 ,moving from left to right.

SFF rear panel
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Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber: Shows the ENC when
adding drive trays.

4 ALARM LED Red: ENC can be removed
safely.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connect to a controller or drive
tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Power supply unit N/A

11 Receptacle Connect to the power cable
supplied with the storage
system.

12 AC IN LED Green: normal operation.

13 ALM LED Red: power supply unit can be
removed safely.

14 RDY LED Green: normal operation.

Large form factor (LFF) drive tray

LFF with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.
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Number Item Description

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: Nonfatal error. Storage
system can remain operating.

This LED can also go ON to
identify the drive tray being
added.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

LFF front panel without bezel
 

 

Number Item Description

1 POWER, READY, LOCATE LEDs See previous table.

2 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

3 ACT LED Red: drive stopped due to a
failure and can be removed
safely.

4 Large Form Factor Drives Twelve 3.5-inch large form
factor drives stacked
horizontally. Slots are
designated the following way:

8   9   10  11
4   5   6   7
0   1   2   3

LFF rear panel
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Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber: Shows the ENC when
adding drive trays.

4 ALARM LED Red: ENC can be removed
safely.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connect to a controller or drive
tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Power supply unit N/A

11 Receptacle Connect to the power cable
supplied with the storage
system.

12 AC IN LED Green: normal operation.

13 ALM LED Red: power supply unit can be
removed safely.

14 RDY LED Green: normal operation.

Flash module drive (FMD) tray

FMD with front panel bezel
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Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: can be forced on using
the maintenance utility when
adding drive trays.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

FMD front panel without bezel
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Number Item Description

1 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

3 POWER, READY, LOCATE LEDs See previous table.

4 Flash module drives Twelve flash module drives.
Slots are designated the
following way:

9, 10, 11

6, 7, 8

3, 4, 5

0, 1, 2

FMD rear panel
 

 

Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber: Shows the ENC when
adding drive trays.

4 ALARM LED Red: ENC can be removed
safely.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connect to a controller or drive
tray.
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Number Item Description

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Receptacle Connect to the power cable
supplied with the storage
system.

Dense intermix drive tray

Dense intermix drive tray with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: Nonfatal error. Storage
system can remain operating.

This LED can also go ON to
identify the drive tray being
added.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

Dense intermix drive tray display LEDs
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Number Item Description

1 ACT Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

Note: Drives are organized as follows, starting from the rear of the drive tray
and moving left to right. In the above figure on the left, the rear of the drive
tray is at the top.
• Rear of drive tray: 48 - 59
• 36 - 47
• 24 - 35
• 12 - 23
• Front of drive tray: 00 - 11

Dense intermix drive tray rear panel
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Number Item Description

1 Power supply unit N/A

2 RDY LED Green: normal operation.

3 AC IN LED Green: normal operation.

4 ALM LED Red: power supply unit can be
removed safely.

5 Receptacle Connect to the power cable
supplied with the storage
system.

6 ENC N/A

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 PATH (IN) LED Blue: IN side port is linked up.

10 PATH (IN) connector Connect to a controller or drive
tray.

11 Console This port is reserved.

12 ALARM LED Red: ENC can be removed
safely.

13 LOCATE LED Amber: Shows the ENC when
adding drive trays.

14 POWER LED Green: ENC is in the power-on
state.

Service Processor
Storage systems come with a separate, dedicated 1U service processor (SVP)
on which element manager runs. The SVP (model number 3919435.P)
operates independently from the storage system's CPU and operating system,
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and provides out‑of‑band configuration and management of the storage
system. It also collects performance data for key components of the storage
system to enable diagnostic testing and analysis.

Note: This product is also designed for IT power distribution systems with
phase-to-phase voltage.

The SVP runs Microsoft Windows Embedded Standard 7. This operating
system provides the same look and feel and desktop environment as
Microsoft Windows 7 Professional.

The SVP provides four RJ-45 ports:
• Two ports connect to the storage system controllers (one port for each

controller).
• One port connects to the user's IP network.
• One port connects to a user-supplied management console PC.

Three of the four RJ-45 ports (the ones that connect to the controllers and
the IP network) are configured as a bridge. The SVP can be addressed using
the default IP address 192.168.0.15.

Users are responsible for adopting the appropriate security procedures with
the SVP, including:
• Applying Windows security patches.
• Turning on automatic Windows updates or using the manual Windows

update method.
• Installing antivirus software that has been tested and approved by Hitachi.
• Installing the latest SVP firmware releases from Hitachi.

SVP front panel
The SVP front panel has LEDs, a reset button, and a power button.
 

 

Number Description

1 LEDs. From left to right, the LEDs are:
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Number Description

• BMC Heartbeat
• LAN card 2
• LAN card 1
• Hard drive
• System standby power

2 Reset button.

3 Power button. Applies power to or removes
power from the SVP.

SVP rear panel
The only ports used on the rear panel of the SVP are the power socket and
the four LAN ports.

 

 

Number Description

1 Power socket. Attach the power cable supplied
with the SVP.

2 Four LAN ports arranged as follows:

LAN3 LAN4

LAN1 LAN2

These ports connect to your IP network, the
management console PC, and the user LAN port
on each storage system controller.
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3
Installing the hardware

The following sections describe how to mount, connect, and power up the
storage system hardware.

The following steps describe the recommended order to follow when installing
your storage system.

Note: Do not install the equipment in an environment with temperatures of
104ºF (40ºC) or higher because battery life will be shortened. For more
information about site preparation and installation, refer to the Hitachi Virtual
Storage Platform G200, G400, G600 Site Preparation Guide.

Procedure

1. If your storage system hardware did not arrive in a rack, unpack the
hardware and mount it in a rack.

2. If you ordered drive trays, use SAS cables to connect the controllers to
drive trays and to connect one drive tray to another.

3. Make the required SVP connections.
4. Power up the hardware and confirm normal operation.
5. Configure the storage system for host connections, and then connect the

storage system data ports to a switch that is connected to the hosts.
6. Connect the front bezels to all controllers and drive trays if not already

connected.

□ Unpacking

□ Mounting the hardware

□ Connecting drive trays

□ Connecting to the SVP

□ Powering up the hardware

□ Making host connections
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□ Confirming your connections

□ Attaching and removing the front panel bezel

□ Powering off the storage system

□ Removing cables

□ Storing the storage system

□ Where to go from here
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Unpacking
There are two ways in which the storage system is packed and shipped to
you. It can be shipped completely installed and cabled in a Hitachi rack, or it
will be shipped in multiple boxes for installation into a customer-provided
rack.

If your system was shipped fully assembled and cabled in a Hitachi rack, start
the installation process by connecting the drive trays.

If your system was shipped in separate boxes and needs to be assembled in
your own rack, unpack the storage system.

Note: To avoid condensation from occurring with the storage system, do not
unpack the storage system in a location subject to rapid differences in
temperature.

Procedure

1. Verify that you have received all system components. For damaged or
missing items, contact the shipper.

2. Remove all packing materials, envelopes, and boxes from the cartons.

WARNING!: Because storage system components are heavy,
unpacking should be done by three or more persons.

3. Keep the keys for the front bezels in a safe place.
You will need them to remove the storage system bezel if you upgrade or
replace components.

4. Keep all packing materials and cartons in case you need to transport or
ship the storage system.

5. Start the installation process by mounting the hardware.

Mounting the hardware
After you remove the storage system hardware from the packaging, you are
ready to mount the hardware into a rack. The following procedures assume
that the rack is already assembled.

Hitachi recommends that the storage system hardware be mounted only by
qualified personnel, experienced in mounting hardware into racks, and
knowledgeable of all safety regulations and practices. These instructions are
intended only for use by qualified individuals using all proper safety
equipment.
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Note: Storage system hardware can be extremely heavy, and if not installed
properly could fall, possible causing injury as well as damage to property.

Floor load ratings
The floor space at the installation site must be strong enough to support the
combined weight of the:
• Controller.
• Drive trays.
• Rack.
• All associated equipment.

To ensure adequate load-bearing capacity, plan for the maximum
configuration. The following table lists the weight for maximum
configurations. The table takes into account a rack that is not sold by Hitachi
Data Systems. For rack information, refer to the Hitachi Universal V2 Rack
Reference Guide.

The weights below do not include the rack itself, so add the weight of the
rack to the values shown below. The maximum allowable weight in the
Hitachi rack is 2,000 pounds (907 kg). For more information about the
Hitachi rack, refer to the Hitachi Universal V2 Rack Reference Guide.

Table 1 CBLM and SVP

Controller, SVP Drive trays Weight

1 CBLM 16 SFF drive trays 2597.1 lbs
(1178 kg)

16 LFF drive trays 2581.6 lbs
(1171 kg)

16 FMD drive trays 2940.9 lbs
(1334 kg)

8 dense intermix drive trays 3075.4 lbs
(1395 kg)

SVP — 39.5 lbs
(17.9 kg)

Table 2 CBLM and SVP

Controller, SVP Drive trays Weight

1 CBLM 24 SFF drive trays 3243 lbs
(1471 kg)

24 LFF drive trays 3223.2 lbs
(1462 kg)

24 FMD drive trays 3734.6 lbs
(1694 kg)
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Controller, SVP Drive trays Weight

12 dense intermix drive trays 4515.1 lbs
(2048 kg)

SVP — 39.5 lbs
(17.9 kg)

Mounting the SVP
The SVP comes with two rack rail assemblies. Each assembly consists of an
inner fixed chassis rail that secures directly to the SVP chassis, and an outer
fixed rack rail that secures directly to the rack itself.

Use the following procedures to mount the SVP in a rack.

Choose a mounting location

Procedure

1. Install the SVP in the top bay of the rack.
2. Leave enough distance in front of the rack to enable you to open the

front bezel (approximately 25 inches).
3. Leave approximately 30 inches of clearance in the back of the rack to

allow for sufficient airflow and ease in servicing.

Installing the inner rail extension

The SVP includes chassis ears that you must remove before installing the
rails.
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Procedure

1. Remove the chassis ears.
a. Locate and remove the three screws holding the chassis ear in place.
b. Repeat with the other chassis ear.
 

 
2. Place the inner rail on the side of the chassis aligning the hooks of the

chassis with the rail holes.
3. Slide the rail toward the front of the chassis to secure the rail in place.
4. Secure the chassis with four screws.
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5. Repeat steps 2 through 4 for the other inner rail extension.
 

 

Installing the outer rails to the rack

Procedure

1. Attach the short bracket to the outside of the long bracket.
You must align the pins with the slides. Orient both bracket ends so they
face the same direction.

2. Adjust both the short and long brackets to the proper distance so the rail
fits snugly into the rack.

3. Secure the long bracket to the front side of the outer rail with two M5
screws and the short bracket to the rear side of the outer rail with three
M5 screws.
Use a washer with each screw.

4. Repat steps 1 through 3 for the left outer rail.

Installing the chassis into the rack

Prerequisites
• The inner rails are attached to the chassis.
• The outer rails are installed on the rack.
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Procedure

1. Align chassis rails with the front of the rack rails.
2. Slide the chassis rails into the rack rails, keeping the pressure even on

both sides.
If necessary, press the locking tabs when inserting.
When the server is pushed completely into the rack, the locking tabs
"click" into the locked position.

3. Optional: Insert and tighten the thumbscrews that hold the front of the
server to the rack.
 

 

Mounting the storage system
The storage systems are designed to be installed in a Hitachi rack or
equivalent. The location should not exceed 104°F (40°C); otherwise, the
storage system’s battery life will be shortened. For the SFF and dense trays,
the location should not exceed 95°F (35°C). For more information about the
Hitachi rack, refer to the Hitachi Rack Guide.
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Note: Due to the heavy weight of the controller chassis and drive trays, we
recommend at least two people perform the following procedure.

Prerequisites

• Be sure the rack is secure and is in no danger of falling over.
• Verify that the storage system is turned off, the main switch is in the off

position, and all power cables are removed from the sockets on all
controllers and drive trays.

• Install the rack stabilizers before mounting or servicing the storage system
in the rack.

Procedure

1. Adjust the length of the mounting rails as needed.
The rear rail slides inside the front rail. The rail halves are riveted
together and use no adjustment screws.

2. Attach the mounting rail assemblies to the outside of the rack posts,
using the attaching screws and flange nuts from your rack system.
a. Be sure the front rail support is on the bottom facing forward.
b. The alignment pins fit into the rack holes above and below the

attaching screws.
c. Use the attaching screws and flange nuts from your rack system.
d. Tighten the screws and flange nuts according to your rack system

instructions.
3. Place the controller onto the rails.
4. Secure the controller to the rack.

One screw each side, in the upper hole only. Use the attaching screws
and flange nuts from your rack system. Tighten the screws and flange
nuts according to your rack system instructions.

5. Place the drive tray onto the rails.
6. Secure the drive tray to the rack.

One screw each side, in the upper hole only. Use the attaching screws
and flange nuts from your rack system. Tighten the screws and flange
nuts according to your rack system instructions.

7. To mount additional drive trays, repeat steps 5 and 6.

Connecting drive trays
Drive trays let you increase capacity by adding drives to your storage system.
A drive tray contains both physical components (drives, power, and fan
modules) and logical components (volumes, host groups, and RAID groups).
Each drive tray comes with a SAS cable for connecting to the controller or
another drive tray.
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Maximum drive boxes supported
The CBLM supports a maximum of 720 drives:
• SFF drive trays: 24
• LFF drive trays: 24
• FMD drive trays: 24
• Dense intermix drive trays: 12

Virtual Storage Platform G600 connection rules
Drive trays are installed and connected according to the unit ID number in
ascending order, from bottom to top.

The following figure shows the maximum number of Virtual Storage Platform
G600 drive trays that can be connected and the SAS port numbers for
connecting them. Drive trays are installed and connected in ascending order
of unit ID number, from the bottom of the rack. The maximum number of
drive trays that can be installed depends on the drive tray type.
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Maximum number of installable drive trays
When mounting drive trays, do not exceed the maximum number of installed
drives.

Some configurations may exceed 240 slots per path. If a drive is inserted into
the slot of a configuration that exceeds 240 slots per path, the drive is
blocked. Be sure that your configurations do not exceed 240 slots per path.

Selecting SAS cables
You connect the controllers to the drive trays using a SAS cable. The
following tables are provided to help you choose the SAS cable best suited to
your requirements.

Connecting controllers to drive trays

Connection
source

Connection
destination

chassis

Distance
between chassis*

Cable length
(meters)

Cable
designation

CBLM SFF, LFF, FMD
drive trays

2-10 1.5 DW-F800-SCQ1F

11-34 3 DW-F800-SCQ3

35 or more 5 DW-F800-SCQ5

* One EIA unit is approximately 44.45 mm.

SAS cable connections for SFF, LFF, and FMD drive trays

Connection
destination chassis

Distance between
chassis

Cable length (meters) Cable designation

SFF, LFF, and FMD drive
trays

2-8 1 DW-F800-SCQ1

9-20 1.5 DW-F800-SCQ1F

21-36 3 DW-F800-SCQ3

37 or more 5 DW-F800-SCQ5

Connecting drive trays
Before connecting drive trays, observe the following guidelines:
• If connecting two or more drive trays, use the SAS cable to connect ENC

#1 and ENC #2.
• When using a SAS cable, bend it at least 40 mm and wind it at least 200

mm to relieve cable stress.
• If you insert a SAS cable incorrectly, remove it while gently pulling the tab

on the cable.
• Before attaching SAS cables, unwind, stretch, and untwist them.
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• When inserting the connector into the socket, do not turn the connector
more than 90 degrees. Turn the cable with the cable connector and orient
the connector to match the insertion direction.

Prerequisites

If the ends of the SAS cable have a rubber cap, remove the cap.

Procedure

1. Connect either end of the SAS cable to the SAS port on the controller
chassis. Connect the other end of the cable to the IN port on the drive
tray.
The connector locks in place when secure. Gently tug at the end of the
cable to confirm it is secure; if the cable comes out of the connector,
repeat this step.

2. To connect two or more drive trays, use another SAS cable to connect
the OUT port of the previous drive tray to the IN port on the next drive
tray. Repeat this step for each additional drive tray you want to want to
connnect.

3. Attach labels to all SAS cables.
 

 
The cable snaps into place when connected securely.

4. Pull gently on the cable to confirm that it is connected securely.
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5. Route the SAS cables. For a SFF, LFF, and FMD drive trays: Keep the
cable length between the two connectors at approximately 13.8 - 15.8
inches (350-400 mm). Do not secure SAS cables and the power cables
together.
Connecting a CBLM to 24 SFF, LFF, or FMD drive trays (1 of 4)

 

 

Connecting a CBLM to 24 SFF, LFF, or FMD drive trays (2 of 4)
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Connecting a CBLM to 24 SFF, LFF, or FMD drive trays (3 of 4)
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Connecting a CBLM to 24 SFF, LFF, or FMD drive trays (4 of 4)
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Turning on the drive tray Locate LED
When connecting drive trays, you may find it helpful to have the LOCATE LED
on the drive tray go on.

Procedure

1. In the Hitachi Command Suite main window, click the Resource tab.
2. From the tree view, click Storage Systems.
3. Expand the tree, and then click Maintenance Utility.
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4. In the Chassis tab, click Table to switch the table view.
 

 
5. To turn on the Locate LED, select one or more drive trays, and then click

Turn onfrom the Locate LED list.
The confirmation window appears.

6. Confirm that the information in the window is correct, and then click
Apply.

7. When the Completion message appears, click Close.
8. To turn off the LOCATE LED, repeat steps 5 through 7, but in step 5, click

Turn offfrom the Locate LED list.

Connecting to the SVP
The rear panel of the SVP has four RJ-45 ports. Using Category 5 or better
Ethernet cables, perform the following connections on the SVP. Your
management console must be able to access the SVP.

Procedure

1. Connect LAN1 to a switch on your IP network.

Note: If your network uses IP addresses 192.168.0.15-17, do not
connect the LAN1 port to your switch until after you complete the
Initial Startup.

2. Connect LAN2 to a management console PC.
Typically, this is a notebook PC.

3. Connect LAN3 to the user LAN port on storage system controller 1.
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4. Connect LAN4 to the user LAN port on storage system controller 2.
 

 

Powering up the hardware
Power up the storage system hardware in the proper sequence.

1. Power up the SVP.
2. Power up the storage system controllers.
3. Power up storage system drive trays.

Powering up the SVP

Prerequisites

Power up the SVP before you power up the storage system.
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Procedure

1. Attach the supplied power cable to the power socket on the rear panel of
the SVP.
 

 
2. Plug the other end of the power cable into an AC power source.
3. Push the power button on the front of the SVP.
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Powering up the storage system

Note: The load on a PDU must not exceed 16 A. The load on a PDU breaker
must not exceed 8 A. Load values are:
• One CBLM: 8.0 A
• One SFF drive tray: 2.4 A
• One LFF drive tray: 1.9 A
• One FMD drive tray: 2.6 A
• One dense intermix drive tray: 6.0 A

Procedure

1. Check that the breaker of each PDU is turned off.
2. Connect the power cables to each power socket on the storage system

controllers and drive trays.

 

 
3. Secure the power cable holders on the rear panel of the storage system

to the power cables and route the power cables appropriately.

Note: For SFF, LFF, and FMD drive trays, use omega clips to secure
the power cable.

4. Plug the other end of the power cables into an AC power source.

Note: For redundancy, connect the power cables to feeds from
separate power sources.
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5. To ensure that the controller and drive trays are receiving power, confirm
that the POWER LED is on at the front panel of the controller and drive
trays.

6. Press the main switch on the front of the controller chassis for about
three seconds.

 

 
7. Verify that the READY LED on the controller chassis changes from amber

to green (takes approximately 33 minutes).

Confirming normal operation
After powering up the storage system, confirm that the system is operating
normally.

Check the storage system for any alarm indications indicated by the LEDs.
For example:
• The amber WARNING LED or red ALARM LED is on.
• The green READY LED does not go on.

If you suspect there might be a problem and you enabled email notifications,
check for an email about an error. If you enabled Simple Management
Network Protocol (SMNP), check your SNMP application for any traps received
from the storage system.

If an error has occurred, use the maintenance utility to identify and correct
the problem.
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Making host connections
A host is a server that can store and retrieve data on the storage system.
Each host runs its own operating system.

Your storage system provides Fibre Channel ports, iSCSI ports, or both to
connect to your hosts. Before you make these connections, prepare the
storage system and the hosts by:
• Configuring the storage system for the operating systems running on the

hosts. Refer to the Hitachi Open-Systems Host Attachment Guide and the
HDS Product Interoperability Documentation at http://www.hdss.com/
products/interoperability.

• Following the instructions in your vendor documentation for preparing your
hosts, HBAs, NICs, and iSCSI initiators for use with the storage system.

Note: When configuring your switch, be sure the number of hosts
connected to the storage system does not exceed the number of
data ports on the storage system.

Fibre Channel connections

A Fibre Channel SAN requires:
• A Fibre Channel switch.
• A Fibre Channel HBA in each host computer.

After you prepare the storage system for your host operating systems,
establish the data path between the storage system and hosts using the
following procedure and referring to the figures of the storage system.

Tip: Before connecting Fibre Channel cables, use the Backend Configuration
Kit (BECK) tool to ascertain the recommended data paths for the controller
and drive trays in your configuration.

Procedure

1. Using LC-LC optical cables, connect the Fibre Channel data ports on each
controller to your Fibre Channel switch.

2. Connect your Fibre Channel switch to the Fibre Channel HBA card in each
host computer (refer to your vendor documentation).

iSCSI connections
If your storage system has iSCSI ports, use the information in this section to
connect the ports to your hosts.

An iSCSI SAN requires:
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• A 10 Gigabit Ethernet switch.
• A 10 Gb NIC or HBA card in each host computer.
• A 10 Gb iSCSI initiator.

After you prepare the storage system for your host operating systems,
establish the data path between the storage system and hosts using the
following procedure.

Tip: Before connecting iSCSI cables, use the Backend Configuration Kit
(BECK) tool to ascertain the recommended data paths for the controller and
drive trays in your configuration.

Procedure

1. Using LC-LC optical cables, connect the iSCSI data ports on each
controller to your Gigabit Ethernet network switch.

2. Connect your network switch to the NIC or iSCSI HBA in each host
computer (refer to your vendor documentation).

Confirming your connections
After you make your hardware connections at the storage system rear panel,
ensure that all connections are correct. Use the following sample figure as a
guide.
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Attaching and removing the front panel bezel
The following procedures describe how to attach the front panel bezel on the
storage system controllers and drive trays, and how to remove the front
bezel.

Attaching the front bezel to the SVP
The SVP has a removable front bezel.

To attach the SVP front bezel:
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Procedure

1. Use the supplied key to unlock the front bezel. Hold the key and the
bottom of the bezel with both hands, so the front of the bezel is facing
you.

2. Insert the tabs on the left-front side of the SVP into the tab holes on the
front bezel.

3. Push the right side of the bezel to engage it with the ball catch on the
front of the SVP to secure the bezel.

4. Use the supplied key to lock the front bezel. Before turning the key,
verify that it is inserted completely into the lock. Otherwise, you can
damage the key.

 

 

Removing the front bezel from the SVP

Procedure

1. Use the supplied key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch
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3. Holding the lower right part of the bezel, gently pull the key toward you
and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

4. Disengage the front bezel from the left tabs and then remove the bezel.

Attaching the front bezel to a SFF, LFF, or FMD

Procedure

1. Use the supplied key to unlock the front bezel.
Hold the key and the bottom of the bezel with both hands, so the front of
the bezel is facing you.

2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Use the supplied key to lock the front bezel.
Before turning the key, verify that it is inserted completely into the lock.
Otherwise, you can damage the key.

4. Remove the key from the lock.
Align the groove of the key with the positioning mark on the lock.
Otherwise, you can damage the lock.
 

 

Removing the front bezel from a DBS or DBL drive tray

Procedure

1. Use the supplied key to unlock the bezel.
2. Disengage the front bezel from the left tabs and then remove the bezel.
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Remove the front bezel from a CBLM or CBLH controller

Procedure

1. Use the supplied key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

 

 
3. Disengage the front bezel from the left tabs and then remove the bezel.

Attaching the front bezel to a CBLM or CBLH controller

Procedure

1. Use the supplied key to unlock the front bezel.
Hold the key and the bottom of the bezel with both hands, so the front of
the bezel is facing you.
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2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Push the right side of the bezel until it engages with the ball catch on the
front of the storage system to secure the bezel.

4. Use the supplied key to lock the front bezel.
Before turning the key, verify that it is inserted completely into the lock.
Otherwise, you can damage the key.

5. Remove the key from the lock.
Align the groove of the key with the positioning mark on the lock.
Otherwise, you can damage the lock.
 

 

Attaching the front bezel to a dense intermix drive tray

Procedure

1. Use the supplied key to unlock the front bezel.
Hold the key and the bottom of the bezel with both hands, so the front of
the bezel is facing you.

2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Push the right side of the bezel until it engages with the ball catch on the
front of the storage system to secure the bezel.

4. Use the supplied key to lock the front bezel.
Before turning the key, verify that it is inserted completely into the lock.
Otherwise, you can damage the key.
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5. Remove the key from the lock.
Align the groove of the key with the positioning mark on the lock.
Otherwise, you can damage the lock.
 

 

Removing the front bezel from a dense intermix drive tray
To prevent the rack from tipping when removing a dense intermix drive tray:
• Do not remove multiple dense intermix drive trays at one time.
• After removing the dense intermix drive tray, do not place objects on it or

use it as working space.

To remove the front bezel from the dense intermix drive tray:

Procedure

1. Use the supplied key to unlock the bezel.
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2. Holding the lower right part of the bezel, gently pull the key toward you
and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

 

 
3. Disengage the front bezel from the left tabs and then remove the bezel.

Powering off the storage system

Procedure

1. Press the main switch for three seconds until the POWER LED blinks.
2. Verify that the POWER LED on the front of the storage system changes

from green to amber.
It can take from 25 minutes to 4 hours for the POWER LED to turn amber,
depending on the configuration of the system (check after 33 minutes).

3. To stop the power supply from supplying power, remove the power cables
from the power supply units on the controller chassis and drive box.
If the storage system is connected to a PDU, you can stop the power
supply by turning off the PDU breaker.
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Note: If the storage system does not receive power for more than
six months, the battery can become discharged and possibly
damaged. To avoid this situation, charge the battery for more than
three hours at least once every six months.

Removing cables
Observe the following instructions when removing cables form the storage
system.

To remove a SAS cable, pull the tab of the SAS cable (1) to release the latch
and remove the SAS cable (2).

 

 

To remove an optical cable, push the top of the connector of the optical cable
(1) to release the latch and remove the SAS cable (2).

 

 

To remove a LAN cable, push the top of the LAN cable connector (1) to
release the latch and remove the LAN cable (2).
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Storing the storage system
If the storage system does not receive power for more than six months, the
battery can become discharged and possibly damaged. To avoid this
situation, charge the battery for more than three hours at least once every
six months.

Note: Do not store the equipment in an environment with temperatures of
104ºF (40ºC) or higher because battery life will be shortened.

Using flash drives and flash module drives
If a storage system contains flash drives, power up the flash drives using
power from the storage system for at least 90 minutes every month. Failing
to do so may render a flash drive or FMD drive tray unusable and will
abrogate replacement under the terms of the warranty.

Where to go from here

After you complete all of the installation steps, continue to set up your
system by performing the initial configuration procedures.
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4
Performing the initial configuration

After all storage system installation procedures are complete, configure the
storage system for the first time.

When configuring the storage system for the first time, you run the Initial
Startup Wizard followed by the Initial Setup Wizard.

After running the Initial Setup Wizard, you configure email and SNMP alert
notifications, and install and enable licenses, using the maintenance utility.

You perform these procedures using Remote Desktop Client on a
management console computer (PC) connected to LAN port 2 on the SVP. The
PC must be on the same subnet as the SVP and the storage system.

□ Running the Initial Startup Wizard

□ Running the Initial Setup Wizard

□ Configuring alert notifications

□ Installing and enabling licenses

□ Setting the SVP date, time, and timezone settings

□ Disconnecting from the SVP
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Running the Initial Startup Wizard
The Initial Startup Wizard allows you to specify the storage system IP
addresses. As you specify your configuration settings, record them for future
reference. You run this Wizard using the PC connected to the LAN1 port of
the SVP.

Note: The Initial Startup Wizard takes about 15 minutes to complete.

Procedure

1. From the PC connected to the SVP, click Start > All Programs> >
Accessories > Remote Desktop Connection.
The Remote Desktop Connection window appears.
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2. In the Computer field, type 192.168.0.15, and then click Connect.
The Windows Security screen appears.
 

 
3. Type the following in the top and bottom fields, and then click OK:

• Top field: SVP-PC\SVP
• Bottom field: raid-login

 

 
4. If prompted that the identity of the remote computer cannot be verified,

click Yes.
5. Perform the following steps on the SVP:

a. Click the Start button, and then click All Programs > Hitachi
Device Manager-Storage Navigator.

b. Right-click Initial Startup Tool and click Run as administrator.
c. At the bottom of the Initial Startup screen, click Start Setup.
d. When a message about checking the initial environment appears, click

OK.
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Note: If an error message states that the SVP does not support
the DHCP network setting, close the error window, assign a static
address to the SVP, and log in to the SVP again.
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6. Complete the fields on the Initial Startup Tool page and record your
settings.
 

 

Parameter Description Factory default

Default Account Read-only field that shows the
currently logged in user.

New Password Enter a new case-sensitive
password of your choice that
you will use to access the
maintenance utility. Range:
6-255 characters. If you will
use Hitachi HiCommand Initial
Setup wizard, you will need to
enter this password again in
the Add Storage System
page.

N/A

Re-enter New Password Enter the same case-sensitive
password you entered in the
New Password field. Record
this password, as you will
enter it in the Initial Setup
Wizard.

N/A
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Parameter Description Factory default

Network Settings - IPv4
Configuration

Storage System Address IP address for each controller,
entered in dotted-decimal
notation.

Controller 1

192.168.0.16

Controller 2

192.168.0.17

SVP Address IP address for the SVP,
entered in dotted-decimal
notation. Record the IP
address, as you will refer to it
when running the Initial Setup
Wizard.

192.168.0.15

Subnet Mask Subnet mask of the network
to which the storage system
is connected.

255.255.255.0

Default Gateway Default gateway address of

the network to which the

storage system is connected.

N/A

DNS Server 1

DNS Server 2

DNS Server 3

IP addresses for up to three
Domain Name Systems
servers, entered in dotted-
decimal notation. DNS servers
translate (resolve) human-
memorable domain names
and hostnames into the
corresponding numeric
Internet Protocol (IP)
addresses.

N/A

IPv6 Configuration Enables or disables IPv6
addressing. If you select
Enable, the settings for
configuring IPv6 appear.

Disable

7. Click Apply.
A Setup Progress screen shows the progress of the initial startup.

8. When the Initial Startup is complete, click Close.
The SVP reboots automatically (5 to 10 minutes).

Note: The Remote Desktop Connection session ends when the SVP
reboots. Restart the Remote Desktop Connection using the
procedure above to prepare for the Initial Setup Wizard.

9. Remove the PC cable from the LAN2 port on the SVP and connect the
cable to SVP LAN port 1.

10. Proceed to Running the Initial Setup Wizard on page 87.
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Running the Initial Setup Wizard
After you run the Initial Startup Wizard, run the Initial Setup Wizard from the
same management console PC.

The Initial Setup Wizard allows you to specify the storage system name and
location, date and time, and network settings. As you specify your
configuration settings, record them for future reference.

Procedure

1. From the PC connected to the SVP, click Start > All Programs> >
Accessories > Remote Desktop Connection.
The Remote Desktop Connection window appears.

2. In the Computer field, type 192.168.0.15, and then click Connect.
3. At the next screen, click the SVP icon.
4. At the next screen, type the username maintenance and the password

raid-maintenance, and then press Enter:
5. If prompted that the identity of the remote computer cannot be verified,

click Yes.
6. Double-click the following icon on the SVP desktop:

 

 
The Storage Device List appears.

7. Click the plus (+) sign in the Storage Device List.
8. On the SVP, click Start > All Programs > Hitachi Device Manager-

Storage Navigator > StorageDeviceList.
9. In the Storage Device List window, click the picture of the registered

storage system.
10. If prompted about a security certificate, select Continue to this

website.
11. Log in to Hitachi Device Manager - Storage Navigator.
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12. On the Maintenance Utility menu, click Hardware > Other hardware
maintenance.
The maintenance utility starts.
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13. In the left pane of the Maintenance Utility window, under Menu, click
Initial Setup Wizard.
The Initial Setup Wizard starts, with the Set Up System Information
page displayed.

 

 
14. Complete the fields in the Set Up System Information page.

Parameter Description

Storage System Name Enter a name to identify this storage system,

up to 180 alphanumeric characters. The

following characters are not permitted:

\ , / ; : * ? ” < > | & % ^

Contact Enter the name of the contact person for the

storage system, up to 180 alphanumeric

characters.

Location Enter the location where the storage system

resides, up to 180 alphanumeric characters.

Performing the initial configuration 89
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



15. Click Apply and Next.
The Set Up Date & Time page appears.

 

 
16. Complete the fields in the Set Up Date & Time page.

Note: The settings on the Set Up Date & Time page do not apply
to the SVP. Date and time settings on the SVP can be changed
using the controls in the Microsoft Windows 7 operating system
running on the SVP (see Managing the SVP date and time settings
on page 99).

Parameter Description

UTC Timezone Select the time zone in which the storage

system is located.

Use NTP Server Select whether you want the time source for

the storage system to be a Network Time

Protocol (NTP) server. An NTP server receives

its time from an authoritative time source,

such as an atomic clock attached to a time
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server, and then distributes this time across

the network to your storage system.
• Yes = storage system time will be

synchronized to an NTP server. Enter the
IP address of the NTP server in the NTP
Server field.

• No = storage system will use the date and
time you enter in the Date & Time fields.

Synchronizing Time To synchronize the storage system with a

specific time every day, enter the

synchronizing time.

17. Click Apply and Next.
18. When theSet Up Network Settings page appears, click Apply to accept

the settings on this page.
The Finish page appears.

19. Click Close to complete the Initial Setup Wizard.
20. Leave the Maintenance Utility window open and proceed to Configuring

alert notifications on page 91.

Configuring alert notifications
After running the Initial Setup Wizard, use the maintenance utility to
configure email and SNMP delivery of alert notifications, and location
identification. You can also send a test alert e-mail.

You perform this procedure using the management console PC. This
procedure assumes the following:
• The management PC is connected to the LAN 2 port on the SVP.
• The PC has established a Remote Desktop Connection with the SVP.
• The Management Utility window is displayed on the PC.
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Procedure

1. In the left pane of the Maintenance Utility window, click
Administration > Alert Notification.
The Alert Notifications page appears.
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2. In the Alert Notifications page, click Set Up.
The Set Up Alert Notifications page appears, with the Email tab
displayed.
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3. Complete the fields in the Email tab and record your settings.

Parameter Description

Notification Alert Set to Host Report to receive notifications

about meaningful events only (not all events).

Email Notice Click Enable to activate email alert
notifications.

Email Address (To) Click Add to add an email address. When the
Add Email Address window appears:
• Enter an email address.
• Select whether this address receives the

alert (To), a copy of the alert (Cc), or a
blind copy (Bcc) of the alert.

• Click OK.

A Delete button lets you delete selected email
addresses.

 

 

Email Address (From) Enter the name that will appear as the sender
on the email alert.

Email Address (Reply To) Enter the email address to which replies can
be directed.

Mail Server Settings Mail Server: Select Identifier or the IP
addressing scheme (IPv4 or IPv6) used by
the mail server.
• If you selected Identifier, enter the name

of the mail server.
• If you selected IPv4 or IPv6, enter the

appropriate IP address for the mail server.

SMTP Authentication If your mail server uses authentication, enter

the name (Account) and password required to

authenticate to the mail server.
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4. To configure SNMP alert notifications, click the SNMP tab, and then
complete the fields in theSNMP tab and record your settings.

Note: Before enabling SNMP, configure your trap receiver or SNMP
server with the Management Information Base (MIB) definition file
VSPGx00MIB.txt. The MIB definition file is located in the program
\SNMP folder of the software media kit.

 

 

Parameter Description

Notification Alert Set to Host Report to receive notifications

about meaningful events only (not all events).

SNMP Agent Click Enable to activate SNMP alert
notifications.

Trap Destination Click Add to add an SNMP trap. When the Add
SNMP Trap window appears:
• Enter a new IPv4 or IPv6 address, or

select an existing one.
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• Enter or select an existing community
string.

• Click OK.

A Delete button lets you delete selected trap
destinations.

 

 

SNMP Manager Click Add to add an SNMP manager. When the
Add SNMP Manager window appears:
• Enter a new IPv4 or IPv6 address, or

select an existing one.
• Click OK.

A Delete button lets you delete selected trap
destinations.
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System Group Information If the storage system name, contact, or
location need to be changed, edit the
information shown as required.

5. Click Apply.
6. When the Information window tells you that alert notifications are

complete, click OK.
7. To send a test email, click Send Test Email in the Email tab.

A test email is sent to the IP address(es) you specified in the Set Up
Alert Notifications page.

8. Proceed to Installing and enabling licenses on page 97.

Installing and enabling licenses
After configuring alert notifications, use the maintenance utility to add and
install and enable licenses for the Hitachi program products you want to
install.

You perform this procedure using the management console PC. This
procedure assumes the following:
• The management PC is connected to the LAN 2 port on the SVP.
• The PC has established a Remote Desktop Connection with the SVP.
• The Management Utility window is displayed on the PC.
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Procedure

1. In the left pane of the Maintenance Utility window, click
Administration > Licenses.
The Licenses page appears.
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2. To install a license key:
a. In the License Keys window, click Install.

The Install Licenses window appears.

 

 
b. If you have a license key code, click License Key Code and enter the

code in the adjacent field. If you have a license key file, click License
Key File, and then click the Browse button, go to the location where
the license key file is located, click the file, and click Open.

c. Click Apply.
d. When the completion message appears, click OK.

3. After you install licenses, you can enable them:
a. On the Licenses page, check the licenses you want to enable.
b. Click Enable.
c. When the Selected License Keys page appears, click Apply.
d. When the Completion message appears, click OK.

4. After installing and enabling the desired licenses, proceed to Setting SVP
date and time on page 99.

Setting the SVP date, time, and timezone settings
Set the SVP date, time, and timezone to the local time where the SVP is
installed. You specify these settings using the Microsoft Windows 7 operating
system running on the SVP.

You perform this procedure using the management console PC. This
procedure assumes the following:
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• The management PC is connected to the LAN 2 port on the SVP.
• The PC has established a Remote Desktop Connection with the SVP.
• The Management Utility window is displayed on the PC.

Procedure

1. In the desktop, click the Start button, and then click Control Panel.
2. Click Clock, Language, and Region.

The Clock, Language, and Region window appears.
3. Click Date and Time.

The Date and Time window appears, with the Date and Time tab
displayed.

 

 
4. Click Change date and time.

The Date and Time Settings window appears.
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5. Set the year, month, day, and time.
 

 
6. Click OK.
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7. In the Date and Time tab, click Change time zone.
 

 
The Time Zone Settings window appears.
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8. Select a UTC timezone from the drop-down list, and then click OK.
 

 
9. Click OK.

10. Close the Windows Control Panel.

Disconnecting from the SVP

To disconnect the management console PC from the SVP:

Procedure

1. Click the Start button on the SVP desktop.
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2. Click Log off > Disconnect.
 

 

Result

The SVP disconnects from the PC.
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5
Troubleshooting

This chapter covers troubleshooting topics related to the replacement of
components.

□ General troubleshooting

□ Using LEDs to diagnose problems

□ Checking alerts

□ Checking SIM alerts

□ Checking hardware replacement alerts

□ Troubleshooting Hitachi Device Manager - Storage Navigator

□ Dump tool

□ Troubleshooting the maintenance utility

□ Turning the storage system on or off using the maintenance utility

□ iSCSI troubleshooting

□ SVP troubleshooting

□ About working with firewalls

□ Configuring the audit log
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General troubleshooting

Host cannot access storage

Procedure

1. Verify that the ACT LED on the data port is on. If not, try a different data
port.

2. Check that all data port cables are connected securely at both ends.
3. Send a ping command from the host to the storage system. If the ping

fails, verify that the host is communicating with the storage system at
the appropriate IP address.

4. Check whether other devices in your network, such as a router or switch,
are the cause of the problem.

5. If these steps do not fix the problem, contact HDS support at http://
portal.hds.com.

Correct values for the storage system IP address
Set appropriate value IP address, subnet mask, and default gateway settings
for the storage system for the customer environment.

IPv4 default value
Controller 1:
Controller 2:
IP Address: 192.168.0.16
Subnet Mask: 255.255.255.0
Default gateway: 0.0.0.0
Controller board #2:
IP Address: 192.168.0.17
Subnet Mask: 255.255.255.0
Default gateway: 0.0.0.0

IPv6 default value
Controller 1:
IP Address: Auto
Controller 2:
IP Address: Auto

DHCPv4 configuration for storage systems
If the storage system is configured to use DHCPv4, connect with the IP
address assigned by the DHCPv4 server. When using DHCPv4 server,
configure the storage system to use a static IP address.
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If the storage system does not receive an IP address from a DHCP server
when it is configured for DHCP, Hitachi Device Manager - Storage Navigator
cannot connect to the storage system. Contact your network administrator,
and review the DHCPv4 server settings.

Default value
DHCPv4: Off (Static IP Address)

IP address being used by other storage systems or hosts
If the storage system is using the same IP address is used by other devices,
Hitachi Device Manager - Storage Navigator cannot connect to the storage
system. Assign an IP address to the storage system that is not used by
another device.

IP address configuration for the host
Use Hitachi Device Manager - Storage Navigator to set the IP address, subnet
mask, and default gateway that the host can use to communicate with the
storage system.

TCP/UDP port filtering being performed on the network switch
The default TCP port number for Hitachi Device Manager - Storage Navigator
is 2000. Set an appropriate value for the customer's environment.
[default port number]: 2000 (standard)
28355 (secure)
Change the port number in environments that use Cisco SIP Phones.

Search Storage system performed across the IPv6 routers
The Auto Search Storage system of IPv6 uses link-local scope multicast. The
IPv6 router is unable to transfer this multicast to other local links, so the IPv6
router is unable to search storage systems across the IPv6 router. For
different local links, register the storage system using a static IP address
search.

Using LEDs to diagnose problems
If the storage system used in a remote TrueCopy configuration restarts with
the TrueCopy status of enabled, the following occur:
• The path used by TrueCopy becomes blocked. Notifications from the

Hitachi Device Manager - Storage Navigator email alert function, SNMP
Agent Support function, and TRAP occur when the path is blocked. Follow
the instructions in the notification. The blocked path recovers
automatically after restarting the storage system.
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• If the TrueCopy pair status is PAIR or COPY, the pair changes to PSUE. In
this case, suspend the paris before restarting the storage system.

POWER LED does not go on

Procedure

1. Set the main switch to on.
2. Is the POWER LED on at the controller?

• Yes: Go to step 10.
• No: Power on the host computer.

3. Is the POWER LED on at the controller?
• Yes: Go to step 10.
• No: Set the main switch to off.

4. Check that the PDU on the rack is delivering power to the storage
system.

5. Verify that the AC cable is correctly connected to the plug socket and the
equipment.

6. Set the main switch to on.
7. Is the POWER LED on at the controller?

• Yes: Go to step 10.
• No: Set the main switch to off.

8. Contact your administrator. Go to step 10.
9. Is the READY LED on?

• Yes: Continue to use the equipment, even if the green READY LED
blinks fast.

• No: See READY LED does not go on or READY LED went on and then off.
10. End of procedure.

POWER LED turned off

Procedure

1. Is AC power being supplied?
• Yes: Go to step 2.
• No: Supply AC power to the storage system and restart the storage

system. Go to step 2.
2. Set the main switch to off.
3. Wait over a minute and then set the main switch to on.
4. Is the POWER LED on at the controller?

• Yes: go to step 6.
• No: set the main switch to off.

5. Contact your administrator. Go to step 7.
6. Is the READY LED on at the controller?
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• Yes: Use the equipment in its current operational state, even if the
green READY LED blinks fast.

• No: See READY LED does not go on or READY LED when on and then
off.

7. End of procedure.

READY LED does not go on or READY LED went on and then off

Procedure

1. Is the controller POWER LED on?
• Yes: Go to step 2.
• No: Go to step 4 in POWER LED does not go on.

2. Is the ALARM LED on at the controller?
• Yes: See ALARM LED is on.
• No: Go to step 3.

3. Turn off the main switch.
4. Wait more than one minute and then set the main switch to on.
5. Is the READY LED on at the controller?

• Yes: Continue to use the equipment. If the green READY LED blinks
fast, the storage system is operational. Go to step 8.

• No: Go to step 8.
6. Set the main switch to off.
7. Contact your system administrator.
8. End of procedure.

ALARM LED is on.

Procedure

1. Identify which components failed.
2. Contact your system administrator and do not disturb the equipment.

WARNING LED goes on or blinks.

Procedure

1. Does the amber WARNING LED on the controller blink fast?
• Yes: Identify which components in the controller chassis failed using

Hitachi Device Manager - Storage Navigator. Go to step 5.
• No: Go to step 2.

2. Does the amber WARNING LED at the controller blink slowly?
• Yes: At the controller, wait for the amber WARNING LED to go off and

the green READY LED to go on.
• No: Go to step 3.
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3. Is the green READY LED at the controller on?
• Yes: Go to step 5.
• No: See READY LED does not go on or READY LED went on and then off

4. Continue to use the equipment and contact your system administrator.
5. End of procedure.

Checking alerts

If an alert, warning, or information item appears in the maintenance utility,
but there is no service information message (SIM) associated with it, use the
following procedure to obtain more information about the item.

Procedure

1. In the navigation area of the Maintenance Utility window, check the
status of the storage system.
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2. In the header area, click Alert.
The Alerts tab appears.

 

 

Status Description Navigation area Alert color

Failed The storage system

might be down.

 

 

Red

Warning A part has a Blocked,

Failed, or Warning

status.

 

 

Amber

Information Alert does not have a

SIM defined for it.

 

 

Amber

Ready All parts have a normal

status.

 

 

Green

Power-on in progress Power-on is in

progress.

 

 

—

Power-off in progress Power-off is in

progress.

 

 

—
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Status Description Navigation area Alert color

Unknown The storage system is

in an unknown state

prior to power on..

 

 

—

3. In the Alerts tab, click DKC and GUM, and then check the alerts.
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4. Under the Alert ID column, click an entry.
The Alert Detail window appears.

 

 
5. To check the internal alert, click Internal Alerts (DKC) or Internal

Alerts (GUM) from the View Internal Alerts list. Click an entry under
Alert ID.
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6. When the Alert Detail window appears, check the alert information:
• SSB shows high-priority error information.
• SSBS = shows low-priority error information.

SSB Tab in the Internal Alerts (DKC) Window
 

 
SSBs Tab in the Internal Alerts (DKC) Window
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Internal Alerts (GUM) Window
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Checking SIM alerts
Some alarm, warning, and information notifications shown in the
Maintenance Utility window include service information message (SIM)
alerts.

Procedure

1. In the navigation area of the Maintenance Utility window, check the
status of the storage system.

2. In the header area, click Alert.
The Alerts tab appears.
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3. In the Alerts tab, click DKC and GUM, and then check the SIM alerts.
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4. Under the Alert ID column, click a character string.
An Alert Detail window similar to the following appears.
 

 
5. Check the alert information in the window.
6. To check an internal alert:

a. Click Internal Alerts (DKC) or Internal Alerts (GUM) from the
View Internal Alerts list.

b. Click the character string of the Alert ID to open the Alert Detail
window.

c. Check the alert information. The SSB tab shows high-priority error
information, while the SSBS tab shows low-priority error information.

Checking hardware replacement alerts
The Maintenance Utility window displays alerts when hardware components
need to be replaced.

Procedure

1. In the Maintenance Utility window, click Hardware > target
hardware.

2. Click the Status link for the hardware.
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3. Open the Related Alerts window for the appropriate hardware
component (see the following table).

Parts Main window Tab Status link

Controller chassis Controller Chassis

window

Drives Status

CTLs CTL Status

CMG Status

BKMFs BKMF Status

Battery - Status

CFMs Status

CHMs Status

CHBs Status

SFP Status

DKBs Status

LANBs Status

PSs Status

Small Form-Factor

Pluggable window

— SFP Status

Drive tray Drive Box window Drives Status

ENCs Status

PSs Status
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4. When the Related Alerts window appears, check for alerts that indicate
hardware that needs to be replaced. For example:
 

 
Only the alerts including the action codes of the specified parts and the
related parts are displayed. To check the action codes, click the character
string in the Alert ID column to open an Alert Detail window similar to
the following:
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The Related Alerts window shows a maximum of 256 alerts. Alerts
detected one hour or more before the most recent alert are not
displayed; in this case, refer to the Alert window.

Troubleshooting Hitachi Device Manager - Storage
Navigator

Message ID Description Recovery Action

21542 005011 Clicking the Apply button
in the Add System
window caused the error,
and the storage icon is not
created.

The SVP does not have sufficient free
space to create the storage icon. Make
20 GB or more of free space available in
the installation directory of the drive.

21542 005019 Clicking Start Service
caused the error, and the
service cannot start.

Two or more services cannot be executed
simultaneously. Stop the service that
started before starting the other service.

21542 005026 Clicking Start Service
caused the error and the
service cannot start.

The SVP IP address is invalid. At the top-
right of the screen of the Storage
Device List window, click SVP IP
Address. In the Change SVP IP
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Message ID Description Recovery Action

Address window, set the IP address of
the SVP, and then retry Start Service.

21542 005026 The status of the service
changed to Error after
rebooting the SVP with the
Start-up service set to
Auto. The Service Status
window shows the error,
and the Status field shows
BASE.

The SVP IP address is invalid. At the top-
right of the screen of the Storage
Device List window, click SVP IP
Address. In the Change SVP IP
Address window, set the IP address of
the SVP, and then retry Start Service.

21041-006002 Clicking the storage
system in the Storage
Device List window
caused the error, and
Hitachi Device Manager -
Storage Navigator cannot
start.

The default browser is not defined.
Specify your browser as the default
browser (refer to the documentation for
your browser) and retry.

21041-006005 Starting the Storage
Device List caused the
error, and the Storage
Device List cannot start.

Failed to connect to the Supervisor
service (DKCMan/MAPPAppServer/
MAPPWebServer). Select Control Panel >
Administrative Tools > Services in
Windows, and confirm that the DKCMan,
MAPPAppServer, and MAPPWebServer
services started. Start the Storage Device
List again.

If the status of DKCMan, MAPPAppServer,
and MAPPWebServer did not start, right-
click the service and select Start, or
reboot the SVP.

Dump tool

About the Dump tool
Use the Dump tool to collect Hitachi Device Manager - Storage Navigator
configuration information.

You can use the collected dump files:
• Before deleting the storage management software.
• To collect the dump files from the SVP.
• To troubleshoot using Device Manager - Storage Navigator.
• To check the Device Manager - Storage Navigator configuration. In Device

Manager - Storage Navigator, click File > Refresh All to update the
configuration information, and then use the Dump tool to collect dump
files.

The Dump tool has two files.
• Dump_Normal.bat            collects dump files containing information

about the SVP and minimum information about the storage system. Use
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this tool when there is no fatal error, such as a problem with accessing
Device Manager - Storage Navigator.

• Dump_Detail_bat collects detailed dump files and contains comprehensive
information about the storage system in addition to the contents of the
normal dump file. Use this tool if you cannot start Device Manager -
Storage Navigator or to check for problems with the storage system.

Using the Dump tool

Prerequisites

• The client PC must be connected to the SVP using the Remote Desktop
Connection.

• No other user should be using the Dump tool.
• No maintenance operation is being performed.

Procedure

1. Close all Hitachi Device Manager - Storage Navigator sessions on the
SVP.

2. On the SVP, exit to a Windows command prompt as Administrator.
3. Change to the directory where the Dump tool is located.

For example, C:\Mapp\wk\83xxxxxxx\DKC200\mp\pc where 83xxxxxxx is
the DKC serial number.

4. Specify the output folder for the dump file (for example, C:\Mapp\wk
\83xxxxxxx\DKC200\tmp) as an output destination, and then execute
Dump_Normal.bat or Dump_Detail.bat.

5. When the completion message appears, close the command prompt.
6. Under the output destination folder, check that the following files are

created.:
• hdcp.tgz = dump file

zSv_AutoDump.log = dump tool log file. If the dump file was not
created, give this log file to your administrator. Otherwise, delete the
log file.

7. Exit the command prompt.

Collecting dump files manually
If you cannot use the Dump tool or the Dump tool fails, collect the following
dump files manually.

Note: In the following list:
• installDir = the SVP installation directory (for example, C:\Mapp).
• %USERPROFILE% = the installation login user of the SVP (for example, C:

\Users\<user name>).
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• %WINDIR% = the Windows folder in the system drive (for example, C:
\Windows).

<installDir>\wk\supervisor\dkcman\log\*.*
<installDir>\wk\supervisor\dkcman\cnf\*.*
<installDir>\wk\supervisor\rmiserver\log\*.*
<installDir>\wk\supervisor\rmiserver\cnf\*.*
<installDir>\wk\supervisor\sdlist\log\*.*
<installDir>\wk\supervisor\mappiniset\logs\MappIniSet\*.*
<installDir>\OSS\apache\logs\*.log
<installDir>\OSS\apache\logs\ssl\*.log
<installDir>\OSS\jetty\logs\*.log
%USERPROFILE%\AppData\LocalLow\Sun\Java\Deployment\log
%WINDIR%\system32\config\SysEvent.Evt
%WINDIR%\system32\config\SecEvent.Evt
%WINDIR%\system32\config\AppEvent.Evt
%WINDIR%\minidump\*.dmp
%WINDIR%\System32\Winevt\Logs\Application.evtx
%WINDIR%\System32\Winevt\Logs\Security.evtx
%WINDIR%\System32\Winevt\Logs\System.evtx
%WINDIR%\system32\drivers\etc\HOSTS*
%WINDIR%\system32\drivers\etc\services*
%WINDIR%\minidump\*.dmp
c:\SetupTrace\*.*

Troubleshooting the maintenance utility

JavaScript security
The Maintenance Utility window opens, but it is blank, even after one or
more minutes elapse.

Use the following procedure to add the Maintenance Utility window to the
trusted sites, and then open the Maintenance Utility window again.
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Procedure

1. In Internet Explorer, select Tools > Internet Options and select the
Security tab.

2. Click Trusted Sites > Sites.
3. Clear the Require server verification (https:) for all sites in this

zone check box.
4. Enter the IP address of controller 1 to Add this website to the zone

and click Add.
5. Add the IP address of controller 2 using the same method.
6. Click Close.
7. When returning to the Internet Options window, click OK to close the

window.

Compatibility view
Contents displayed in the Maintenance Utility window may be corrupted.
Exclude the maintenance utility from the compatibility view target. In
Internet Explorer, check the Compatibility View on the address bar. In
Internet Explorer versions 10 and earlier:

Procedure

1. Select Tools > Compatibility View setting.
2. Clear the Display intranet sites in Compatibility View and the

Display all websites in Compatibility View check box.
3. Click Close.

Clearing the browser cache
In the unlikely event that the login to the Maintenance Utility window fails,
or the Maintenance Utility window opens but is blank, even after one or
more minutes elapse, clear the browser cache and open the Maintenance
Utility window again.

Refreshing the Maintenance Utility window
Images are not displayed properly in the Maintenance Utility window.

In the unlikely event that images do not appear properly in the Maintenance
Utility window, refresh the browser.

Procedure

1. Log out of the maintenance utility.
2. Press the Ctl key and the F5 key at the same time to perform a manual

refresh.
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Maintenance Utility window freezes
Window freezes when performing maintenance utility operations.

In the unlikely event the Maintenance Utility window freezes ("hangs")
when performing operations, perform the following procedure:

Procedure

1. Check that the network between the SVP and the storage system is
operating properly.

2. Log out of the Maintenance Utility window, and then log in again.
3. If the message System Locked appears, click System Locked to

unlock the system.

Turning the storage system on or off using the maintenance
utility

In the unlikely event the SVP will not run or it cannot connect to the storage
system, you can power on and off the storage system using the maintenance
utility.

Prerequisites

• The breaker is turned on.
• The amber POWER LED on the storage system is on.

Procedure

1. Start the browser on the client PC.
2. In the browser address bar, enter the address of controller 1, and press

Enter.
The login window opens.

3. Log in.
The Maintenance Utility window opens.

4. To power on the storage system, select Power Management > Power
on Storage System. When the confirmation message appears, click
Submit.

5. To power off the storage system, select Power Management > Power
off Storage System. When the confirmation message appears, click
Submit.

iSCSI troubleshooting
The following list summarizes issues associated with iSCSI configurations.
• Is the link status of the host LAN port normal?
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• Check the power status of the network peripherals (switches, routers,
NICs, and other devices) between the storage system and the host.

• Its power being supplied to devices, are the devices turned on, and are all
cables to devices connected securely to the appropriate connectors?

• If the LAN cable is connected loosely, secure it.
• Does the port transfer speed of the HBA, switch, or NIC connected to the

storage system match the transfer speed of the storage system configured
in Storage Navigator?

• Match the transfer speeds between the storage system (configured in
Hitachi Device Manager - Storage Navigator) and the customer device.

• Check the following:
○ VLANs
○ Firewall settings
○ Level 3 switches and routers
○ Installing and configuring host iSCSI drivers

• Confirm that IPsec is turned off at the host storage system port.
• Are the IP address, subnet mask, default gateway, and MTU value for each

storage system and host set properly for the network over which they
communicate? The MTU value must be the same as all the devices (host,
switches, storage systems, and so on) in the LAN environment.
When connecting using an IPv6 address, check whether the IPv6 address,
subnet mask, default gateway, and MTU value are configured appropriately
for the network. Check the address status of the IPv6 address.

• Does the host recognize the iSCSI driver? Can the host log into the target
using the appropriate IP address and iSCSI name?

• Is the storage system TCP port number set correctly for the host?
• Are discovery and login performed by the host?
• If using an iSNS server, is the IP address of the iSNS server set correctly

for the host and storage system? Can the iSNS server register the IP
address, iSCSI name, and other information for new iSCSI devices?

• If using CHAP authorization, is the CHAP user (initiator) registered for the
storage system port? If not, register them.

• If using initiator authentication (part of CHAP authentication), is the target
name (for example, [000:T000]) registered on the storage system for the
CHAP user? If not, use Device Manager - Storage Navigatorto assign a
target name to the CHAP user of the initiator.

• If using bidirectional CHAP authentication, are the user name and target
secret set appropriately for the host?

• If using target security by unlocking the LUN Manager function, does the
HBA iSCSI name appear in the list of iSCSI initiators assigned to the
storage system target? If not, use Device Manager - Storage Navigator to
assign the HBA iSCSI name to the target.

Troubleshooting 127
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Check these items Description

Are the values of the IPv6 address and the default gateway
address of the iSCSI port to be connected set correctly?

The IPv6 address and default
gateway of the iSCSI Port are
generated automatically. When
set manually, select a suitable
value for the environment.

Display the address status of
the IPv6 address for the iSCSI
port.

Confirming IPv6 is checking whether other
hosts and addresses in the
network connection are not
duplicated. Confirm the
transition.

Enabled The IPv6 address of the iSCSI
port is not duplicated and set
correctly. The address is in
normal status.

Disabled The iSCSI port is in Link Down
status. When using an IPv6
address with an iSCSI port,
check that the cable is
connected correctly.

Duplicated The IPv6 address for the iSCSI
port is the same as the address
of other hosts in the network
connection. Set the unassigned
IPv6 address manually.

Not confirmed The IPv6 address of the iSCSI
port is the same as other
addresses on the same iSCSI
port. Set the unassigned IPv6
address on the iSCSI port
manually.

Is the value of the MTU size set correctly? The IPv6 Link MTU size shows
the MTU size current value on
the network.
If the Link MTU size and the
MTU size for an iSCSI port are
different, the MTU size of the
host or the router or switch is
different from the storage
system. Set the MTU sizes to
the same value.

Is the IPv6 address of the remote pass setting on the IPv6
address set correctly?

Set IPv6 address to the
appropriate setting at the local
and remote paths of the iSCSI
port.

Is the prefix set as IPv6 Global Address in a server correct? When IPv6 Global Address is
set to two or more interfaces in
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Check these items Description

a Linux system, set the IPv6
address with different prefix.

SVP troubleshooting
When the user-supplied management console PC is connected to the SVP via
Remote Desktop, you can turn off or reboot the SVP.

Powering off the SVP

Procedure

1. From a management console PC, connect to the SVP using Windows
Remote Desktop Connection.

2. On the SVP, click Start in Windows desktop.
3. From the displayed menu, click Windows Security.
4. In the Windows Security window, click the option in the power (up

arrow) menu.
5. From the displayed menu, click Shut down.

The SVP power and POWER LED go off.

Rebooting the SVP

Procedure

1. From a management console PC, connect to the SVP using Windows
Remote Desktop Connection.

2. On the SVP, click Start in Windows desktop.
3. From the displayed menu, click Windows Security.
4. In the Windows Security window, click the up arrow option in the

power menu:
 

 
5. From the displayed menu, click Reboot.

Backing up the SVP configuration
In the unlikely event the SVP fails and needs to be replaced, back up the SVP
configuration file to a USB flash drive before returning the failed SVP. When
you receive the replacement SVP, you can use the USB flash drive to restore
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the previous configuration on the new SVP. This procedure assumes that the
client PC is connected to the SVP using a Remote Desktop connection.

When you back up the SVP configuration, the following items are backed up:
• Parameters set in the Hitachi Device Manager - Storage Navigator

Environment window
• Connection setting to the authentication server
• Connection setting to the key management server
• Password policy for backing up the encryption key on the client PC
• Window view setting (table width) in Device Manager - Storage Navigator
• Warning message in the Device Manager - Storage Navigator login window
• Device Manager - Storage Navigator task information
• SMI-S application settings
• HTTPS and SMI-S SSL certificates, and RM

To back up the SVP configuration:

Procedure

1. From a management console PC, connect to the SVP using Windows
Remote Desktop Connection.

2. Close all Device Manager - Storage Navigator sessions on the SVP.
3. On the SVP, exit to a Windows command prompt as Administrator.
4. Move to the directory where the tool exists, and then issue the following

command:
C:\MAPP\wk\Supervisor\MappIniSet\MappBackup.bat [absolute 
path of the backup (tgz zip) file]

5. When the completion message appears, press any key to continue.
6. Exit the command prompt.
7. Move the configuration file from the SVP to a USB flash drive.

Note: Do not edit the contents of the backup file.

Restoring the SVP configuration
If you backed up the SVP configuration, you can use the following procedure
to restore the configuration. This procedure is particularly useful when you
receive a replacement SVP and want to install a configuration that was used
on your previous SVP.

This procedure assumes that:
• The client PC is connected to the SVP using a Remote Desktop Connection.
• The storage system you want to restore is registered on the SVP.
• The service setting is configured to not start automatically when the SVP

reboots.
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To restore the SVP configuration:

Procedure

1. Copy the backup file to a folder on the SVP.
2. On the SVP, exit to a Windows command prompt as Administrator.
3. Move to the directory where the backup file exists, and then issue the

following command:
C:\MAPP\wk\Supervisor\MappIniSet\MappRestore.bat[absolute 
path of the backup (tgz zip) file]

4. When the restoration message appears, press any key to continue.
5. Exit the command prompt.
6. Atach a USB flash drive to a USB port on the SVP, and then move the

backup file from the SVP to the USB flash drive.
7. Configure the service setting to start automatically the next time the SVP

reboots, and then reboot the SVP.

Changing the SVP IP address
You can change the IP address for the SVP using the Microsoft Windows
Embedded Standard 7 operating system on the SVP or the Storage Device
List.

Changing the SVP IP address in Windows 7

Use this procedure so long as no storage system has been registered on the
SVP, or the storage system service has not been started.

Procedure

1. From a management console PC, connect to the SVP using Windows
Remote Desktop Connection.

2. On the SVP, click Start > Control PanelNetwork and Sharing Center.
3. Click Change adapter settings.
4. Click a network for which you want to set an IP address, and then set the

IP address.

Changing the SVP IP address using the Storage Device List
To use this procedure, there must be no storage system registered on the
SVP or the storage system service must not have been started.

Procedure

1. If you have not connected a management console PC to the SVP using
Windows Remote Desktop Connection, do so now.

2. On the SVP, click Start > All Programs > Hitachi Device Manager-
Storage Navigator > StorageDeviceList.
The Storage Device List window opens.
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3. Click SVP IP Address at the top-right side of the window.
 

 
The Change SVP IP Address window appears.
 

 
4. Click an IP addressing method (IPv4 or IPv6).
5. Enter the new IP address of the SVP.
6. Click Apply.

Blocking communications to port 80
The following procedure describes how to block HTTP communications to the
SVP using port 80.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
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2. Using a management console PC attached to the SVP, connect to the SVP
using Windows Remote Desktop Client.

3. On the SVP, exit to a Windows command prompt as Administrator.
4. Move to the directory where the block file exists, and then issue the

following command:
C:\MAPP\wk\Supervisor\MappIniSet\MappHttpBlock.bat

5. When the completion message appears, press any key to continue.
6. Exit the command prompt.

Postrequisites

To unblock port 80, repeat this procedure, but issue the following command
in step 3:

C:\MAPP\wk\Supervisor\MappIniSet\MappHttpRelease.bat

Deleting the registered storage system
Use the following procedure in the unlikely event you need to delete the
registered storage system from the SVP.

Procedure

1. From a management console PC, connect to the SVP using Windows
Remote Desktop Connection.

2. Stop the SVP service (see Stopping the SVP service on page 208).
3. On the SVP desktop, double-click the Open StorageDeviceList icon.

The Storage Device List window opens.
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4. In the Storage Device List window, click x for the storage system that
you want to delete.
 

 

Registering the storage system on the SVP
If you delete the registered storage system from the SVP, use this procedure
to register the storage system with the SVP.

You register the storage system using the Storage Device List.

Procedure

1. From a management console PC, connect to the SVP using Windows
Remote Desktop Connection.

2. On the SVP, click Start > All Programs > Hitachi Device Manager-
Storage Navigator > StorageDeviceList.

134 Troubleshooting
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



3. Click the plus sign in the center of the window.
The Add System window appears.
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4. Complete the fields in the Add System window.
 

 

Field Description

Software Selection Click Browse and select the installation

media, which ends in a .inf extension.

IP Address (CTL 1) Enter the IP address for controller 1. Accept

the default IPv4 setting or select IPv6, and

then enter the IP address in the appropriate

format for the addressing method selected.

IP Address (CTL 2) Enter the IP address for controller 2. Accept

the default IPv4 setting or select IPv6, and
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Field Description

then enter the IP address in the appropriate

format for the addressing method selected.

System Name Enter the display name of the storage system,

up to 180 characters.

Description Enter the description of the storage system,

up to 180 characters.

User Name Enter a user name, up to 256 characters.

Permitted characters are alphanumeric

characters and the following: (# $ % & ' * +

- . / = ? @ ^ _ ` { | } ~)

Password Enter a password, from 6 to 256 characters.

5. Click Apply.
The confirmation window appears and the registered storage system
appears in the Storage Device List window.

6. Reboot the SVP (see Rebooting the SVP on page 129).
7. After the SVP reboots, click Start > All Programs > Hitachi Device

Manager-Storage Navigator > StorageDeviceList.
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8. Wait for the storage system status becomes Ready.
 

 

Note: If the storage system status does not become Ready, click
Refresh.
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If an error message appears, see Troubleshooting Storage Navigator on
page 121.

About working with firewalls
A firewall's main purpose is to block incoming unsolicited connection attempts
to your network. If the storage system is used within an environment that
uses a firewall, there will be times when the storage system's outbound
connections will need to traverse the firewall.

The storage system's incoming indication ports are ephemeral, with the
system randomly selecting the first available open port that is not being used
by another TCP application. To permit outbound connections from the storage
system, you must either disable the firewall or create or revise a source-
based firewall rule (not a port-based rule) so that items coming from the
storage system are allowed to traverse the firewall.

A firewall can also interfere when upgrading the storage system software.
Software upgrades on the storage system are FTP connections, where the
host computer acts as a server and the software acts as the client. In these
roles, the host listens for a storage system's software upgrade request on an
FTP socket and then makes an incoming connection to the storage system.
The firewall must permit this incoming socket for the upgrade to succeed.
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The following table lists the ports used by the storage system and Hitachi
Device Manager - Storage Navigator. We suggest you create or revise your
source-based firewall rules and policies to accommodate outbound
connections to the storage system via these ports.

Port Description

2000 TCP (Device Manager - Storage Navigator:
Nonsecure)

Cisco Skinny Client Control Protocol (SCCP) uses
port 2000 for TCP. If you use Device Manager -
Storage Navigator in a network with SCCP,
change the TCP port that Device Manager -
Storage Navigator uses (refer to the Device
Manager - Storage Navigator online help).

28355 TCP (Device Manager - Storage Navigator:
Secure)

161 UDP (SNMP uses this port to send traps from the
storage system)

23015 Web browser

23016 Web browser using SSL

10995 TCP Device Manager - Storage Navigator and
Hitachi suite components)

Note: For outgoing traffic from the storage system's management port, there
are no fixed port numbers (ports are ephemeral), so all ports should be open
for traffic from the storage system management port. The storage system
iSCSI data ports use port 3260 (standard iSCSI port) only.

Configuring the audit log
The audit log is a file that contains a history of the operations performed on
the storage system and the person that performed them.

Audit log files
Audit log files are stored in the SVP or the storage system, and can be
exported.

SVP audit logs

When non-transferred logs are accumulated, the icon shown in the top right
of the Device Manager - Storage Navigator main window changes.

• : Number of saved lines is below the threshold.

• : Number of saved lines exceeds the threshold, but the data is still being
saved.

• : Number of saved lines exceeds the maximum, and data is partly lost
because the oldest lines were overwritten by the newest lines.

140 Troubleshooting
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



The threshold of 70% of the maximum stored capacity of the audit logs. If
the audit log file reaches the maximum capacity, files with the oldest data are
overwritten by the newest data.

Storage system logs

When non-transferred logs are accumulated, a SIM is generated.
• Reference code (0x7d03xx): Number of accumulated logs reached the

threshold.
• Reference code (0x7d04xx): Some audit logs were overwritten and

some data are lost because the file is full.

Observe the following:
• xx=00: An event occurred on the controller 1 side.
• xx=01: An event occurred on the controller 2 side.

Note: The capacity of the audit logs that can be stored at the SVP or storage
system is limited. When the audit log file reaches the maximum capacity, the
oldest data is overwritten by the newest data. For this reason, we
recommend you transfer the audit logs to the Syslog server.

When audit logs are not transferred or the Syslog server is not used

If audit logs are not transferred due to a LAN failure, the logs are
accumulated, and either an icon shows the accumulated status in the window
or a SIM is generated. If the Syslog server is not used, the logs are
accumulated as a non-transferred log; however, the icon showing the
accumulated status in the window does not change and a SIM is not
generated.

Audit log storage location
Maximum storage capacity

(maximum number of stored
rows)

When non-transferred logs are
accumulated

SVP 250,000 rows • : Number of saved lines
is below the threshold.

• : Number of saved lines
exceeds the threshold, but
the data is still being saved.

• : Number of saved lines
exceeds the maximum, and
data is partly lost because
the oldest lines were
overwritten by the newest
lines.

Storage system 1,000 rows A SIM is generated.
• Reference code (0x7d03xx):

The number of accumulated
logs reaches the threshold.
See Note.
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Audit log storage location
Maximum storage capacity

(maximum number of stored
rows)

When non-transferred logs are
accumulated

• Reference code (0x7d04xx,
see Note): Some audit logs
are overwritten and some
data are lost because the
file is full.

Note: The threshold is 70% of the maximum stored capacity of the audit
logs. When the audit log file reaches the maximum capacity, the oldest data
is lost as it is overwritten by the newest data (wrap around). xx=00 indicates
an event occurred on the CTL1 side.

xx=01 indicates an event occurred on the CTL2 side.

Perform the following when non-transferred logs are accumulated.
• Export non-transferred logs. All stored audit logs including transferred logs

are exported in this operation. The operation window to be used depends
on where the audit logs are stored. For the procedure to export operation,
see the related items.

Type or contents of audit log Storage place Exporting operation window

• Operations set by the
Device Manager - Storage
Navigator client computer
(Except operations in the
Maintenance Utility menu.

• Operations and events on
encryption keys for
encrypting stored data.

• Execution logs of Remote
Maintenance API,

• Commands that the storage
system received from a host
or computers using RAID
Manager.

SVP Audit Log Properties window

• Maintenance utility
operations

• Maintenance operations by
the service personnel

Storage system Audit Log Settings window

Eliminate the cause of the transfer failure to the Syslog server, and then
perform a test transfer of syslogs to confirm that the transmission is
recovered. Audit logs generated during the transfer failure are not
retransferred.
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Exporting audit log files

All stored audit logs, including transferred logs, are exported in this
operation. The operation window you use depends on where the audit logs
are stored.

Type of audit log Location Window to export

• Operations set in the Device
Manager - Storage
Navigator (management
server).

• Operations and events on
encryption keys for
encrypting stored data.

• Execution logs of remote
maintenance API.

• Commands that the storage
system received from the
host or RAID Manager.

SVP Audit Log properties window

• Operations set in the Device
Manager - Storage
Navigator (except
operations in the
maintenance utility).

• Operations configured by
the SVP.

Storage system Audit Log Settings window

Exporting audit log files stored from the SVP
To export the audit log files stored in the SVP:

Procedure

1. In the Hitachi Device Manager - Storage Navigator main window, click
Audit Log on the menu bar.
The Audit Log Properties window opens.

2. Expand the tree, and then right-click the target storage system. Select
Other functions.

3. In the Device Manager - Storage Navigator main window, click Audit
Log on the menu bar.
The icons on the menu bar show the accumulated status of the audit log
files.

4. From the Audit Log Properties window, click Download (SVP) to
export logs operated by the Device Manager - Storage Navigator client
computer (SVP window), or Download (DKC) to export commands sent
from a host or computers using RAID Manager or logs of events on
encryption keys.
The preparation message appears.

5. Click OK.
A window opens where you can specify the export destination.

6. Specify the export destination and file name, and then click Save.
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7. Click Close.

Exporting audit log files from the storage system

Procedure

1. In the Hitachi Device Manager - Storage Navigator main window, click
the Resourcestab.

2. Expand the tree, and then right-click the target storage system and click
Other Functions.

3. From the Maintenance Utility menu, click Audit Log Settings.
 

 
4. Click Export Audit Log in the Audit Log Settings window.

A window opens where you can specify the export destination.
5. Specify a destination for the file and file name, and then click Save.
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6
Adding components

□ Guidelines when adding optional components

□ Procedures for adding optional components

□ Conditions when adding optional components

□ Starting the maintenance utiility

□ Adding disk drives

□ Adding cache memory

□ Shared memory

□ Front end module

□ Small form factor pluggable

□ Adding a back end module to a CBLM or CBLH controller

□ Adding drive trays
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Guidelines when adding optional components
Observe the following guidelines before adding optional components to
storage systems.
• To avoid the chance of losing data in the event you make a mistake while

adding an optional component, back up all user data at the host before
performing the procedures in this chapter.

• When a procedure involves replacing a mock ("dummy") drive, perform
the procedure with the storage system power on and complete the
procedure within 10 minutes.

• Do not add optional components while the storage system is being started.
• Before performing the procedures in this chapter, collect simple trace

information (refer to the Hitachi Virtual Storage Platform G400 and Hitachi
Virtual Storage Platform G600 Hardware Service Guide) if the storage
system will be returned to the original state after the optional work.

Procedures for adding optional components
The following sections summarize the procedures for addition optional
components to the storage system. You can add optional components with
the storage system power turned on or off.

Adding optional components with power applied
The summarized steps below are associated with adding optional components
when power is applied to the storage system.

Procedure

1. Unpack the optional components.
2. Optional: add drives.
3. Mount the storage system on a rack.
4. Connect cables.
5. Use the service PC to:

• Check restoration of system information.
• Set a spare drive
• Set RAID and volume(s)
• Set volume recognition

The system copy takes approximately 1.5 minutes to complete for each
drive.

6. Prepare the uninterruptible power supply (UPS), if required.
7. Optional: add the front end modules.
8. Install the host.
9. Close the front bezel after the operation.
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Conditions when adding optional components
Observe the conditions in the following sections when adding optional
components.

Conditions when adding drive trays

Note: Data is exchanged between a host and the storage system.

Model name Specification
Minimum

requirements

Condition

Power online and host is operating

DW-F800-DBS or
DW-F800-DBSC

A G400 or G600
storage system
and basic
accessories to be
mounted on a
rack.

Two drives and up
to 24 SFF drive
trays.

Supported

DW-F800-DBL or
DW-F800-DBLC

A storage system
and basic
accessories to be
mounted on a
rack.

Two drives and up
to 24 LFF drive
trays.

Supported

DW-F800-DBF A storage system
and basic
accessories to be
mounted on a
rack.

Two drives and up
to 24 SFF drive
trays.

Supported

Optional components that can be added

Conditions when adding drives

Note: Data is exchanged between a host and the storage system.

Note: Drive capacity values are calculated as 1 Gb = 1,000,000,000 bytes. If
your PC calculates 1 kilobyte as 1,024 bytes, the capacity indication will be
different. The RAID group capacity values displayed in the Hitachi Device
Manager - Storage Navigator are calculated as 1 KB = 1,024 bytes.

Requirements: Select from the drives shown in the following table according
to the intended total capacity of the storage system.

Thirty-two spare drives can be set up in CBLM.
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Conditions vary, depending on the storage system to be added.

Model name Specification

DKC-F810I-200MEM 200-GB, 2.5-inch, MLC, 12-Gbps flash drive

DKC-F810I-300KCM 300-GB, 2.5-inch, 15kmin-1, 6-Gbps SAS drive
(contains BNST)

DKC-F810I-300KCMC 300-GB, 2.5-inch, 15kmin-1, 6-Gbps SAS drive

DKC-F810I-400MEM 400-GB, 2.5-inch, MLC, 12-Gbps flash drive

DKC-F810I-600JCM 600-GB, 2.5-inch, 10kmin-1, 6-Gbps SAS drive
(contains BNST)

DKC-F810I-600JCMC 600-GB, 2.5-inch, 10kmin-1, 6-Gbps SAS drive

DKC-F810I-600KGM 600-GB, 2.5-inch, 15kmin-1, 12-Gbps SAS drive

DKC-F810I-1R2JCM 1.2-TB, 2.5-inch, 10kmin-1, 6-Gbps SAS drive
(contains BNST)

DKC-F810I-1R2JCMC 1.2-TB, 2.5-inch, 10kmin-1, 6-Gbps SAS drive

DKC-F810I-400M6M 400-GB, 3.5-inch, MLC, 12-Gbps flash drive

DKC-F810I-1R2J5M 1.2-TB, 3.5-inch, 10kmin-1, 6-Gbps SAS drive
(contains BNST)

DKC-F810I-1R2J5MC 1.2-TB, 3.5-inch, 10kmin-1, 6-Gbps SAS drive

DKC-F810I-4R0H3M 4-TB, 7.2K, 3.5-inch, 7200min-1, 6-Gbps SAS
drive (contains BNST)

DKC-F810I-4R0H3MC 4-TB, 7.2K, 3.5-inch, 7200min-1, 6-Gbps SAS
drive

DKC-F810I-6R0H9M 6-TB, 7.2K, 3.5-inch, 7200min-1, 12-Gbps SAS
drive

Conditions for adding cache memory

Requirements: Install cache memory of the same capacity in controllers 1
and 2.

Adding cache memory is not supported when the power is online and host is
operating. Add cache memory only when the storage system is powered off.

Model name Specification

DKC-F810I-CM8G Cache memory (8 GB)

DKC-F810I-CM16G Cache memory (16 GB)

DKC-F810I-CM32G Cache memory (32 GB)
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Conditions for adding cache flash memory

Model name Specification

DW-F800-BM20 cache flash memory

DW-F800-BM30 cache flash memory

Conditions for adding batteries

Model name Specifications

DW-F800-BAT Battery

Conditions for adding Fibre Channel front end module

Requirements:
• Install the front end module after removing the dummy board from the

controller.
• Front end module type must correspond to the slot type.

Installation of the fibre channel front end module can be done with the
storage system is on or off.

Model name Specification

DW-F800-4HF8 8 Gbps Fibre Channel

DW-F800-2HF16 16 Gbps Fibre Channel

Conditions for adding iSCSI front end module

Requirements:
• Install the front end module after removing the dummy board from the

controller.
• Front end module type must correspond to the slot type.

Installation of the iSCSI front end module can be done with the storage
system is on or off.

Model name Specification

DW-F800-2HS10S 10 Gbps SFP iSCSI

Conditions for adding small form-factor pluggable

Installation of the SFP can be done with the storage system is on or off.
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Model name Specification

DKC-F810I-1PL8 SFP for 8 Gbps Longwave

DKC-F810I-1PS8 SFP for 8 Gbps Shortwave

DKC-F810I-1PL16 SFP for 16 Gbps Longwave

DKC-F810I-1PS16 SFP for 16 Gbps Shortwave

Starting the maintenance utiility
You can start the maintenance utility from Hitachi Command Suite or Hitachi
Device Manager - Storage Navigator.

Starting the maintenance utility from Hitachi Command Suite

Procedure

1. Start Hitachi Command Suite.

 

 
2. In the Hitachi Command Suite main window, click the Resources tab,

and then click Storage Systems from the tree view.
3. Expand the tree, and then right-click a storage system and click Other

Functions.

150 Adding components
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



4. In Hitachi Device Manager - Storage Navigator, click the Maintenance
Utility menu, and then click Hardware to start the maintenance utility.
 

 

Starting the maintenance utility from Hitachi Device Manager -
Storage Navigator

Procedure

1. Launch a web browser from the console PC connected to the SVP, and
then start Device Manager - Storage Navigator.

2. Enter the following URL in the address field of your browser, and then
press the Enter key: http://[IP address of SVP]/module/sn2/0/
index.do

3. In the Storage Device List window, click the picture of the registered
storage system.

4. Log in to Device Manager - Storage Navigator.
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5. On the Maintenance Utility menu, click Hardware > Other hardware
maintenance to start the maintenance utility.

Note: If a message reports a problem with the website's security,
click Continue to this website (not recommended).
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Adding disk drives
The procedure you use to add drives depends on the drive's location and
whether the storage system is powered on or off.

Exercise care to use the appropriate procedure; otherwise, user data could be
lost.

Replacing a drive for the dense intermix drive tray
Facing the front of the chassis, drive numbering is #0 to #59, from the
bottom left to the top right.

When dealing with a dense intermix drive tray:
• Be mindful of other workers nearby.
• Exercise care when removing or storing the dense intermix drive tray.
• Do not pull out multiple dense intermix drive trays at one time because the

rack can fall over.
• Do not put objects on a dense intermix drive tray you removed from the

rack.
• Do not use the dense intermix drive tray as working space because the

rack can fall over.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM LED for the drive to be replaced is on.

Procedure

1. Remove the dense intermix drive tray from the rack and remove the top
cover and bezel.

2. Pull up the stopper of the drive handle toward you to release the lock.
3. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

4. Place the drive into the guide rail and slide it gently in the direction of
the arrow.
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5. Push the drive until a click indicates it has locked in place.
 

 
6. In the maintenance utility, click Hardware > Controller Chassis or

Hardware > Drive Box.
7. Click the Drives tab.
8. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh at the top-right of the window to update the
status in the window.

9. Confirm that the red ALM LED is off at the new drive.
10. Attach the front bezel, and then replace the dense intermix drive tray in

the rack.

Adding drives to a SFF drive tray
Facing the front of the chassis, drive numbering in a chassis is #0 to #23,
from the bottom left to the top right.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
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Procedure

1. Remove the front bezel.
2. Pull up the stopper of the drive handle toward you to release the lock.
3. Open the handle toward you, and then pull out and remove the dummy

drive.
4. Place the drive into the guide rail and slide it gently in the direction of

the arrow.
5. Push the lower part of the drive until it reaches the position where the

hook on the handle engages with the square hole on the frame.
6. Raise the stopper, which is tilted toward you, and then press the stopper

to disengage the lock.
If the handle is raised so the hook of the handle cannot enter into each
hole, the drive cannot be installed properly because it is blocked by the
frame of the storage system.
 

 
7. Attach the front bezel.

Adding drives to a LFF drive tray
Facing the front of the chassis, drive numbering in the chassis is #0 to #11,
from the bottom left to the top right.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
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Procedure

1. Remove the front bezel.
2. Pull up the stopper of the drive handle toward you to release the lock.
3. Open the handle toward you, and then pull out and remove the dummy

drive.
Hold the rail side of the drive because the shield spring is subject to
breakage.

4. Place the drive into the guide rail and slide it gently in the direction of
the arrow.

5. Push the lower part of the drive until it reaches the position where the
hook on the handle engages with the square hole on the frame.

6. Pull the stopper lightly, close the handle, and then press the stopper to
engage the lock.
If the hook of the handle cannot enter the square hole, the drive cannot
be installed properly because it gets blocked by the frame of the storage
system.
 

 
7. Attach the front bezel.

Recognizing drives
Use the Maintenance Utility window to recognize the new drive you added.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, select the controller chassis or

drive tray in which the drives are added.
3. Click Install.
4. When the storage system detects the added drives, a window appears.
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5. Check the slot positions where you added the new drive.
a. If the positions are incorrect, re-install the drives in the correct

positions.
b. Click Reload.
c. Check that the LEDs go off at the drives to be re-installed.

6. Mount all the drives to be added on the storage system and click Install.
The storage system will recognize the added drive and displays a dialog
box.

7. Click Close to close the completion message.
8. If the drive addition fails:

a. Click Close on the completion message.
b. Click Refresh.
c. Click the Drives tab on the Controller Chassis window or the Drive

Box window.
d. Check the drive status.

9. Verify that the added drives and the storage system are operating
normally.

10. Log out and close the maintenance utility.
After adding drives, set parity groups, spare drive settings, logical device
settings, and volume settings according to your requirements.

Configuring a host to recognize a volume with power on
The following example describes how an HP-UX host recognizes a newly
added drive with storage system power on. In the following figure, the PC
connected to the LAN has an installed version of Hitachi Device Manager -
Storage Navigator.
 

 

Prerequisites

The host and storage system are in the READY status.
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Procedure

1. Create a new RAID group for the installed drives.
2. Create one or more new volumes for the RAID group.
3. Format the volumes.
4. At the host:

a. Issue the ioscan -nfC disk command to verify that the host
recognizes the storage system.
The status of the newly added volume appears as NO-NW.

b. Issue the insf -e command to create a device file for the new
volumes.

c. Issue the ioscan -nfC disk command to verify that the host
recognizes the storage system.
The status of the new volume appears as CLAIMED.

d. Create a file system by creating the volume group and logical volume
for the newly added volume.

Result

The host can now use the new volumes.

Adding cache memory

Cache memory for Hitachi Virtual Storage Platform G400
The Hitachi Virtual Storage Platform G400 supports 64 GB or 128 GB of cache
memory. Controller 1 and controller 2 must have the same capacity of cache
memory installed. Cache memory modules come in 8 GB and 16 GB
capacities.

Cache
memory
capacity per
system

Controller 1 Controller 2

Cache
memory
group 0

Cache memory group
1

Cache memory
group 0

Cache memory group
1

64 8 GB x 4 (32
GB)

Not used 8 GB x 4 (32 GB) Not used

128 16 GB x 4 (64
GB)

Not used 16 GB x 4 (64 GB) Not used

When you upgrade cache memory, you may also have to upgrade cache flash
memory. See the following table for more information.

Cache memory capacity per
system (GB)

Cache flash memory module

64 DW-F800-BM20 N/A

128 DW-F800-BM20 DW-F800-BM20
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Cache memory for Hitachi Virtual Storage Platform G600
The Hitachi Virtual Storage Platform G600 supports 64 GB, 128 GB, or 256
GB of cache memory. Controller 1 and controller 2 must have the same
capacity of cache memory installed. Cache memory modules come in 8 GB
and 16 GB capacities.

Cache
memory
capacity per
system

Controller 1 Controller 2

Cache
memory
group 0

Cache memory group
1

Cache memory
group 0

Cache memory group
1

64 8 GB x 4 (32
GB)

Not used 8 GB x 4 (32 GB) Not used

128 16 GB x 4 (64
GB)

Not used 16 GB x 4 (64 GB) Not used

128 8 GB x 4 (32
GB)

8 GB x 4 (32 GB) 8 GB x 4 (32 GB) 8 GB x 4 (32 GB)

256 16 GB x 4 (64
GB)

16 GB x 4 (64 GB) 16 GB x 4 (64 GB) 16 GB x 4 (64 GB)

When you upgrade cache memory, you may also have to upgrade cache flash
memory and the number of installed batteries. See the following table for
more information.

Cache memory
capacity per
system (GB)

Cache flash memory module Number of installed batteries per
system

Standard Optional

64 DW-F800-BM20 or
DW-F800-BM30

N/A 6 N/A

128 DW-F800-BM20 DW-F800-BM20 6 N/A

256 DW-F800-BM20 DW-F800-BM20 6 6

Checking cache memory

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
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3. Click the CTLs tab.
 

 
4. Verify the status and capacity of the installed cache memory.
5. Click Install list and select the controller where you want to add the

cache memory.
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6. When the Install Cache Memories page appears, specify the cache size
that will be reached after you install the cache memory, and then click
Block
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7. Check that the controller is blocked and becomes ready for adding. Do
not click Restore.
 

 
If the controller block fails, click Close on the completion message and

click Refresh: . Then click the CTLs tab on the Controller Chassis
window and check the controller status.

Blocking a controller
Blocking a controller is done within the maintenance utility.

Procedure

1. Click the Install list and select the controller in which the cache memory
will be added.

2. Specify how large the cache memory size will be after the cache memory
is added.

3. Check the cache size, and then click Block.
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4. Check that the controller is blocked and becomes ready for adding. Do
not click Restore.
 

 
5. If the controller block fails:

a. Click Close on the completion message.
b. Click Refresh.
c. Click the CTLs tab on the Controller Chassis window.
d. Check the controller status.

Adding cache memory to a CBLM or CBLH controller
The following figure shows the cache memory locations on a CBLM or CBLH
controller. Install the cache memory DIMMs in sets of four. These controllers
provide two sets of DIMM slots: CMG0 and CMG1. Populate the CMGO slots first,
and then populate the CMG1 slots if necessary.
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When replacing cache memory on a CBLM or CBLH controller, remove the
backup module first, and then remove the controller. A single CBLM or CBLH
controller board weighs approximately 42 pounds (19 kg).

Procedure

1. Loosen the right and left blue screws on the lever of the controller to add
the cache memory in the front of the CBLM or CBLH controller and open
the lever.

2. Loosen the blue screw securing the backup module.
3. With the lever opened, pull out and remove the backup module.

 

 
4. Remove all four backup modules installed in the controller.
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5. Loosen the blue right and left screws on the lever of the controller, and
then open the lever.

6. Hold the controller with both hands and gently remove it. Keep the
controller straight to avoid touching the components above and below it.
 

 
7. Open the air guide.
8. Pull the lever outward.
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9. Hold both ends of the cache memory, and then gently pull out the cache
memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.

 

 
10. Align the notch on the cache memory board with the projection inside

the slot.
11. Holding both ends of the cache memory, insert it into the socket.
12. Confirm that the lever is securing the cache memory.
13. Close the air guide.

Postrequisites

Add a cache flash memory (CFM) and a battery if required by the cache
memory size.

Adding cache flash memory to a CBLM or CBLH controller
The amount of cache memory installed on the storage system might require
you to add cache flash memory (CFM).

Procedure

1. Loosen the blue screw that secures the cache flash memory (CFM).
2. Open the lever.
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3. Using both hands, hold the body of the CFM and remove it.
 

 
4. With the lever opened completely, insert the CFM into the slot.
5. Push the CFM all the way into the slot.
6. Tighten the blue screw to secure the CFM.

Adding a battery to a CBLM or CBLH controller
The amount of cache memory installed on the storage system might require
you to add a battery. Use only the appropriate batteries with your storage
system.

Procedure

1. Loosen the blue screw that secures the backup module.
2. Open the lever, and then use both hands to remove the backup module.
3. Loosen the blue screw on the rear panel of the backup module.
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4. Slide the top panel of the backup module, and then remove it.
 

 
5. Hold the latch of the cable connector of the battery and remove the

connector from the socket.
6. Remove the battery.
7. Install a new battery in the empty slot of the backup module and route

cables along the groove of the backup module.
Exercise care when routing cables to avoid bending them.

8. Connect the cable connector to the socket.
The connector latch clicks when connected securely.

9. Slide the top panel of the backup module and attach it.
10. Tighten the blue screw on the rear panel of the backup module.
11. With the backup module lever opened, insert the backup module into the

slot of the new controller.
12. Close the backup module lever and tighten the blue screw.

Postrequisites

Add three batteries per controller.

Installing a controller in a CBLM or CBLH controller

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.
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Procedure

1. With the right and left levers on the new controller opened completely,
insert the controller into the slot of the CBLM or CBLH chassis.
Hold the controller with both hands and move it in a straight direction.
 

 
2. With the lever closed on the BKMF you removed, tighten the blue screw

to secure the BKMF.
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3. Install the four BKMFs on the controller.
 

 
4. Push the controller in all the way.

The right and left covers close completely.
5. Tighten the blue screw to secure the controller.
6. Confirm that the red CTL ALM LED on the new controller is off.
7. Attach the front bezel.

Postrequisites
• Use the maintenance utility to restore (unblock) the controller.

Restoring cache memory

Procedure

1. At the Replace Cache Memories window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
HDS Support Portal at https://portal.hds.com.
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2. When the progress bar goes away and the completion message appears,
click Close.

3. Click CTLs tab and confirm that all status conditions are Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Log out and close the Maintenance Utility window.

Shared memory
The same capacity of shared memory must be installed in controller 1 and
controller 2.

Required shared memory capacity is determined by the storage application
being used. In the following table:
• NO: The functions and storage applications in the table cannot be used.
• YES: The functions and storage applications in the table can be used.

To configure the storage system to use the shared memory capacity in the
table, configure the shared memory setting in the maintenance utility.
Storage applications may require a license before they can be used.

Note: Volume Migration is included in Hitachi Tiered Storage Manager.

Shared
memory
function

Hitachi storage application
ShadowIm

age or
Volume

Migration
Extension

TrueCopy
or

Universal
Replicator
Extension

Dynamic
Provisionin
g,Dynamic
Tiering or

Thin Image
Extension

Sha
red
me
mor

y
cap
acit

y
(GB

)

Sha
dow
Ima
ge
or

Volu
me
Mig
rati
on

Thin
Ima
ge

Tru
eCo
py
orU
nive
rsal
Rep
licat
or

Dyn
ami

c
Pro
visi
onin

g

Dyn
ami

c
Tier
ing

1 2 1 2 1 2

Base NO NO NO NO NO Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

5

Extension 1 YES YES YES YES YES Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

9

Extension 2 YES YES YES YES YES Exten
sion
is not
used

Exten
sion
is
used

Exten
sion
is not
used

Exten
sion
is
used

Exten
sion
is not
used

Exten
sion
is
used

13
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Shared
memory
function

Hitachi storage application
ShadowIm

age or
Volume

Migration
Extension

TrueCopy
or

Universal
Replicator
Extension

Dynamic
Provisionin
g,Dynamic
Tiering or

Thin Image
Extension

Sha
red
me
mor

y
cap
acit

y
(GB

)

Sha
dow
Ima
ge
or

Volu
me
Mig
rati
on

Thin
Ima
ge

Tru
eCo
py
orU
nive
rsal
Rep
licat
or

Dyn
ami

c
Pro
visi
onin

g

Dyn
ami

c
Tier
ing

1 2 1 2 1 2

Extension 3 YES YES YES YES YES Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is not
used

17

Extension 4 YES YES YES YES YES Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

Exten
sion
is
used

25

Note: Volume Migration function is included in Hitachi Tiered Storage
Manager

When using Hitachi Dynamic Provisioning, Dynamic Tiering, or Thin Image,
the pool or virtual volume capacity that can be created is enhanced according
to the addition condition of Shared Memories. When using a pool or virtual
volume capacity that exceeds 0.12 PB (VSP G200) and 0.2 PB (VSP G400,
G600, G800), use the DP, DT, or TI Extension. If you do not use the DP, DT,
or TI Extension, delete all DP, DT, and TI pools.

The following table shows the usabale capacity of the pool or virtual volume:

Hitachi storage application Maximum pool or virtual volume capacity (Pb)

DP 0.2

Dynamic Provisioning, Dynamic Tiering, Thin
Image

0.5

Dynamic Provisioning, Dynamic Tiering, Thin
Image Extension 1

2.0

Dynamic Provisioning, Dynamic Tiering, Thin
Image Extension 2

6.5

The following table shows the shared memory capacity for is a conversion
table for the Maintenance Utility window and reference table.
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Shared memory
Hitachi storage

application
Shared memory capacity (GB)

Basic only Apply Dynamic
Provisioning.

5

Basic, Extension 1 Apply Dynamic
Provisioning.

Apply:
• ShadowImage, Volume

Migration
• Thin Image
• TrueCopy, Universal

Replicator
• Dynamic Tiering

9

Basic, Extension 1,
Extension 2

Apply Dynamic
Provisioning.

Apply:
• ShadowImage, Volume

Migration
• Thin Image
• TrueCopy, Universal

Replicator
• Dynamic Tiering

Apply:
• ShadowImage, Volume

Migration Extension 1
• TrueCopy, Universal

Replicator Extension 1
• Dynamic Provisioning,

Dynamic Tiering, Thin
Image Extension 1

13

Basic, Extension 1,
Extension 2, Extension 3

Apply Dynamic
Provisioning.

Apply:
• ShadowImage, Volume

Migration
• Thin Image
• TrueCopy, Universal

Replicator
• Dynamic Tiering

Apply:
• ShadowImage, Volume

Migration Extension 1
• Dynamic Provisioning,

Dynamic Tiering, Thin
Image Extension 1

Apply:
• ShadowImage, Volume

Migration Extension 2
• TrueCopy, Universal

Replicator Extension 2

17
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Shared memory
Hitachi storage

application
Shared memory capacity (GB)

Basic, Extension 1,
Extension 2, Extension 3,
Extension 4

Apply:
• ShadowImage, Volume

Migration
• Thin Image
• TrueCopy, Universal

Replicator
• Dynamic Tiering

Apply:
• ShadowImage, Volume

Migration Extension 1
• TrueCopy, Universal

Replicator Extension 1
• Dynamic Provisioning,

Dynamic Tiering, Thin
Image Extension 1

Apply:

• ShadowImage, Volume
Migration Extension 2

• TrueCopy, Universal
Replicator Extension 2

Apply Dynamic
Provisioning, Dynamic
Tiering, Thin Image
Extension 2 applications.

25

The following figures show the Install Shared Memories window with the
base and extension settings, followed by the Maintenance Utility window.
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Adding shared memory

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the CTLs tab.
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4. Check the status and capacity of the mounted shared memory.
5. Click Install list, and then click Shared Memory.
6. In the Install Shared Memory window, check the Shared Memory

Function and click Install.
7. When the completion message appears, click Close.
8. Click the CTLs tab on the Controller Chassis window, and then confirm

that the shared memory size has changed and that the Status is Normal.
9. If the shared memory addition fails:

a. Click Close on the completion message.
b. Click Refresh.
c. Click the CTLs tab on the Controller Chassis window.
d. Check the shared memory status.

10. Add shared memory to controller 2 using the same procedures.
11. Log out and close the Maintenance Utility window.

Front end module

Blocking a front end module

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
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3. In the Controller Chassis window, click the CHBs tab.
 

 
4. Check the status of the front end module.
5. Click the Install list.

Adding components 177
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



6. In the following window, select the front end module (CHB Type) to be
added, and then click Submit.
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7. Check that the front end module becomes ready for adding, but do not
click the Install button.
 

 

Adding a front end module

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the front end module.
• Storage system power is turned on.

Procedure

1. Disconnect the optical fiber cable from the front end module.
2. Loosen the two blue screws that secure the front end module.
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3. Gently remove the front end module.
When removing the front end module, hold the blue screw and keep the
front end module straight avoid jostling the components above and
below it.
 

 
4. Connect the optical fiber cable to the new front end module.
5. Insert the new front end module into the slot, just before the "shield

finger."
 

 
6. Gently push the front end module all the way into the slot.
7. Tighten the two blue screws to secure the front end module.
8. Confirm that the red STATUS LED on the front end module goes off.

Postrequisites
• Use the maintenance utility to restore (unblock) the front end module.

Recognizing a front end module
Recognizing a front end module is done in the maintenance utility.

180 Adding components
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Procedure

1. Click Install.
2. When the completion message appears, click Close.
3. Click CHBs tab in the Controller Chassis window and confirm that the

status of the new front end module is Normal.
4. If the front end module addition fails:

a. Click Close on the completion message.
b. Click Refresh.
c. Click the CHBs tab on the Controller Chassis window.
d. Check the front end module status.

5. Log out and close the Maintenance Utility window.
6. Configure host group and iSCSI target settings, as apppropriate.

Small form factor pluggable

Checking a small form factor pluggable
Verify the status of the small form factor pluggable in the Maintenance
Utility window.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the CHBs tab.
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4. Check the status of the small form factor pluggable.
 

 
5. Click the status of the small form factor pluggable.
6. Click the SFP Status of the SFP you want to replace.
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7. Click Change SFP Type.
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8. Click Submit.
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9. Check that the SFP can be changed. Do not click Apply.
 

 

Replacing an SFP
Install the same type of SFP as the one being replaced. The color of the lever
or the entire SFP identifies the SFP type:
• Shortwave SFPs are black.
• Longwave SFPs are blue.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.

Procedure

1. Disconnect the optical cable from the SFP to be replaced.
2. Pull the SFP lever down toward you and pull out the SFP.

If you cannot remove the SFP, pull it out while pushing open the lever
toward you.
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3.  

 
Wait at least 10 seconds, and then check the SFP insertion direction and
insert the SFP into the port until it clicks.

Note: Replace the SFP with the same type being removed.

4. Connect the optical cable to the new SFP. Check that optical cable latch
clicks and the cables are surely connected.

5. Confirm that the red STATUS LED on the front end module is off.
6. In the Controller Chassis window, confirm that the status of the

replacement SFP is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.
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7. Log out and close the Maintenance Utility window.

Recognizing an SFP
The new SFP must be recognized through the Maintenance Utility window.

Procedure

1. Click Apply.
2. When the completion message appears, click Close.
3. In the Controller Chassis window, click the CHBs tab, and then check

that the SFP status is Normal.
4. If the SFP type change fails:

a. Click Close on the completion message.
b. Click Refresh.
c. Click the CHBs tab on the Controller Chassis window.
d. Check the status of the SFP.

5. Log out and close the Maintenance Utility window.

Adding a back end module to a CBLM or CBLH controller
You can install a back end module into an empty slot on a CBLM or CBLH
controller, or replace back end modules. There are two back end modules
available, but they cannot be mixed in a single storage system. Therefore, be
sure to add the appropriate back end module.

Preparing to install a back end module into an empty slot
Log into the maintenance utility to verify the status of the back end module.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the DKBs tab.
4. Check the status of the back end module.

Adding components 187
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



5. Click the Install list and select the slot where the back end module will
be added.
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6. Select the back end module to be added and click Submit.
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7. Check that the back end module becomes ready for adding. Do not click
Install.
 

 

Postrequisites

You can now install the back end module into an empty slot.

Preparing to replace a back end module

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the DKBs tab.
4. Check the status of the back end module (DKB) to be changed type.
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5. Select the back end module to be replaced, and then click Replace
(Type Change).
 

 
6. Check that the channel board (DKB) replacement (type change)

preparation is completed, and then click Block.
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7. Click Block.
8. When the next window appears, leave the New DKB Type drop-down

list as is and do not click Restore until you replace the back end module.
 

 

Postrequisites

You can now replace the back end module.

Adding or replacing the back end module

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the back end module.
• Storage system power is turned on.

• Confirm that the red STATUS LED on the back end module to be replaced is
on.

Procedure

1. Press the white tab on the SAS cable, and then remove the cable from
the back end module to be replaced.
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2. Loosen the two blue screws that secure the back end module or
"dummy" board.

3. Holding the blue screw on the back end module, gently remove the back
end module. Keep the back end module straight to avoid jostling the
components above and below it.
 

 
4. Insert the new back end module into the slot, just before the "shield

finger."
 

 
5. Gently push the new back end module all the way into the slot.
6. Connect the SAS cable to the new back end module.
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7. Tighten the two blue screws to secure the back end module.
8. Confirm that the red STATUS LED on the new back end module is off.

Postrequisites
• Use the maintenance utility to restore (unblock) the back end module.

Recognizing a back end module

Procedure

1. Start the maintenance utility.
2. If you installed a back end module into an empty slot:

a. From the Install Disk Board window, click Install.
b. When the completion message appears, click Close.
c. Click the DKBs tab, and then check that the status of the newly added

back end module is Normal.
3. If you replaced a back end module:

a. From the Replace Disk Board (Type Change) window, use the New
DKB Type drop-down list to select the type of back end module you
added, and then click Restore.

b. When the completion message appears, click Close.
c. Click the DKBs tab, and then check that the status of the newly added

back end module is Normal.
4. If the back end module type change fails:

a. Click Close on the completion message.
b. Click Refresh.
c. Click the DKBs tab on the Controller Chassis window.
d. Check the back end module status.

5. Log out and close the Maintenance Utility window.

Adding drive trays

Prerequisites

Prior to installing a drive tray, verify that the drive tray contains no drives. If
drives are installed, remove them prior to installing the drive tray.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click the storage system

information.
3. Click the Chassis tab.
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4. Click Install.
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5. Check that the drive tray becomes ready for installation. Do not click
Install at this time.

 

 
6. Mount the drive tray in the rack.
7. Secure the SFF or LFF drive tray.
8. Install the drives in the drive tray.
9. Connect the SAS cables.

10. Connect the power cables.
11. Check that the green READY LED is on at the newly added drive tray.
12. Attach the front bezel to the drive tray.
13. In the Install Drive Boxes window, specify the number of drive trays

added and the drive tray type, and then click Install.
14. When the completion message appears, click Close.
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15. Click Chassis tab on the Maintenance Utility window, and then check
the added drive tray is Normal.

If the drive tray addition fails:
• Click Close in the completion message.
• Click Refresh.
• Click the Chassis tab.
• Check the Drive Box status.

• Click the Refresh icon:
16. After adding the drive tray, log out and close the Maintenance Utility

window.
17. Configure the following system settings to suit your requirements:

• Set parity groups.
• Format volumes.
• Set spare drives.
• Allocate volumes.
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A
Registration, resources, and checklists

This appendix contains instructions for registering your storage system and
information about the available resources you can use to enhance your
experience with your storage system. Also, included is a table where you can
record your configuration settings for future reference.

□ Register your storage system

□ Creating a user account

□ Logging in to the HDS Support Portal

□ Additional resources

□ Recording your configuration settings
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Register your storage system
Before you start using your storage system for the first time, use the HDS
Support Portal to register your storage system.

If you encounter a problem visit https://portal.hds.com/index.php/contact-us
or contact the Hitachi Global Contact Center (GCC):
• From the US: (800) 446 0744
• Outside the US: (858) 547-4526
• Web: portal.support@hds.com
• EMEA assistance: maito:hdsservicerequests@hds.com or call +44 1753

216064

When calling the GCC, please have the following information available:
• Customer site ID
• Product model and serial number
• Contact name, phone number, and email address

Creating a user account
The first time you log in to the HDS Support Portal, you must create a user
account before you register your storage system.

Procedure

1. Open a browser and go to the HDS Support Portal at https://
portal.hds.com.

2. When the landing page appears, click Need to register? under Login at
the bottom-right area of the page.

3. At the User Registration page, click your country or region, and then
click Submit.

4. At the Global Personal Data Protection & Privacy Policy page, read
the policy. When you finish, click I accept.
You must accept the policy to continue with the registration process.

5. At the User Type page, select a user type.
• Customer
• Channel Partner
• Other (OEM, Supplier, Global Solutions)
• Guest

6. Click Next.
7. At the Contact Info page, enter your customer contact information.
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Note: In the Registering with a Company field, enter your
company's Site ID to ensure accurate user to site matching.

8. When you finish, click Next.
9. Follow the remaining on-screen instructions.

10. At the Confirmation page, confirm that the information shown is
correct.
If you need to change it:
a. Click the appropriate topic link in the bread crumbs at the top of the

page or in the body of the page.
b. Edit the information.
c. Click Next until the Confirm page appears.

11. Click Register.

Result

The storage system is registered, the Landing page appears, and a login
password is sent to the email address you specified during product
registration. You can use the email address and password to log in to the
HDS Support Portal.

Logging in to the HDS Support Portal
After you create a user account in the HDS Support Portal and receive a
password, you can log in to the Portal to register additional Hitachi storage
systems.

The HDS Support Portal also provides the following support tools:
• Knowledge Base
• Case management
• Downloads
• Product Interoperability
• Technical bulletins
• Product documents

Procedure

1. At the Login page, enter your login credentials.
• Username: Enter the email address you specified when you created

your user account.
• Password: Enter the case-sensitive password you received by email

when you created your user account. For security, each typed
password character is mased with a dot (·).

2. Click LOGIN.
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3. Confirm that all of your products are registered by clicking the My
Products link at the top of the page or at the bottom-right area of the
page.

4. If all of your products are shown under My Products for all of your sites,
your Hitachi storage systems are registered.
Otherwise, perform the following steps:

5. Click the Register Additional Product link at the top of the page or the
Register Additional Products link at the bottom-right area of the
page.

6. At the Product Registration page, under Product Information, click
the Product Category menu and select the product category for the
product you are registering.

7. Click the Product Model menu and select the product you are
registering.

8. Click in the Serial Number field and enter the serial number for your
product.
For your convenience, the Hitachi Virtual Storage Platform G200, G400,
G600 models provide a serial # label on the top of the enclosure.
 

 
9. Optional: Click in the Alias field and enter a "friendly" name for the

product you are registering.
10. Click the Next button at the bottom of the page.
11. At the Site Information page, click the site where the product is

installed.
If the site does not exist, create a new site.
• If you clicked an existing site, click Next.
• If you clicked Create a New Site, complete the on-screen site

information. When that is complete, click Next.
12. At the Confirm Registration page, click Register at the bottom of the

page.
13. Wait 15 minutes, then go to the My Products page link and confirm that

the storage system is registered.
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Additional resources
Hitachi provides a number of resources for maximizing your experience.

Product documentation
Refer to the Related documents section in the Preface and the supplied
documentation CD.

All documentation is also available at https://portal.hds.com/.

Product interoperability
For convenience, Hitachi Data Systems provides an interoperability matrix
that can be accessed from the Support Portal and the Hitachi web site.
• HDS Support Portal: Log into the Portal and click the Product

Interoperability link.
• Hitachi web site: http://www.hds.com/products/interoperability/.

Global services
Hitachi Data Systems Global Services can increase the value of IT to your
business with carefully applied technologies for reducing risk, accelerating
ROI, lowering costs, and managing your storage infrastructure successfully.

http://www.hds.com/services/

For a list of in-country toll-free phone numbers, go to https://portal.hds.com/
index.php/contact-us/in-country-toll-free-numbers.

HDS Community
The HDS Community lets you exchange information, questions, and
comments about Hitachi Data Systems products, services, and support.

http://community.hds.com

Recording your configuration settings
Make a copy of the following table and record your configuration settings for
future reference.

Field Enter Your Setting Below

Initial Startup Wizard

Default Account Maintenance Password
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Field Enter Your Setting Below

IP v4 Configuration: Storage System Address,
Controller 1

IP v4 Configuration: Storage System Address,
Controller 2

IP v4 Configuration: SVP Address

IP v4 Configuration: Subnet Mask

IP v4 Configuration: Default Gateway

IP v4 Configuration: DNS Server 1

IP v4 Configuration: DNS Server 2

IP v4 Configuration: DNS Server 3

IP V6 Configuration Enabled or Disabled

Initial Setup Wizard

Storage System Name

Contact

Location

UTC Time Zone

Use NTP Server:

Yes - Specify NTP Server IP Address:

No - Specify Manually Entered Date and Time:

Synchronizing Time

Alert Notifications

Notification Alert, Host Report or All

Email Notice, Enable or Disable

Email Address (To)

Email Address (From)

Email Address (Reply To)

Mail Server Settings

Mail Server: Identifier, IPv4, or IPv6

IP address

SMTP Authentication, Enable or Disable

If Enabled, Enter Account and Password

SNMP Agent, Enable or Disable

Trap Destinations

SNMP Managers

System Group Information

Storage System Name

Contact

Location
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Field Enter Your Setting Below

Installing Licenses

Record each license installed on the storage
system. You may want to include whether the
license was installed by selecting a license key
file or by typing a license key code.

Host Port Settings

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

Fibre Channel Port: __________
Port Address:
Transfer Rate:
Topology:

iSCSI Port: __________
IP Address:
Subnet Mask:
Default Gateway:

iSCSI Port: __________
IP Address:
Subnet Mask:
Default Gateway:

iSCSI Port: __________
IP Address:
Subnet Mask:
Default Gateway:
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Field Enter Your Setting Below

iSCSI Port: __________
IP Address:
Subnet Mask:
Default Gateway:
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B
Upgrading firmware

□ Firmware upgrade prerequisites

□ Upgrading the SVP software

□ Upgrading firmware for the storage system
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Firmware upgrade prerequisites
Before upgrading the firmware on a storage system, observe the following
prerequisites:

• Firmware upgrades can cause a single controller to handle all host I/O.
Therefore, we recommend you upgrade firmware when host I/O is low,
such as during non-peak hours or on weekends or holidays.

• If the storage system and the computer that will be used during the
upgrade are connected directly, check that the storage system LAN port is
linked up. If they are connected using a switch, check that the LAN port on
the switch is linked up.

• If you need to upgrade the SVP and storage system firmware, upgrade the
SVP firmware first.

• Confirm that other applications (JP1 andHitachi Device Manager - Storage
Navigator, other Device Manager - Storage Navigator operations, and so
on) that access the storage system over a network are not operating.

• Do not upgrade firmware when TrueCopy is used.

Upgrading the SVP software
Hitachi provides regular software upgrades for the SVP.

You should always run the latest SVP software. The software-upgrade
procedure requires an SVP reboot, so allow sufficient time to upgrade the
software and reboot the SVP.

Upgrading the SVP software consists of the following steps:

Procedure

1. Stopping the SVP service.
2. Upgrading the SVP software.
3. Starting the SVP service.

Stopping the SVP service
Before upgrading the SVP software, stop the SVP service.

Procedure

1. Connect the management console PC attached to the SVP, connect to the
SVP using Windows Remote Desktop Client.

2. On the SVP, click Start > All Programs > Hitachi Device Manager-
Storage Navigator > StorageDeviceList.
The Storage Device List window opens.
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3. Wait for the Ready LED to turn green in the Storage Device List
window.
 

 

Note: If the storage system status does not become Ready, click
the Refresh icon to the right of StorageDeviceList at the top of

the page: 

4. In the Storage Device List window, record the S/W
Version:___________________________________
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5. Click Edit.
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6. Uncheck Start service automatically, when the SVP is rebooted at
the bottom of the Edit System window.
 

 
7. Click Apply, and then click Close.
8. Reboot the SVP (see Rebooting the SVP on page 129).
9. Proceed to Upgrading the software on page 212.
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Upgrading the software
After stopping the SVP service, use the following procedure tp upgrade the
SVP software. As part of this procedure, you will specify that the SVP service
should restart when the SVP is rebooted. This procedure assumes that you
have the new SVP software file at a location that can be accessed by the PC.

Procedure

1. On the SVP, click Start > All Programs > Hitachi Device Manager-
Storage Navigator > StorageDeviceList.
The Storage Device List window opens.

2. In the Storage Device List window, click Edit for the storage system
whose SVP software you want to upgrade.
 

 
The Edit System window appears.
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3. At the top of the window, check Software Selection, and then click
Browse.
 

 
4. Go to the location where you downloaded the software file (for example,

Software\productname.inf), and then click the software file and click
Open.

5. At the bottom of the Edit System window, check the check box Start
service automatically, when the SVP is rebooted.
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6. Click Apply.
7. In the Storage Device List window, confirm that the software version

shown is later than the version you recorded prior to the upgrade.

Upgrading firmware for the storage system
Hitachi works hard to constantly improve the operation and performance of
your storage system. When improvements are available, they are offered to
customers as upgraded firmware releases.

We recommend you check that your storage system has the latest firmware
after you install and configure the storage system. Thereafter, check for
firmware releases and install them as they become available.

Upgrading the firmware
Use the following procedure to determine whether your storage system is
using the most recent firmware version. This procedure assumes that you
have the new storage system firmware file at a location that can be accessed
by the PC.

Note: If you need to upgrade the SVP software and the storage system
firmware, upgrade the SVP software first, and then upgrade the storage
system firmware.

Procedure

1. In the Hitachi Command Suite main window, click the Resource tab.
2. Click Storage Systems from the tree view
3. Expand the tree, and then click Maintenance Utility.

The Maintenance Utility window appears.
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4. In the Maintenance Utility window, click Administration >
Firmware.
The Firmware page appears.

 

 
5. Record the currently installed firmware shown on the bottom (GUM) row:

________________________________
6. Click the Update button.

The Update Firmware window appears.

 

 
7. Next to Firmware File(*mda), click Browse.
8. Go to the location where the new firmware file is located (the file ends

with the extension .mda).
9. Click the filename, and then click Open.

10. Click Apply.
The firmware version confirmation window appears.

11. Click Apply.
The Update Progress window shows the progress of the upgrade.
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12. When the Information window informs you about the maintenance utility
(GUM) reboot, click OK, and then click the X in the top-right corner to
close the window.

13. When the Firmware window appears, close it, and then wait for the
maintenance utility to start.

14. Repeat steps 4 and 6.
15. When a window tells you that firmware renewal was completed, click OK.
16. Log out of the maintenance utility, and then log back in, go to the

Firmware version window, and confirm that the firmware for GUM is
higher than the one you recorded before the upgrade.
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C
Specifications

□ Model lists

□ Replacement parts

□ Hitachi Virtual Storage Platform G400, G600 mechanical specifications

□ Electrical specifications

□ Environmental specifications

□ Battery specifications

□ RAID specifications

□ iSCSI specifications

□ iSCSI standards

□ Regulatory compliance

□ Dense intermix drive tray connection restrictions

□ SVP hardware specifications
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Model lists

Hitachi Virtual Storage Platform G400, G600 controller model lists

CBLM controller components

Model number Part name Quantity

DW800-CBL 4U chassis 1

Power supply unit 2

Power cable (0.9 m) 2

Power cable (2.5 m) 2

LAN blade (local-area network,
uninterruptible power supply)

2

Backup module 8

Front bezel (4U) 1

DW-F800-CTLM Controller 2

DW-F800-BAT Battery 6

CBLM controller optional components

Model number Part name Quantity

DKC-F810I-CM8G Cache memory (8 GB) 8-16

DKC-F810I-CM16G Cache memory (16 GB) 8-16

DW-F800-BM20 Cache flash memory 2-4

DW-F800-4HF8 Front end module (8 Gbps Fibre
Channel)

2-4

DW-F800-2HF16 Front end module (16 Gbps
Fibre Channel)

2-4

DW-F800-2HS10S Front end module (10 Gbps
small form factor pluggable
iSCSI)

2-4

DW-F800-BS12G Back end module 2-4

DKC-F810I-1PS8 SFP for 8 Gbps Shortwave 2-4

DKC-F810I-1PL8 SFP for 8 Gbps Longwave 2-4

DKC-F810I-1PS16 SFP for 16 Gbps Shortwave 2-4

DKC-F810I-1PL16 SFP for 16 Gbps Longwave 2-4

DW-F800-BAT Battery 2-6
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Model number Part name Quantity

N/A SAS cable label 2

Drive tray model lists

SFF drive tray components

Model number Part name Quantity

DW-F800-DBS and DW-F800-
DBSC

2U chassis 1

ENC 2

Power supply unit 2

Power cable (0.9 m) 2

Power cable (2.5 m) 2

Front bezel (2U) 1

SFF drive tray optional components

Model number Part name Quantity

DKC-F810I-200MEM 200-GB, 2.5-inch, MLC, 12-
Gbps flash drive

2-24

DKC-F810I-300KCMC 300-GB, 2.5-inch, 15kmin-1, 6-
Gbps SAS drive

2-24

DKC-F810I-400MEM 400-GB, 2.5-inch, MLC, 12-
Gbps flash drive

2-24

DKC-F810I-600JCM 600-GB, 2.5-inch, 10kmin-1, 6-
Gbps SAS drive (contains BNST)

2-24

DKC-F810I-600JCMC 600-GB, 2.5-inch, 10kmin-1, 6-
Gbps SAS drive

2-24

DKC-F8191-600KGM 600-GB, 2.5-inch SAS drive 2-24

DKC-F810I-1R2JCMC 1.2-TB, 2.5-inch, 10kmin-1, 6-
Gbps SAS drive

2-24

LFF drive tray components

Model number Part name Quantity

DW-F800-DBL and DW-F800-
DBLC

2U chassis 1

ENC 2

Power supply unit 2

Power cable (0.9 m) 2
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Model number Part name Quantity

Power cable (2.5 m) 2

Front bezel (2U) 1

Optional LFF drive tray components

Model number Part name Quantity

DKC-F810I-400M6M 400-GB, 3.5-inch, MLC, 12-
Gbps flash drive

2-12

DKC-F810I-1R2J5M 1.2-TB, 3.5-inch, 10kmin-1, 6-
Gbps SAS drive (contains BNST)

2-12

DKC-F810I-1R2J5MC 1.2-TB, 3.5-inch,10kmin-1, 6-
Gbps SAS drive

2-12

DKC-F810I-4R0H3M 4-TB, 7.2K 3.5-inch, 7200min-1,
6-Gbps SAS drive (contains
BNST)

2-12

DKC-F810I-4R0H3MC 4-TB, 7.2K 3.5-inch, 7200min-1,
6-Gbps SAS drive

2-12

DKC-F810I-6R0H9M 6-TB, 7.2K 3.5-inch, 7200min-1,
12-Gbps SAS drive

2-12

FMD drive tray components

Model number Part name Quantity

DW-F800-DBF 2U chassis 1

ENC 2

Power supply unit 2

Power cable (0.9 m) 2

Power cable (2.5 m) 2

Front bezel (2U) 1

FMD drive tray optional components

Model number Part name Quantity

DKC-F710I-1R6FM 1.6-TB, MLC, 6-Gbps Flash
Module Drive

2-12

DKC-F710I-3R2FM 3.2-TB, MLC, 6-Gbps Flash
Module Drive

2-12
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Dense intermix drive tray components

Model number Part name Quantity

DW-F800-DB60 and DW-F800-
DB60C

4U box 1

ENC 2

Power supply unit 2

Power cable (0.9 m) 2

Power cable (2.5 m) 2

Front bezel (dense intermix
drive tray)

1

DW-F800-SCQ3 SAS cable (3 m), including 2
omega clips

2

Dense intermix drive tray optional components

Model number Part name Quantity

DKC-F810I-400M8M 1.6-GB, MLC, 12-Gbps flash
drive

2-60

DKC-F810I-1R2J7M 1.2-TB, 2.5-inch, 10kmin-1, 6-
Gbps SAS drive (contains BNST)

2-60

DKC-F810I-1R2J7MC 1.2-TB, 2.5-inch, 10kmin-1, 6-
Gbps SAS drive

2-60

DKC-F810I-4R0H4M 4-TB, 7.2K 3.5-inch, 7200min-1,
6-Gbps SAS drive (contains
BNST)

2-60

DKC-F810I-4R0H4MC 4-TB, 7.2K 3.5-inch, 7200min-1,
6-Gbps SAS drive

2-60

DKC-F810I-6R0HLM 6-TB, 7.2K 3.5-inch, 7200min-1,
12 Gbps SAS drive

2-60

Other model list
Numbers in parentheses show the quantities of the components.

Power cables

Model number Specification

DW-F800-J1H 2.5 m, 2-pole power cable with grounding
terminal (AC 125 V, 13 A or 15 A)

DW-F800-J2H 2.5 m, 2-pole power cable with grounding
terminal (AC 250 V, 13 A or 15 A)
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Model number Specification

DW-F800-J2H5 5.0 m, 2-pole power cable with grounding
terminal (AC 200 V, 13 A or 15 A)

DW-F800-J2H10 10.0 m, 2-pole power cable with grounding
terminal (AC 200 V, 13 A or 15 A)

A-F6516-P620 Power cable for PDU (1)

A-F6516-P630 Power cable for PDU (1)

SAS cables

Model number Specification

DW-F800-SCQ1 1 m SAS cable, including omega clips (2)

DW-F800-SCQ1F 1.5 m SAS cable, including omega clips (2)

DW-F800-SCQ3 3 m SAS cable, including omega clips (2)

DW-F800-SCQ5 5 m SAS cable, including omega clips (2)

DW-F800-SCQ10A 10 m SAS optical cable

DW-F800-SCQ30A 30 m SAS optical cable

DW-F800-SCQ1HA 100 m SAS optical cable

Optical cables

Model number Specification

A-6515-GM5L 5 m LC-LC optical cable for optical

A-6515-GM10L 10 m LC-LC optical cable for optical

A-6515-GM20L 20 m LC-LC optical cable for optical

A-6515-GM30L 30 m LC-LC optical cable for optical

A-6515-GM40L 40 m LC-LC optical cable for optical

A-6515-GM50L 50 m LC-LC optical cable for optical

A-6515-GM1JL 100 m LC-LC optical cable for optical

A-6515-GS10L 10 m LC-LC optical cable for optical

A-6515-GS20L 20 m LC-LC optical cable for optical

A-6515-GS30L 30 m LC-LC optical cable for optical

A-6515-GS50L 50 m LC-LC optical cable for optical

A-6515-GS1JL 100 m LC-LC optical cable for optical

A-6515-HM5L 5 m LC-LC optical cable for optical

A-6515-HM10L 10 m LC-LC optical cable for optical

A-6515-HM20L 20 m LC-LC optical cable for optical
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Model number Specification

A-6515-HM30L 30 m LC-LC optical cable for optical

A-6515-HM50L 50 m LC-LC optical cable for optical

A-6515-HM100L 100 m LC-LC optical cable for optical

A-6515-HM200L 200 m LC-LC optical cable for optical

A-6515-HM300L 300 m LC-LC optical cable for optical

A-6515-JM5L 5 m LC-LC optical cable for optical

A-6515-JM10L 10 m LC-LC optical cable for optical

A-6515-JM20L 20 m LC-LC optical cable for optical

A-6515-JM30L 30 m LC-LC optical cable for optical

A-6515-JM50L 50 m LC-LC optical cable for optical

A-6515-JM100L 100 m LC-LC optical cable for optical

A-6515-JM200L 200 m LC-LC optical cable for optical

A-6515-JM300L 300 m LC-LC optical cable for optical

Replacement parts
Part replacement is required to maintain high performance. Replacement of
parts is covered by the maintenance service contract.

Battery unit

Replacement period

Three years.

Treatment

Use the storage system in a place where the ambient temperature is 86°F
(30°C) or less on average.

Periodic parts replacement is required. For customers with maintenance
service contracts, parts are replaced periodically in keeping with the terms of
the contract.

Note: The battery is designed to protect the data in the cache memory in an
emergency, such as a sudden power failure. In these situations, follow the
normal power down procedure. If not, the battery might reach its lifespan
earlier than expected and become unusable within three years. When
replacing the battery, follow the given procedure for disposing a used battery.
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Hitachi Virtual Storage Platform G400, G600 mechanical
specifications

Configuration

Controller
1 CBLM

Drive tray
1 SFF drive tray
1 LFF drive tray
1 FMD drive tray
1 Dense intermix drive tray

Drive

When mounting storage systems mixing SFF, LFF, FMD, and dense intermix
drive trays, the maximum number of drives you can mount varies.

Item Component Specification

Drive size (WxDxH) SFF drive tray 2.5-type: 3.21 x 8.10 x 0.74
inches (81.6 x 205.7 x 18.7
mm)

LFF drive tray 3.5-type: 4 x 5.78 x 1.02
inches (101.6 x 147.0 x 26.1
mm)

FMD drive tray Flash Module Drive: 5.74 x
14.44 x 0.78 inches (146 x
366.8 x 19.8 mm)

Data capacity (GB) SFF drive tray 2.5-type: 196.92, 288.20,
393.85, 576.39, 1152.79

LFF drive tray, dense intermix
drive tray

3.5-type: 393.85, 1152.79,
3916.14, 5874.22

FMD drive tray Flash Module Drive: 1759.21,
3518.43

Rotational speed (min-1) SFF drive tray
Flash drive, 2.5-type: 196.92
GB, 393.85 GB
2.5-type: 288.20 GB, 15,000
RPM
2.5-type: 576.39 GB, 10,000 or
15,000 RPM
2.5-type: 1152.79 GB, 10,000
RPM

LFF drive tray
Flash drive, 3.5-type: 393.85
GB
3.5-type: 1152.79 GB, 10,000
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Item Component Specification

RPM
3.5-type: 3916.14 GB, 7,200
RPM
3.5-type: 5874.22 GB, 7,200
RPM

FMD drive tray Flash Module Drive: 1759.21
GB, 3518.43 GB

Maximum number of drives that
can be mounted

SFF drive tray 24 drives

LFF drive tray 12 drives

FMD drive tray 12 drives

Dense intermix drive tray 60 drives

Hitachi Virtual Storage Platform
G400 SFF drive tray

384

Hitachi Virtual Storage Platform
G400 LFF drive tray

192

Hitachi Virtual Storage Platform
G400 FMD drive tray

192

Hitachi Virtual Storage Platform
G400 dense intermix drive tray

480

Hitachi Virtual Storage Platform
G600 SFF drive tray

576

Hitachi Virtual Storage Platform
G600 LFF drive tray

288

Hitachi Virtual Storage Platform
G600 FMD drive tray

288

Hitachi Virtual Storage Platform
G600 dense intermix drive tray

720

Maximum number of spare
drives

32

Host interface

Item Component Specification

Interface type Fibre Channel optical 8 Gbps, 16 Gbps

Optical iSCSI 10 Gbps

Data transfer speed (maximum
speed for transfer to host)

Fibre Channel optical 800 Mbps

Fibre Channel optical 1600 Mbps

Optical iSCSI 1000 Mbps

Number of ports 8-Gbps Fibre Channel optical 48

16-Gbps Fibre Channel optical 24

10-Gbps optical iSCSI 24

Transferred block size N/A 512 bytes
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Item Component Specification

Maximum number of hosts
using a Fibre Channel switch

255

Maximum number of hosts
using a network switch

255

RAID specifications

D: Data drive, P: Parity drive.

Although the storage system with a configuration of RAID 1, RAID 5, or RAID
6 provides data reliability enhanced by redundancy, there is a chance that
user data could be lost due to an unexpected host, storage system hardware,
or software failure. Therefore, users are requested to back up all data.

RAID Level SAS, SAS 7.2k, flash drives mounted

RAID 1 2D+2D, 4D+4D

RAID 5 3D+1P, 4D+1P, 6D+1P, 7D+1P

RAID 6 6D+2P, 12D+2P, 14D+2P

Item Specification

Maximum number of parity groups Virtual Storage Platform G400:160

Virtual Storage Platform G600:240

Maximum volume size 3 TB (using the LDEVs of other storage systems:
4 TB )

Maximum volumes/host groups and iSCSI
targets

2048

Maximum volumes/parity groups 2048

Internal logic specifications

Item Component Specification

Control memory Flash memory 32 MB

L3 cache memory 4 MB

SDRAM 1 GB

Data assurance method Data bus Parity

Cache memory ECC (1 bit for correction, 2 bits
for detection)

Drive Data assurance code
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Physical specifications

Item Component Specification

Start-up time (min)1 Controller Standard: 5 to 8

Drive trays Standard: 5 to 8

Chassis size Controller
17.57 x 35.1 x 6.86 in
(446.3 x 891.7 x 174.3 mm)

SFF drive tray
WxDxH: 19 x 22.2 x 3.5 inches
(482 x 565 x 88.2 mm)

LFF drive tray
WxDxH: 19 x 22.2 x 3.5 inches
(482 x 565 x 88.2 mm)

FMD drive tray
WxDxH: 19 x 30 x 3.42 inches
(483 x 762 x 87 mm)

Dense intermix drive tray
WxDxH: 19 x 40.5 x 7 inches
(482 x 1,029 x 176 mm)

Mass (approximate)2 CBLM
187.3 lbs
(85 kg)

SFF drive tray
51 lbs (23 kg)

LFF drive tray
59.5 lbs (27 kg)

FMD drive tray
84 lbs (38 kg)

Dense intermix drive tray
198 lbs (90 kg)

Required height CBLM 4

SFF drive tray 2

LFF drive tray 2

FMD drive tray 2

Dense intermix drive tray 4

Notes
1. The startup time might be longer in proportion to the number of drive trays connected. With a

maximum configuration of 1 controller and 19 drive trays, startup time is approximately 8
minutes.

2. Value of maximum configuration when all controllers and drives are mounted.

Cache specifications

Item Specification

Capacity (GB) Virtual Storage Platform G400: 128

Virtual Storage Platform G600: 256

Control Method Read LRU, Write after
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Item Specification

Battery backup Provided

Backup duration Unrestricted (saving to a nonvolatile memory)

Data in the cache memory is preserved against power failures. If a power
outage occurs, data in cache memory is written to drives.

When the storage system enters Cache Backup mode, the amber WARNING
LED goes on to when the system starts. This warning indicates that the
battery charge has dropped significantly and the remaining battery capacity
is not sufficient; the storage system will continue operating with the Write
Cache function disabled.

When the battery is charged, the warning indication disappears, and the
storage system continues the operation in the Write Cache function.

The warning indication disappears within six hours. Even when the warning is
shown, normal operation is assured in Write-Through. Read and write
performance is lowered because the Write Cache function is disabled.

If the storage system is not charged for more than six months, the battery
can become overcharged and sustain unrecoverable damage. To avoid this
situation, charge the battery more than 3 hours every six months.

Insulation performance

Item Specification

Insulation withstand voltage AC 1,500 V (100 mA, 1 min)

Insulation resistance DC 500 V, 10 M Ω or more

Electrical specifications

Item Controller Drive tray

Input voltage (operable voltage
range) (V)

AC 200-240 +6%/-11% SFF, LFF, FMD, and dense
intermix drive tray: AC 200-240
+6%/-11%

Frequency (Hz) 50/60 ±1

Number of phases, cabling Single-phase with protective grounding

Steady-state current 100V/
200V1, 2

CBSS: 4.0x2/2.0x2 CBSL:
4.0x2/2.0x2
CBSM: 4.0x2

SFF drive tray: 2.4x2/1.2x2

LFF drive tray: 1.9x2/1.0x2

FMD drive tray: 2.6x2/1.3x2

Dense intermix drive tray: -/
3.0x2
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Item Controller Drive tray

Current rating of breaker/fuse
(A)

16.0

Heat value (normal) (kJ/h) CBSS: 1800 or less CBSL 1550
or less
CBSM: 2160 or less

SFF drive tray: 1120 or less

LFF drive tray: 940 or less

FMD drive tray: 1300 or less

Dense intermix drive tray: 3460
or less

Steady-state power (VA/W)3 CBSS: 800/760 or less CBSL:
800/760 or less
CBSM: 1600/1560

SFF drive tray: 480/460 or less

LFF drive tray: 380/350 or less

FMD drive tray: 520/470 or less

Dense intermix drive tray:
1200/1160 or less

Power consumption (VA/W) CBSS: 520/500 or less CBSL:
450/430 or less
CBSM: 640/600 or less

SFF drive tray: 320/310 or less

LFF drive tray: 280/260 or less

FMD drive tray: 380/360 or less

Dense intermix drive tray:
1000/960 or less

Notes:
1. The power current of Nx2 described in this table is required for a single power unit.
2. If one power unit fails, another power unit requires electric current for the two power units.

Therefore, plan the power supply facility so that the current-carrying capacity for one power
unit can provide the total capacity for two power units.

3. This table shows the power requirement (100 V or 200 V) for the maximum configuration .
The actual required power might exceed the value shown in the table when the tolerance is
included.

Environmental specifications

Temperature

State Controller
SFF, LFF drive

trays
FMD drive trays

Dense intermix
drive tray

Operating 50°F to 104°F
(10°C to 40°C)

50°F to 104°F
(10°C to 40°C)

50°F to 95°F
(10°C to 35°C)

50°F to 104°F
(10°C to 40°C)

Non-operating 14°F to 122°F
(-10°C to 50°C)

14°F to 122°F
(-10°C to 50°C)

14°F to 95°F
(10°C to 35°C)

14°F to 122°F
(-10°C to 50°C)

Transport, storage -22°F to 140°F
(-30°C to 60°C)

-22°F to 140°F
(-30°C to 60°C)

-22°F to 122°F
(-30°C to 50°C)

-22°F to 140°F
(-30°C to 60°C)
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State Controller
SFF, LFF drive

trays
FMD drive trays

Dense intermix
drive tray

Temperature
change rate
(°C/h)

10 or less

Humidity

State Percentage

Operating 8 to 80

Non-operating 8 to 90

Transport, storage (%) 5 to 95

Maximum wet bulb temperature (°C) 29 (non-condensing)

Vibration

State m/s2

Operating 2.5 or less
Within 5 seconds (resonance point: 10 Hz or
less)

Non-operating 5.0 or less at 5 Hz to 300 Hz (no damage to
product)
9.8 (1.0 G)

Within 5 seconds (resonance point: 10 Hz or
less)

Transport (packed) 5.0 or less

Impact

State m/s2

Operating 20 or less
(10 ms, half sine wave)

Non-operating 50 or less
(10 ms, half sine wave)

Transport (packed) 80 or less

230 Specifications
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



Altitude

State Controller
SFF and LFF

drives
FMD drive

Dense intermix
drive tray

Operating (m) 3,000
(Environmental
temperature:
10°C to 32°C)

900
(Environmental
temperature:
32°C to 40°C)

3,000
(Environmental
temperature:
10°C to 32°C)

0 (Environmental
temperature:
32°C to 35°C)

3,000
(Environmental
temperature:
10°C to 28°C)

1,000
(Environmental
temperature:
28°C to 35°C)

Depends on
specifications of
installed devices
shown at left.

Non-operating
(m)

-60 to 12,000 N/A N/A N/A

Atmosphere

Avoid areas exposed to corrosive gas and salty air.

Acoustic Noise

Controller SFF, LFF FMD
Dense intermix drive

tray

60 dB (Environmental
temperature 32°C or
less)1

60 dB (Environmental
temperature 32°C or
less)1

71 dB (Environmental
temperature 32°C or
less)1, 2, 3, 4

72 dB (Environmental
temperature 32°C or
less)1, 2, 3, 4

60 dB 60 dB 71 dB (Environmental
temperature 32°C or
less)1, 2, 3, 4

72 dB (Environmental
temperature 32°C or
less)1, 2, 3, 4

Notes:
1. The system's internal temperature controls the rotating speed of the fan module. Therefore,

this standard value might be exceeded if the maximum load continues under high-
temperature environment or if a failure occurs in the system.

2. Sound pressure level (LA) changes from 66 dB or 75 dB, according to the ambient
temperature, drive configuration, and operating status. Maximum volume can reach 79 dB
during maintenance procedure for a failed ENC or power supply.

3. Acoustic power level (LwA) measured by the ISO 7779 standard is 7.2 B. This value changes
from 7.2 B to 8.1 B, according to the ambient temperature, drive configuration, and operating
status.

4. When accessing the dense intermix drive tray, do not work for long times at the rear of the
rack.

Battery specifications
The following table shows the lifetime expectancy of the batteries installed in
the storage system.
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Storage system

intake temperature

CBSS CBSL CBLM/CBLH

Up to 75.2º F (24º

C)

5 years 5 years 5 years

Up to 86º F (30º C) 5 years 4 years 5 years

RAID specifications

Item Controller
SFF, LFF, FMD, dense
intermix drive tray
(range for setup)

RAID level N/A SAS, SAS 7.2 krpm,
flash drives mounted:
0, 1, 5, 6, 1+0 (DBW
supports SAS 7.2k
drives)

RAID configuration
(unit of addition)

RAID 1 N/A 2D+2D, 4D+4D

RAID 5 N/A 3D+1P, 4D+1P, 6D+1P,
7D+1P

RAID 6 N/A 6D+2P, 12D+2P, 14D
+2P

Note: Although certain RAID configurations support redundancy in the event
of a drive failure, best practices dictate that you back up data on a regular
basis.

iSCSI specifications

Item Specification Comments

iSCSI target function Supported N/A

iSCSI target function Supported TrueCopy® only

iSCSI ports 2 per interface board Maximum 32 per iSCSI system

Host connections 255 (maximum per iSCSI port) With Linux software initiator,
the maximum number
decreases.

Path fallover HDLM1 Supports Microsoft MPIO (Multi
Path I/O)

Link 10 Gbps SFP+ N/A

Transfer speed 10 Gbps N/A
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Item Specification Comments

Connector type LC N/A

Cable Optical OM3, OM2 MMF cable N/A

Network switch L2 or L3 switch Should comply with
IEEE802.3ae

Switch cascading Maximum: 5 switches or fewer Minimum number of cascading
switches is recommended.

MAC address Per port (fixed value) Factory setting: World Wide
Unique value. Cannot be
changed.

Maximum transfer unit (MTU) 1,500, 4,500, 9,000 bytes
(Ethernet frame)

Jumbo frame, MTU size greater
than 1500

Link aggregation Not supported N/A

Tagged VLAN Supported N/A

IPv4 Supported N/A

IPv6 Supported N/A

Subnet mask Supported N/A

Gateway address Supported N/A

DHCP N/A N/A

DNS N/A N/A

Ping (ICMP ECHO) Transmit,
Receive

Supported N/A

IPsec2 N/A N/A

TCP port number 3260 Changeable among 1 to
65,535. Observe the following if
changing values:
• The setting of the

corresponding host should
also be changed to log in
the new port number.

• The new port number might
conflict with other network
communication or be
filtered on some network
equipment, preventing the
storage system from
communicating through the
new port number.

iSCSI name Both iqn3 and eui4 types are
supported

The unique iqn value is
automatically set when a target
is made. iSCSI name is
configurable.

Error recovery level 0 (zero) Error recovery by retrying from
host. Does not support Level 1
and Level 2.
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Item Specification Comments

Header digest Supported Detects header error or data
error with iSCSI
communication. The storage
system follows the host's digest
setting. If digest is enabled, the
performance degrades. The
amount of the degradation
depends on factors such as host
performance of host and
transaction pattern.

Data digest Supported

Maximum iSCSI connections at
one time

255 per iSCSI port N/A

CHAP Supported Authentication: login request is
sent properly from host to
storage. CHAP is not supported
during discovery session.

Mutual (2-way) CHAP Supported (not available if
connected to Linux software
initiator)

Authentication: login request is
sent properly from host to
storage.

CHAP user registration Max 512 users per iSCSI port N/A

iSNS Supported With iSNS (name service), a
host can discover a target
without knowing the target's IP
address.

Note:
1. JP1, HiCommand Dynamic Link Manager. Pass switching is achieved. Not supported on

Microsoft Windows Vista and Windows 7 operating systems.
2. IP Security. Authentication and encryption of IP packets. The storage system does not

support IPsec.
3. iqn: iSCSI Qualified Name. The iqn consists of a type identifier, "iqn," a date of domain

acquisition, a domain name, and a character string given by the individual who acquired the
domain. Example: iqn.1994-04.jp.co.hitachi:rsd.d7m.t.10020.1b000.tar

4. eui: 64-bit Extended Unique Identifier. The eui consists of a type identifier, "eui," and an
ASCII-coded, hexadecimal, EUI-64 identifier. Example: eui.0123456789abcdef

iSCSI standards
The following standards apply to the management, maintenance, and iSCSI
data ports. To configure this system, use switches that comply with the
following standards:
• IEEE 802.1D STP
• IEEE 802.1w RSTP
• IEEE 802.3 CSMA/CD
• IEEE 802.3u Fast Ethernet
• IEEE 802.3z 1000 BASE-X
• IEEE 802.1Q Virtual LANs
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• IEEE 802.3ad Dynamic LACP
• IEEE 802.3ae 10 Gigabit Ethernet
• RFC 768 UDP
• RFC 783 TFTP
• RFC 791 IP
• RFC 793 TCP
• RFC 1157 SNMP v1
• RFC 1231 MIB II
• RFC 1757 RMON
• RFC 1901 SNMPv2

Regulatory compliance
This equipment has been tested and certified for compliance with the
following standards.

Standard Specification Mark on the product Country regulation

Electronic emission
controls

FCC part 15 Subpart B:
2013

FCC USA and Canada

ICES-003 Issue 5:2012 ICES-003 USA and Canada

AS/NZS CISPR
22:2009+A1

RCM Australia and New
Zealand

TP TC 020/2011 EAC Russia, Belarus, and
Kazakhstan

CNS 13438 BSMI Taiwan

KN22 KC Korea

KN24 KC Korea

Electronic emission
certifications

EN5522: 2010 CEmarking EU

EN5524: 2010 CEmarking EU

EN61000-3.2:2006+A1
+A2

CEmarking EU

EN61000-3.3:2008 CEmarking EU

Safety certifications UL and CSA
60950-1:2007

cTUVus USA and Canada

EN60950-1:2006+A1 TUV Germany

IEC60950-1:2005+A1 N/A All CB countries

IEC60950-1:2005+A1 S_Mark Argentina

TP TC 004/2011 EAC Russia

CNS 14336-1 BSMI Taiwan

EN60950-1:2006+A1 CEmarking EU
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Standard Specification Mark on the product Country regulation

Radio interference
voluntary control

VCCI V-3/2013.04 VCCI Japan

Dense intermix drive tray connection restrictions
If a drive is inserted into a slot of a dense intermix drive tray when the
installed number of drives exceeds 240 slots per path, the drive is blocked.

SVP hardware specifications
The following table lists the SVP hardware specifications.

Item Specification

Dimensions Height: 1.7 inches (43 mm)

Width: 17.2 inches (437 mm)

Depth: 14.5 inches (369 mm)

Weight: 14 lbs (6.4 kg)

Processor Celeron G1820 2.7 GHz 2M, 2C, 2T

Memory 8 GB RAM DDR3

Hard drive 2 TB

Network interface card x4 ports (on-board NIC) +

x1 IPMI (BMC) port

Rated AC voltage 100-240 V, 50-60 Hz, 4.2 - 1.8A

Power supply 350 Watt AC power supply w/ PFC

AC voltage 100-240 V, 50-60 Hz, 4.2-1.8 Amp

Power supply safety / EMC • USA - UL listed, FCC
• Canada - CUL listed
• Germany - TUV Certified
• Europe/CE Mark
• EN 60950/IEC 60950-Compliant

Fans 2x 4cm 4-pin PWM fans

Operating system Microsoft Windows Embedded Standard 7

Operating temperature 41°F ~ 95°F

(5°C ~ 35°C)

Non-operating temperature range -40°F ~ 140°F

(-40°C ~ 60°C)

Operating relative humidity range 8% ~ 90% (non-condensing)

Non-operating relative humidity range 5% - 95% (non-condensing)
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D
Cables

□ Fibre Channel cables

□ iSCSI cables

□ AC power cables
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Fibre Channel cables
When constructing a system with the direct connection or Fibre Channel
switch connection, consider the following:
• If you connect a storage system directly to a host adapter, set the Loop

value to Fibre Channel topology. 16 Gbps Fibre Channel does not support
Loop.

• If you connect a storage system to a fibre channel switch, set the Point
to Point value to Fibre Channel topology. The 16 Gbps Fibre Channel
does not support Point to Point connection to a host server.

Topology direct

connection

16 Gbps Point to

Point

8 Gbps Loop

Point to Point

4 Gbps Loop

Point to Point

2 Gbps Loop

Switch

connection

Point to Point Point to Point Point to Point Point to Point

• Because high-speed serial data transfer is performed via Fibre Channel,
use high-quality Fibre Channel cables that conform to the Fibre Channel-
PH standard.
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Data transfer
rate

Maximum length of cable

Multimode cable Single mode
cableOM2 OM3 OM4

2 Gbps 984.25 ft (300 m) 1640.4 ft (500 m) — 3280.8 ft (10 km)

4 Gbps 493 ft (150 m) 1246.72 ft (380
m)

1312.3 ft (400 m)

8 Gbps 164.04 ft (50 m) 493 ft (150 m) 623.36 ft (190 m)

16 Gbps 114.8 ft (35 m) 328.08 ft (100 m) 410.1 ft (125 m)

The following table lists specifications of the Fibre Channel interface cable.

Cable type Interface
Cable mode

name

Nominal

Cable
Connector

One side Other side

LC-LC cable Optical Equivalent to

DXLC-2P-PC-

xxM-GC50,

125-2SR

(OMx)

50, 125 μm,

62.5, 125 μm

Multimode

Wavelength;

850 nm

LC connector LC connector

The following figure shows the connector used for optical interfaces.
 

 

The following figure shows the type of optical connector that connects the
storage system Fibre Channel ports.
• LC connector type
• Connector type: LC duplex receptacle connector
• Interval: 6.25 mm flat type, two rows
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iSCSI cables
This section describes typical iSCSI cable lengths for a given type of
connection.

Data transfer
rate

Maximum length of cable

Multimode cable Single mode
cableOM2 OM3 OM4

10 Gbps (FCoE) 269.02 ft (82 m) 984.25 ft (300 m) 1804.46 ft (550

m)

—

Cable type Interface
Cable mode

name

Nominal

Cable
Connector

One side Other side

LC-LC cable Optical Equivalent to
DXLC-2P-PC-
xxM-GC50,
125-2SR
(OMx)

50, 125 mm
Multimode
Wavelength:
850 nm

LC connector LC connector

The following figure shows the connector used for optical interfaces.
 

 

The following figure shows the type of optical connector that connects the
storage system optical iSCSI ports.
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• LC connector type
• Connector type: LC duplex receptacle connector
• Interval: 6.25 mm flat type, two rows

 

 

AC power cables
Utility AC power standards for connector types and voltage levels vary by
country. Hitachi provides a variety of power cables that facilitate using
storage systems around the world. Hitachi power cables meet the safety
standards for the country for which they are intended.

Power cable assemblies

Hitachi power cables consist of three parts:
• Plug: Male connector for insertion into the AC outlet providing power. The

physical design and layout of the plug's contact meet a specific standard.
• Cord: Main section of insulated wires of varying length, whose thickness is

determined by its current rating.
• Receptacle: Female connector to which the equipment attaches. The

physical design and layout of the receptacle's contacts meet a specific
standard. Common standards are the IEC C13 receptacle for loads up to
10 amperes (A) and the IEC C19 receptacle for loads up to 15 A.
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Number Countryor region Plug type
Voltage rating

(VAC)
Current rating

(amperes)

11 North America 100-127 15 NEMA 5-15P

Brazil 200-240 10, 20 NEMA 5-15P

Japan 100-127 12 JIS C8303

Taiwan 100-127 12, 16 CNS 690

2 North America 100-127 20 NEMA 5-20P

3 North America 200-240 20 NEMA L6-20P

42 North America 200-240 30 NEMA L15-30P

53 Hong Kong 200-240 13 BS-1363

Singapore 200-240 13 BS-1363

6 Chile 200-240 10, 16 CEI 23-50

Italy 200-240 10, 16 CEI 23-50

7 Argentina 200-240 10, 15 IRAM 2073

Australia 200-240 10, 15 AS-3112

China 200-240 10, 16 GB-1002

New Zealand 200-240 10, 15 AS-3112

8 Denmark 200-240 10 DK 2-5

Israel 200-240 10, 16 SI-32

94 Europe 200-240 CEE 7, 7

105 India 200-240 6, 16 IS-1293

South Africa 200-240 10, 16 SABS-164

11 Switzerland 200-240 10 SEV 1011

126 International 200-240 20 IEC 309

137 United Kingdom 200-240 13 BS-1363

International 200-240 20 IEC 309

148 International 200-240 30 IEC 309

Notes:
1. Also used for 200-240 VAC applications in Korea and Philippines.
2. Three-phase AC.
3. Also Malaysia and Ireland.
4. Also known as "Schuko" connector and used in Austria, Belgium, Finland, France, Germany,

Greece, Hungary, Indonesia, Netherlands, Norway, Poland, Portugal, Russia, Spain, and
Sweden.

5. Supersedes type BS 546.
6. 3-wire (two-phase and earth). Physical variations (connector size and color) indicate

amperage rating. Used in Switzerland for a true 16 A application.
7. 4-wire (three-phase and earth). Physical variations (connector size and color) indicate

amperage rating.
8. 5-wire (three-phase, earth and neutral). Physical variations (connector size and color)

indicate amperage rating.

AC connections
The following table shows and describes the types of AC connections on your
storage system.
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Description Receptacle (male end) Input rating Reference standards

NEMA 5-15P  

 

100V-120V (standard
attachment)

1 ANSI C73.11
2 NEMA 5-15P

3 IEC 83

NEMA L6-20P  

 

200V-240V 1 ANSI C73.11
2 NEMA 6-15P

3 IEC 83

CEE 7/7  

 

200V-240V 4 CEE (7) II, IV, VII
3 IEC 83

BS-1363  

 

200V-240V 5 BS 1365
3IEC 83

AS-3112  

 

200V-240V 6 AS C112

Power cable usage guidelines
Hitachi storage systems are intended for rack installation and ship with power
cords. Installation and service requirements may require additional cords and
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cables to be ordered. The type of power cable required by a given installation
is determined primarily by the:
• Type of AC line feed provided by the facility.
• Type of AC source (wall outlet or modular and monitored PDU) to be used.
• Serviceability of components to be connected.

Storage systems require a country-specific power cable for direct connection
to a facility AC feed.

Storage systems are designed to allow replacement of hot-pluggable
components without removing the chassis from the rack. As a result, power
cables can be short because cable movement is of minimal consideration.

Three-phase power considerations for racks
Increasing power requirements for racks are making the use of three-phase
power at the rack level compelling.
• With single-phase power, at any given time the voltage across the hot and

neutral conductors can be anywhere between its peak (maximum) and
zero. Electrical conductors must be large to meet high amperage
requirements.

• Three-phase power uses three cycles that are 120 degrees out of phase,
which never allows the voltage to drop to zero. The more consistent
voltage derived from the three hot conductors results in smoother current
flow and allows small-gauge conductors to be used to distribute the same
amount of AC power. As a result, the load balancing and increased power
handling capabilities of three-phase distribution can result in more efficient
and less costly installations that require fewer AC cables and PDUs.

 

 

Cable management
Rack installations should be planned for operational efficiency, ease of
maintenance, and safety. Hitachi offers the Backend Configuration Utility
(BECK), a graphical, cable-management application that can relieve the
typical cable congestion created when populating a rack with storage systems
and their accessories.

Cable retention
Unintentional unplugging or unseating of a power cable can have a serious
impact on the operation of an enterprise storage system. Unlike data cables,
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power connectors do not have built-in retention mechanisms to prevent this
from happening.

To prevent accidental unplugging or unseating of power cables, the storage
system includes a rubber cable-retention strap near the AC receptacle on
each controller. These straps, shown in the following image, loop around the
neck of a power cable connector, and the notched tail is slipped over the hook
of the restraining bar fixed to the storage system.
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E
Port address mapping

□ Port address mapping
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Port address mapping
For the port address (AL_PA) of each fibre channel port of the Hitachi Virtual
Storage Platform G200, G400, G600, EF is set. You do not have to change
the AL_PA because the storage system port can connect to the host bus
adapter (HBA) with the current setting.

To change the AL_PA, select the value described in the following table.

When setting a value not described in the following table, or when setting a
value already used by the HBA, the host might not be able to recognize the
VOL. If this problem or other problems occur, restore the value to the default
value of EF

EF* CD B2 98 72 55 3A 25

E8 CC B1 67 7 64 39 23

E4 CB AE 90 6E 53 36 1F

E2 CA AD 8F 6D 52 35 1E

E1 C9 AC 88 6C 51 34 1D

E0 C7 AB 84 6B 4E 33 1B

DC C6 AA 82 6A 4D 32 18

DA C5 A9 81 69 4C 31 17

D9 C3 A7 80 67 4B 2E 10

D6 BC A6 7C 66 4A 2D 0F

D5 BA A5 7A 65 49 2C 08

D4 B9 A3 79 63 47 2B 04

D3 B6 9F 76 5C 46 2A 02

D2 B5 9E 75 5A 45 29 01

D1 B4 9D 74 59 43 27 N/A

CE B3 9B 73 56 3C 26 N/A

* A value set as the default value.
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F
Using the BECK tool

The Backend Configuration Kit (BECK) tool is a graphical application for
checking the cabling paths between controllers and drive trays. The BECK
tool is available as a download from Hitachi.

□ System requirements

□ Drive tray specifications

□ Installing the BECK tool

□ Uninstalling the BECK tool

□ BECK tool at a glance

□ Starting the BECK tool

□ BECK tool configuration screen

□ Working with cable figures

□ Expanding a configuration

□ Saving and loading a configuration file

□ BECK tool messages

□ Special guidelines
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System requirements
To use the BECK tool, verify the following system requirements.

Item Description

Operating system Microsoft Windows XP (x86), Windows Vista
(x86) or Windows 7 (x86)

Available disk space 5 MB or more for installation.
At least 100 MB if the simple trace function will
be used.

Memory 1 GB or more is recommended.
We recommend you close memory-intensive
programs before using the BECK tool.

Related file To use the simple trace function, place the file
UNLHA32.DLL in the Windows system folder.

Screen resolution 1280 x 700, 96 DPI or less is recommended. For
Windows XP (x86) English version, the screen
resolution of 1280 x 1024 or more is
recommended.

Drive tray specifications

M
o
d
el

Dri
ve
co
un
t

Uni
t

siz
e

(U)

P
at
h

Number of drive tray
connections

Maximum
number of

drives1

Maximum number of drives
per path

LFF
driv

e
tray

SFF
driv

e
tray

FMD
drive
tray

Dense
intermi
x drive

tray

VS
P
G2
00

2.5
inch
: 24

2 1 7 8 7 4 2642 2642

3.5
inch
: 12

2 1 8 7 7 4 2522 2522

VS
P
G4
00

- 4 2 16 16 16 8 480 240

VS
P
G6
00

- 4 2 24 24 24 12 720 360

Notes:
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Number of drive tray
connections

Maximum
number of

drives1

Maximum number of drives
per path

LFF
driv

e
tray

SFF
driv

e
tray

FMD
drive
tray

Dense
intermi
x drive

tray

1. The maximum number of drives may be limited depending on the mounting pattern when LFF,
SFF, FMD, or dense intermix drive trays are used together

2. A drive tray in the unit and four dense intermix drive trays are connected.

Installing the BECK tool

Procedure

1. In a new (empty) folder, place the file BECK_Tool_wxyz.zip, where wxyz
represents the BECK version number.

2. Double-click the zip file.
A BECK_Tool_wxyz subfolder is created automatically within the folder
where the zip file is located, and BECK_Tool.exe and initialization (INI)
files are displayed in the folder.

Note: Do not move the INI files from the folder or change the INI
file names or INI file contents.

3. To verify that the BECK tool is installed, double-click the executable file
BECK_Tool.exe in the BECK_Tool_wxyz folder to start the BECK tool.

4. Confirm that the Language dialog box appears.

Uninstalling the BECK tool

Procedure

1. Confirm that the computer is operating normally.
2. If the BECK tool is running, stop it.
3. If there are files in the BECK_Tool_wxyz subfolder that you want to keep,

copy them to another folder.
4. Delete the BECK_Tool_wxyz subfolder containing the BECK_Tool.exe and

INI files.
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BECK tool at a glance

Procedure

1. Select a language from the Language dialog box.
• English
• Japanese

2. At the Array Unit Type dialog box, click an array unit type or enter a
box code of up to 8 alphanumeric characters.
You can enter the serial unit number and an optional name as the box
code. A configuration screen appears that corresponds to the array unit
type selected in the Array Unit Type dialog box.

3. Create logical and physical configuration figures.
• Automatically by specifying the number of units.
• Manually by entering values in supplied fields.

Configurations can be expanded after you create them. You can also
expand a configuration loaded from simple trace in step 2. At the Array
Unit Type dialog box, select a storage system array unit type and load
an existing configuration. Configurations in the configuration file for the
BECK tool can also be loaded and saved.
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4. A cable figure appears based on the logical and physical configuration
figures.
 

 

Starting the BECK tool

Procedure

1. Store the executable file on your computer's desktop.
2. In the BECK_Tool_wxyz folder, run the BECK executable file

BECK_Tool.exe.
3. At the Language dialog box, click a language, and then click OK.

The selected language will be used in the subsequent screens.
4. At the Array Unit Type dialog box, perform one of the following steps:

• Click a storage system from the menu.
• Enter the system's box code, up to 8 alphanumeric characters. Or

enter the system's serial unit number and optional name as the box
code.

5. Click OK.
The configuration screen appears.
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BECK tool configuration screen
The configuration screen consists of Logical and Physical areas:
• Logical: At the left side, shows logical path information about the storage

system. To activate this area, click any of the fields in the path columns.
When the message asks whether the physical configuration should be
initialized, click OK.

• Physical: At the right side, shows rack information about the storage
system. To activate this area, click any field in the rack columns. When the
message asks whether the logical configuration should be initialized, click
OK.

Only one side, Logical or Physical, can be active at a time. The background of
the Logical or Physical area turns light green to show it is activated.

Understanding the BECK tool configuration screen
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Number Name Description

1 Logical Displays units, unit IDs, and
box codes in each path.

2 Version Shows the BECK tool version.

3 Edit button Click the button to edit the
logical configuration figure
manually.

4 Physical Displays units, unit IDs, and
box codes in each rack. The
number of racks vary,
depending on the controller.

5 Single and Dual buttons N/A

6 Edit (Physical) Lets you edit the physical
configuration figure manually.

7 Cable figure button Displays the SAS (ENC) cable
figure

8 Rack size Size of each rack, specified in 0
to 42 U.

9 End button Closes the configuration screen.

10 Create button Creates the configuration edited
in the logical and physical
configuration figures. Displays
units, unit IDs, and box codes
in the logical and physical
configuration figures.

11 Reset button Resets the created
configuration (units, unit IDs,
and box codes). If you load a
simple trace, clicking this
button redisplays the
configuration screen that was
shown after the simple trace
was loaded. If loading a
configuration information file,
the configuration screen
displayed after the
configuration information file
was loaded is redisplayed.

12 Base button Displays units and unit IDs in
the Logical and Physical
configuration figures
automatically created after you
enter the number of LFF, SFF,
FMD, and dense intermix drive
trays.
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Number Name Description

13 Save button Saves configuration information
to a CSV file.

14 Load button Loads configuration information
from a CSV file.

Creating new configurations
Using the BECK tool, you can create new configuration diagrams
automatically or manually.

Creating a configuration automatically

You can use the BECK tool to create a configuration automatically by entering
a drive tray value.

Procedure

1. In the configuration screen, click Base.
2. At the Number of Drive Box dialog box, change the values shown for

the number of drive trays.
3. Click OK.

Using the entered values, the BECK tool generates logical and physical
configuration figures. Drive trays are added to a path and rack for each
storage system in the following order: FMD, dense intermix drive tray,
SFF to LFF

4. Click Cable Figure.
A cable figure is displayed based on the logical and physical
configuration.

Creating a configuration manually

An alternative to creating a configuration automatically is to create a
configuration manually by entering the drive trays in the logical or physical
configuration figure.

Procedure

1. In the logical or physical figure of the configuration screen, click the Edit
button or left-click the areas of the logical or physical configuration
figure.

2. If you clicked Edit in the physical figure, the message May logical 
configuration figure be initialized? appears. Click OK to remove
the message.

3. All the units, unit IDs, and box codes in the logical configuration figure
are cleared and the physical configuration figure is highlighted in light
green. Right-click an empty box in a rack.
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The clicked box is highlighted in orange and the Select Box dialog box
appears.

4. In the Select Box dialog box, click the desired drive tray.
• You can optionally enter a box code for the selected drive tray in the

Enter box code (optional) field.
5. Click OK.

The selected drive tray appears in the box you clicked in the physical
configuration figure.

6. Click Create.
The logical configuration figure is updated based on the changes made.
Unit IDs are assigned automatically.

7. Click Cable Figure.
The BECK tool creates and displays a cable figure based on the logical
and physical configuration figure.

Editing the logical configuration figure

Procedure

1. In the logical configuration figure, click Edit, or click the area in the
logical configuration figure.

2. When the message May physical configuration figure be 
initialized? appears, click OK to remove the message.
All the units, unit IDs, and box codes in the physical configuration figure
are cleared, and the logical configuration figure is highlighted in light
green.

From this screen, you can:
• Assign units to a path.
• Move and exchange drive trays.

Assigning units to a path
When you assign units to a path in the logical configuration figure, you can:
• Set a unit in an empty box in a path (described below).
• Change or delete a drive tray in the path.
• Edit storage system controller box codes.

Setting a unit in an empty box in a path

Procedure

1. Right-click an empty box in a path when the logical configuration figure
can be edited.
The clicked box is highlighted in orange and the Select Box dialog box
appears.
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2. In the Select Box dialog box, click the desired drive tray.
• You can optionally enter the box code for the selected drive tray in the

Enter box code (optional) box.
3. Click OK.

The selected drive tray appears in the box in the logical configuration
figure.

Changing or deleting a drive tray in a path

Procedure

1. Right-click a drive tray in the path.
If you change the type of drive tray type, the existing drive tray is
changed or deleted. You can also edit the box code.
The selected drive tray is highlighted in orange and the Select Box
dialog box appears. The Select Box dialog box shows the selected drive
tray. A box code is also displayed if you registered the system. If you
change the Drive Box type, the existing Drive Box is changed or deleted.
You can also edit the Box Code.

Editing box codes for a controller (VSP G200 only)

Procedure

1. In the logical configuration figure, right-click a controller in the path or a
box where you want to set a controller (bottom box of the logical
configuration figure).

2. The box is highlighted in orange and the Select Box dialog box appears,
with a controller and box code displayed. If you registered the drive tray,
the displayed box code can be edited. If no controller appears in the
configuration screen, click OK to add a controller to the configuration
screen.

3. From here, you can:
• Assign a unit in an empty box in a path.
• Change or delete a drive tray in a path.
• Assign controllers and edit their box codes.

Note: If you click Cable Figure after creating configuration
figures, the cable figure appears. You can also display the cable
figure by clicking Cable Figure without first creating configuration
figures.
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Moving and exchanging drive trays
When editing the logical configuration figure, you can move and exchange
units by dragging and dropping them in the logical configuration figure in
ascending order in paths.

Procedure

1. Click an existing drive tray in the path.
The existing drive tray is highlighted in orange.

2. Click the existing drive tray.
3. Drag the existing drive tray to the destination drive tray.

An empty tray can be the destination; however you cannot specify a
controller and empty trays for controller as the destination.
Drive trays are exchanged, the box is highlighted in orange, and the unit
ID and box code are exchanged accordingly.

4. After moving and exchanging units by dragging and dropping them, click
Cable Figure to display the cable figure.

Note: Cable Figure also lets you display the cable figure without
first creating configuration figures.

Editing the physical configuration figure

Procedure

1. In the physical configuration figure, click Edit or click the physical
configuration figure.

2. When the message May logical configuration figure be 
initialized? appears, click OK to remove the message.
All the units, unit IDs, and box codes in the logical configuration figure
are cleared. The physical configured figure is highlighted in green.

3. From this screen, you can:
• Set rack size.
• Assign units to a rack or set up an empty rack box.
• Move and exchange units.

Setting the rack size
You can specify the rack size in the physical configuration figure. Rack sizes
are specified in 0 to 42 U. The default setting is 42 U. You can also set the
rack size when you are not editing the physical configuration figure.

The following sizes are represented by a box in the physical configuration:
• VSP G400 and G600: 4[U]
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• VSP G200: 2 [U]
• LFF, SFF, and FMD drive trays: 2 [U]
• Dense intermix drive tray: 4 [U]
• Empty: 2 [U]

Setting units to a rack or an empty rack box
Setting units to a rack or an empty rack box in Physical, you can:
• Set drive tray in an empty rack.
• Change or delete a drive tray.
• Edit a controller box code.

Setting a drive tray in an empty rack box

Procedure

1. Right-click an empty box for racks when the physical configuration figure
can be edited.
The selected box is highlighted in orange and the Select Box dialog box
appears.

2. In the Select Box dialog box, click the desired drive tray.
• You can optionally enter a box code for the selected drive tray in the

Enter box code (optional) field.
3. Click OK.

The selected drive tray appears in the box.

Changing or deleting a drive tray

Procedure

1. Right-click a drive tray in the rack.
2. The selected drive tray is highlighted in orange and Select Box dialog

box appears. The button of the drive tray corresponds to the drive box
type you selected.
• If you registered the drive tray, a box code is also displayed.
• If you change the drive tray type, the drive tray is changed or deleted.

You can also edit the box code.

Setting a controller or editing its box code

Procedure

1. Right-click a controller in Rack1 or right-click an empty box in the rack
area if no controller is displayed.

2. The box is highlighted in orange and the Select Box dialog box appears,
with the controller and its box code is displayed.
• If you registered the controller, a box code is displayed and can be

edited.
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• If the configuration screen does not display a controller , click OK to
add a controller to the configuration screen.

Controller can be added only in Rack 1.
3. From this screen, you can:

• Set a drive tray in an empty rack box.
• Change or delete a drive tray.
• Set a controller or edit its box code.

If you click Cable Figure after creating configuration figures, the cable
figure is displayed. You cannot add a drive tray below the controller.

Tip: Cable Figure also lets you display the cable figure without
first creating configuration figures.

Moving and exchanging units

Procedure

1. Click an existing drive tray in the rack.
The existing drive tray is highlighted in orange.

2. Drag the existing drive tray to the destination drive tray.
An empty tray can be the destination, but you cannot specify a controller
and empty trays for the controller as the destination. You can also drag
one to an empty tray or a controller in Rack 1 only.
Drive trays are exchanged, the box is highlighted in orange, and the unit
ID and the box codes are exchanged accordingly.

3. After moving and exchanging units by dragging and dropping them, click
Cable Figure to display the cable figure. You can also display it by
clicking Cable Figure without creating the configuration figure. You
cannot add drive trays below the controller.

Working with cable figures
The Cable Figure screen shows logical and physical configuration figures.

The total number of racks that can be shown are:
• VSPG400 or G600: 10
• VSP G200: 3

Sizes
The following sizes are represented by a box for a rack in the Cable Figure
screen.
• VSP G400 or G600: 4 [U]
• VSP G200: 2 [U]
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Buttons and fields
 

 

Number Name Description

1 Route0 Highlights of SAS (ENC) cables
connected to the unit of
controller 0.

2 Route 1 Highlights of SAS (ENC) cables
connected to the unit of
controller 1.

3 unit ID Shows or hides unit IDs
(Default: on).

4 Standard Clears all highlighted SAS
(ENC) cables in the Cable
Figure screen.

5 Path0 Hightlights SAS (ENC) cables
connected to Path0.

6 Path1 N/A

7 Path2 N/A

8 Path3 N/A

9 All Path Highlights SAS (ENC) cables
connected to all the paths.

10 Rack to Rack Highlights SAS (ENC) cables
connected between racks.

11 Box Code If box codes are assigned to
units, clicking this button shows
or hides the box codes.

12 End Closes the Cable Figure screen.

Working with cable figures

Procedure

1. Click Standard to remove highlights from the SAS (ENC) cables.
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2. Click Path0 to highlight SAS (ENC) cables of the unit connected to
Path0.

3. Click All Path to highlight SAS (ENC) cables connected to all paths.
4. Click Rack to Rack to highlight the SAS (ENC) cables connected

between racks.
5. Click Route0 to highlight the SAS (ENC) cables of the unit connected to

the controller0.
6. Click Route1 to highlight the SAS (ENC) cables of the unit connected to

controller1.
7. Click Device ID to display unit IDs.

Use this toggle button to show or hide unit IDs. The box code can be
used regardless of this setting.

8. If the box codes are registered, click Box Code to display the box codes.
Use this toggle button to show or hide box codes. You can use the
Device ID button regardless of whether box codes are shown or hidden.

9. If both the Device ID and Box Code are on, unit IDs and their box
codes are displayed.

10. Click End to close the Cable Figure screen.

Working with cable figures in rack boxes

Procedure

1. Click a drive box in a rack box.
2. The selected unit is highlighted in orange and the units connected to the

selected unit are displayed in white. SAS (ENC) cables connected to the
selected unit are highlighted. All Path of Partial indicates the number
of SAS (ENC) cables connected to the selected unit. Rack to Rack
indicates the number of SAS (ENC) cables connected to the selected unit
spanning between racks.

Expanding a configuration
Using the BECK tool, you can expand a configuration by loading a simple
trace (refer to the Hardware Service Guide). To load simple traces, place the
UNLHA32.DLL file in the Windows system folder.

Procedure

1. Store the executable file on your computer's desktop.
2. In the BECK_Tool_wxyz folder, run the BECK executable file

BECK_Tool.exe.
3. At the Language dialog box, click a language, and then click OK.

The selected language will be used in the subsequent screens.
4. At the Array Unit Type dialog box, click the Load Log button.
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5. In the Open dialog box, select the simple trace file (*.dat file format).
• If the trace file is stored in another directory, select the trace file

belonging to the storage destination.
• If one simple trace file is collected for a storage system, select the

trace file of the load target.
• If the trace file resides in another directory, when one simple trace file

is collected in the storage system, select the trace file of the load
target.

• If there are multiple simple trace files, selecting an optional trace file
loads the other trace files automatically. If the other simple trace file
resides in the same directory, a load error occurs.

Note: The trace file can be renamed, but its contents must not be
changed.

A Rack size dialog box appears.
6. Enter the size of each rack and click OK.

Default size is 42 U.
If the simple trace loads successfully, the existing configuration appears
in the logical and physical configuration figures, along with the unit IDs
and box codes.

7. Expand the existing configuration.
8. Edit the logical or physical configuration figure in the configuration

screen.
Click Edit in the logical configuration figure or click in the logical
configuration figure.

9. At the message May physical configuration figure be 
initialized?, click OK.
All the units, unit IDs, and box codes in the physical configuration figure
are cleared and the logical configuration figure is highlighted in light
green.

10. Right-click an empty box in a path.
The selected box is highlighted in orange and the Select Box dialog box
appears.

11. In the Select Box dialog box, click the desired drive tray.
You can optionally enter the box code for the selected drive tray.

12. Click OK.
The selected drive tray is displayed in the box in the logical configuration
figure.

13. Click Create.
Changes made are displayed in the physical configuration figure. Unit IDs
are assigned automatically.

14. Click Cable Figure to display the cable figure based on the expansion.
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Note: If you click Reset after editing the loaded configuration, the
Configuration screen refreshes immediately.

Simple trace default file name
A simple trace default file uses the following naming convention:

smpi_trc#_xxxxxxxxxx_YYYYMMDDhhmmss_$%.dat

Part Description

# Controller number for trace target (0 or 1)

xxxxxxxxxx Serial unit number

YYYMMDDhhmmss Trace collecting start time (year, month, date,
hour, minute, second)

$ Trace file serial number (0, 1, 2, ...)

% Trace file split discriminator:
• S: start file
• C: center file
• E: end file

Saving and loading a configuration file
Using the BECK tool, you can save the configuration as a CSV file. After you
save a configuration file, you can load it when you want to use the data
contained in the file.

Saving a configuration file
If you save the configuration information while editing the configuration, the
file is saved with the array unit configuration unchanged.

Procedure

1. In the configuration screen, click Save.
The Save As dialog box appears.

2. In the Save As dialog box, select a folder where you want to save the
file.

3. Click Save to save the file.

The contents in the Configuration screen are saved in csv format.

About the configuration file
The configuration information is stored with the following default file name:
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• If the box code is not entered, the file name consists of the controller box
name selected in the Array Unit Type dialog box with the extension .csv.

• When the box code is entered, the file name consists of the controller box
name selected in the Array Unit Type dialog box, plus an underscore,
plus the box code (up to eight alphanumeric characters), with the
extension .csv.

Observe the following guidelines when saving a configuration file:
• If you save the configuration information file while editing the

configuration in the Logical or Physical configuration figure, the file is
saved with the array unit configuration unchanged.

Observe the following guidelines when loading a configuration file:
• If you click Reset after editing a loaded configuration information file, the

previous configuration figure screen is recovered.
• If you load the configuration information file that was saved while editing

the configuration in the Logical or Physical configuration figure, the array
unit configuration displayed in the Logical or Physical configuration figure
is unchanged.

Loading a configuration file

Procedure

1. In the configuration screen, click Load.
The Open dialog box appears.

2. In the Open dialog box, go to the folder that contains the configuration
file you want to load.

3. Click the configuration file, and then click Open.
The configuration information contained in the file is displayed in the
BECK tool.

BECK tool messages

Message Corrective action

DBL has more rack-mountable numbers than
allowed.

Re-examine the unit configuration.
Display the Select Box dialog box and delete
the LFF.

DBS has more rack-mountable numbers than
allowed

Re-examine the unit configuration.
Display the Select Box dialog box and delete
the SFF.

DBF has more rack-mountable numbers than
allowed

Re-examine the unit configuration.
Display the Select Box dialog box and delete
the FMD.
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Message Corrective action

DB60 has more rack-mountable numbers than
allowed

Re-examine the unit configuration.
Display the Select Box dialog box and delete
the dense intermix drive tray.

The total number of Drive Boxes mountable
exceeds its maximum numbers allowed.

Re-examine the unit configuration.
Reduce the total number of drive trays within
the limit maximum numbers on the Select Box
dialog box.

The number of installable Drive Boxes
exceed its maximum numbers allowed.

Re-examine the unit configuration.
Reduce the total number of drive trays within
the limit maximum numbers on the Select Box
dialog box.

Maximum Drive Boxes count per path was
exceeded.

Re-examine the unit configuration.
Specify the drive tray count per path within the
upper limit in the Select Box dialog box.

Rack-mountable drive numbers per path are
exceeded.

Re-examine the unit configuration.
Reduce the total number of drives per path
within the limit of maximum drive numbers on
the Select Box dialog box.

Select one or more Drive Boxes. In the Select Box dialog box, set any input
value to more than 1.

More units are set to path 1 than to path
0.

In the Logical configuration figure, set the same
number of units to path 0 and path 1, or set one
more unit to path 0 than path 1.

More units are set to path 2 than to path
1

In the Logical configuration figure, set the same
number of units to path 1 and path 2, or set one
more unit to path 1 than path 2.

More units are set to path 3 than to path
2.

In the Logical configuration figure, set the same
number of units to path 2 and path 3, or set one
more unit to path 2 than path 3.

Two or more units are set to path 0 than
path 1.

In the Logical configuration figure, set the same
number of units to path 0 and path 1, or set one
more unit to path 0 than path 1.

Two or more units are set to path 1 than
path 2.

In the Logical configuration figure, set the same
number of units to path 1 and path 2, or set one
more unit to path 1 than path 2.

Two or more units are set to path 2 than
path 3.

In the Logical configuration figure, set the same
number of units to path 2 and path 3, or set one
more unit to path 2 than path 3.

Unit of path 0 side skips one or more
units.

In the Logical configuration figure, do not have
space between the units in path 0.

Unit of path 1 side skips one or more
units.

In the Logical configuration figure, do not have
space between the units in path 1.

Unit of path 2 side skips one or more
units.

In the Logical configuration figure, do not have
space between the units in path 2.
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Message Corrective action

Unit of path 3 side skips one or more
units.

In the Logical configuration figure, do not have
space between the units in path 2.

The total size of mounted units exceeds
the rack size.

Re-examine the size of each rack or reallocate
the units to fit the allowed size of each rack.

The Controller Box location cannot be
changed.

The controller location is nontransferable. Do not
click there.

Log file loading has failed. • Provide sufficient space for storing the trace
file.

• Check access authorization to the folder.
• Check whether another application is trying

to access the folder that contains the trace
file.

Log file contains inaccurate information. • Confirm whether there are trace files other
than the input file in the folder.

• Trace file may be corrupt. Re-examine the
trace file.

• Confirm that the trace file is from a Hitachi
Virtual Storage Platform G200, G400, G600.

Configuration information file loading
has failed.

• Re-examine the configuration file.
• Provide sufficient space for storing the

configuration file.
• Check access authorization to the folder

where the configuration file is located.
• Check whether another application is trying

to access the folder that contains the
configuration file.

Configuration information file saving has
failed.

• Provide sufficient space for storing the
configuration file.

• Check the access authorization to the folder
where the configuration file is located.

• Check whether another application is trying
to access the folder that contains the
configuration file.

• Check whether the configuration exceeds
unit connection support specification 360HDD
OFF.

Set the Controller Box. Set a controller to the logical or physical
configuration figure.

The rack sides exceeds the maximum value
42.

Set the rack size to 42 or below.

The rack size of 1 is insufficient. Set the size of Rack 1 as follows:
• VSP G400, 600: 4
• VSP G200: 2

Set the Drive Box. Set one or more drive trays.

Unable to set the Drive Box below the
controller.

Set a drive box above a controller.

Rack height is insufficient. Operate it again at the size shown in the
maximum unit size screen.
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Message Corrective action

Unable to set at the specified location. • If DBX-A is selected, do not set it to the
highest place of maximum path in the logical
configuration figure.

• If DBX-B is selected, do not set it to the
lowest place of the smallest path in the
logical configuration figure.

• Set a controller only in Rack 1.

Unable to select because unit exists on
right side of the unit.

• Move the unit on the right side of the
exchange destination to a different location
and then re-execute.

• If DBX is specified in the Select Box dialog
box, be sure the cell on the right side is
blank.

Unable to select because unit exists on
left side of the unit.

Move the unit on the left side of the exchange
destination to a different location, and then re-
execute.

Enter box code within 8-alphanumeric
characters.

Enter the box code, up to eight alphanumeric
characters.

Enter box code within 15 alphanumeric
characters.

Enter the box code within 15 alphanumeric
characters.

Install UNLHA32.dll in the Windows system
folder.

Click the Load Log button after storing the file
UNLHA32.DLL in the Windows system folder.

ini file has not stored in program
folder, or ini file loading has failed.

• Store the INI file in the BECK_Tool_wxyz
folder.

• Exchange the INI file or the BECK_Tool.exe
file.

More than on ini files are stored in the
program folder.

Store only one INI file in the BECK_Tool_wxyz
folder.

One or more setting values in ini file
are incorrect.

The INI file may be corrupt. Exchange the INI
file.

BECK tool is already running. Confirm whether the BECK tool is not running.

System error has occurred. Exit the tool
and execute it once again.

Unexpected error occurred. Close the BECK tool
and then start it again.

May physical configuration figure be
initialized?

Click OK or Cancel.

May logical configuration figure be
initialized?

Click OK or Cancel.

May physical configuration and logical
configuration figure be initialized?

Click OK or Cancel.

Current configuration figure will be
discarded if the screen is closed without
saving. Continue to close the screen.

Click OK or Cancel.

Specified file already exists. Overwrite? Click OK or Cancel.

Cancel to read Log file? Click OK or Cancel.
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Special guidelines

Dense intermix drive tray configuration rules
When setting a dense intermix drive tray in a rack, the rack size must be
between 3U and 26U.

Yellow box in the configuration screen
A yellow box displayed in the Physical or Logical configuration figure of the
Configuration screen indicates drive slots in the box cannot be used by the
number indicated at Over in Array system drive slot count / Path drive slot
count. Drive slots that have larger drive numbers in the box cannot be used
by the number indicated at Over. If you see these boxes:

Procedure

1. In the Configuration screen, create a configuration.
2. In the configuration screen, the yellow box shows drive slots that cannot

be used.
The number of drive slots appears at Over in Path drive slot count.
Drive slots that have larger drive numbers in the box cannot be used by
the number indicated at Over.
A yellow box appears when there are drive slots that cannot be used in
the box. For these cases, we recommend you do not add the box.

Loading a simple trace when Unit A of a DBX is connected last
If you collect a simple trace file when Unit A of a DBX drive tray is connected
last in the configuration, Unit B of the DBX in the Logical configuration figure
and DBX in the Physical configuration figure are displayed in cyan in the
Configuration screen. This indicates Unit B is not connected because the
unit connected last is Unit A of the DBX, which consists of Unit A and Unit B.
You can reference the cable figure where only Unit A of the DBX is connected.

Procedure

1. In the Array Unit Type dialog box, click Load log to load a simple trace
of the configuration, where Unit A of a DBX is connected last.
After it is loaded, Unit B of the DBX in Logical configuration figure and
the DBX in Physical configuration figure are shown in cyan.

The number of drive slots in Unit B of DBX is not reflected in the Array
system drive slot count and Path drive slot count because Unit B of
the DBX is not connected.

2. Click Cable Figure to display the cable figure.
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No SAS (ENC) cable is connected to Unit B of the DBX because the Unit A
of the DBX is connected last.

If you collect a simple trace file when Unit A of a DBX drive box is
connected last in the configuration, you cannot click Create on the
configuration screen. When the Logical and Physical configuration figure
can be edited, Unit B of a DBX is not displayed in cyan and Create can
be clicked.
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G
Warning labels on the storage system

□ CBLM controller

□ Small form factor drive tray

□ Large form factor drive tray

□ Flash module drive tray

□ Dense intermix drive tray

□ CBLM controller

□ Drive for a small form factor drive tray

□ Drive for a large form factor drive tray

□ Drive for a flash module drive tray

□ Drive for a dense intermix drive tray

□ CBLM power supply

□ Power supply for small and large form factor drive trays

□ Flash module drive tray power supply

□ Dense intermix drive tray power supply

□ Front end module (Fibre Channel/iSCSI)

□ Back end module
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□ ENC for small and large form factor drive trays

□ ENC for a dense intermix drive tray

□ CMA (used to secure dense intermix drive tray)

□ Battery
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CBLM controller
 

 

Small form factor drive tray
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Large form factor drive tray
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Flash module drive tray
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Dense intermix drive tray
 

 

CBLM controller
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Drive for a small form factor drive tray
 

 

Drive for a large form factor drive tray
 

 

Drive for a flash module drive tray
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Drive for a dense intermix drive tray
 

 

CBLM power supply
 

Warning labels on the storage system 281
Hitachi Virtual Storage Platform G400, G600 Hardware Installation and Reference Guide



 

Power supply for small and large form factor drive trays
 

 

Flash module drive tray power supply
 

 

Dense intermix drive tray power supply
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Front end module (Fibre Channel/iSCSI)
 

 

Back end module
 

 

ENC for small and large form factor drive trays
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ENC for a dense intermix drive tray
 

 

CMA (used to secure dense intermix drive tray)
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Battery
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